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ABSTRACT 
This report documents the models and methods used in the Symbolic Nuclear Analysis 
Package/RADionuclide Transport, Removal And Dose Estimation (SNAP/RADTRAD) code, 
which consists of the SNAP Model Editor graphical user interface (GUI), the SNAP/RADTRAD 
plugin and the RADionuclide Transport, Removal And Dose Estimation analytical code 
(RADTRAD-AC).  The SNAP/RADTRAD code was developed for the U.S. Nuclear Regulatory 
Commission (NRC) Office of Nuclear Regulatory Research to estimate transport and removal of 
radionuclides and dose at selected receptors.  The SNAP/RADTRAD code is used to estimate 
the radionuclide release from the containment using either the NRC TID-14844 or NUREG-1465 
source terms and assumptions, or a user-specified table.  In addition, the code can account for 
a reduction in the quantity of radioactive material released due to containment sprays, natural 
deposition, filters, and other engineered safety features.  The code uses a combination of tables 
and numerical models of source term reduction phenomena to determine the time-dependent 
dose at user-specified locations for a given accident scenario.  SNAP/RADTRAD can also be 
used to assess occupational radiation exposures, typically in the control room; to estimate site 
boundary doses; and to estimate dose attenuation due to modification of a facility or accident 
sequence. 



 

 



 

v 

TABLE OF CONTENTS 
ABSTRACT ............................................................................................................................... iii 

TABLE OF CONTENTS ............................................................................................................. v 

LIST OF FIGURES ................................................................................................................... vii 

LIST OF TABLES ...................................................................................................................... ix 

ACKNOWLEDGMENTS ............................................................................................................ xi 

ABBREVIATIONS ................................................................................................................... xiii 

1.0 INTRODUCTION ..........................................................................................................1-1 

2.0 INSTALLATION GUIDE ...............................................................................................2-1 

2.1 Distribution ........................................................................................................2-1 

2.2 Hardware and Software Requirements .............................................................2-1 

2.3 Installation.........................................................................................................2-2 

2.3.1 Installation of AptPlot .............................................................................2-2 

2.3.2 Installation of SNAP ..............................................................................2-3 

2.3.3 Installation of the RADTRAD-AC ...........................................................2-5 

2.3.4 Updates to SNAP, AptPlot and the RADTRAD-AC ................................2-5 

2.4 Sample Problems ..............................................................................................2-6 

2.5 Contact Information ...........................................................................................2-6 

2.6 Code Error and Problem Reporting ...................................................................2-6 

3.0 MODEL DEVELOPMENT USING SNAP/RADTRAD ...................................................3-1 

3.1 Overview of SNAP/RADTRAD ..........................................................................3-1 

3.2 The Model Editor User Interface- Model Development .......................................3-2 

3.2.1 Overview of Existing Model Features ....................................................3-2 

3.2.2 Job Streams and Case Execution in SNAP/RADTRAD ...........................3-6 

3.2.3 SNAP/RADTRAD Input and Output Files............................................. 3-14 

3.2.4 AptPlot Plotting Program ..................................................................... 3-18 

3.3 SNAP/RADTRAD Model Development and Modification ................................. 3-26 

3.3.1 Model Editor Menus ............................................................................ 3-27 

3.3.2 Building a SNAP/RADTRAD Model – Component Specification .......... 3-30 

3.3.3 Building a SNAP/RADTRAD Model – Input Specification .................... 3-35 

3.3.4 Building a SNAP/RADTRAD Model – Additional Features ................... 3-45 

3.4 SNAP/RADTRAD Input Summary ................................................................... 3-50 

3.4.1 Model Options ..................................................................................... 3-50 



 

vi 

3.4.1.1 Dose Conversion Factors ................................................... 3-56 

3.4.1.2 Adaptive Time Step ............................................................ 3-59 

3.4.2 Nuclear Data and Source Scenarios .................................................... 3-59 

3.4.3 Compartments, Pathways, Natural Deposition, Filters and Sprays ...... 3-65 

3.4.4 Dose Locations, Breathing Rates, and Χ/Q Tables .............................. 3-75 

4.0 MODELS USED IN RADTRAD ....................................................................................4-1 

4.1 Governing Equations in RADTRAD ...................................................................4-1 

4.2 Adaptive Time Step Algorithm ...........................................................................4-7 

4.3 Radionuclide Release Mechanisms ................................................................ 4-12 

4.4 Reactor Coolant System Activity Calculations ................................................. 4-14 

4.5 Removal Models ............................................................................................. 4-20 

4.5.1 Spray Removal Model ......................................................................... 4-21 

4.5.2 Natural Deposition Model .................................................................... 4-22 

4.5.2.1 Henry’s Correlation ............................................................ 4-22 

4.5.2.2 Powers’ Model ................................................................... 4-23 

4.5.3 Deposition in Piping Models ................................................................ 4-27 

4.5.3.1 Brockmann Model for Aerosol Removal ............................. 4-27 

4.5.3.2 Bixler Model for Elemental Iodine Removal ........................ 4-31 

4.5.3.3 Bixler Model for Organic Iodine Removal ........................... 4-31 

4.5.4 Filters .................................................................................................. 4-32 

4.6 Dose Analysis ................................................................................................. 4-32 

4.6.1 Offsite Dose Analysis .......................................................................... 4-32 

4.6.2 Control Room Dose Analysis ............................................................... 4-33 

5.0 REFERENCES .............................................................................................................5-1 

 



 

vii 

LIST OF FIGURES 
Figure 2-1 AptPlot Installation Options window ................................................................. 2-2 
Figure 2-2 AptPlot Installation Tool screenshots ............................................................... 2-3 
Figure 2-3 SNAP Installation Tool screenshots ................................................................. 2-4 
Figure 2-4 Welcome to Model Editor screen ..................................................................... 2-6 
Figure 3-1 Opening the Model Editor ................................................................................ 3-3 
Figure 3-2 SNAP Model Editor screen .............................................................................. 3-4 
Figure 3-3 Illustration of the expand icon .......................................................................... 3-5 
Figure 3-4 Illustration of the various icons used to represent a SNAP/RADTRAD                    

model ............................................................................................................... 3-6 
Figure 3-5 Typical job stream in SNAP/RADTRAD ........................................................... 3-7 
Figure 3-6 Job stream Property window ............................................................................ 3-7 
Figure 3-7 Typical root folder settings in SNAP/RADTRAD ............................................... 3-8 
Figure 3-8 Job stream Property window with an unset root folder ..................................... 3-8 
Figure 3-9 Linking the RADTRAD-AC using the SNAP configuration tool ....................... 3-10 
Figure 3-10 Saving the RADTRAD-AC using in the SNAP configuration tool .................... 3-11 
Figure 3-11 SNAP/RADTRAD job stream and status windows .......................................... 3-12 
Figure 3-12 Relationship between job stream steps and code execution .......................... 3-13 
Figure 3-13 Drop-down menus for SNAP/RADTRAD output ............................................. 3-14 
Figure 3-14 Expanded Output Parameters tab in the Property window ............................. 3-17 
Figure 3-15 Expanded NRC Output Flags tab in the Property window .............................. 3-18 
Figure 3-16 SNAP/RADTRAD Job Status window with AptPlot icon highlighted ............... 3-18 
Figure 3-17 AptPlot startup view ....................................................................................... 3-19 
Figure 3-18 Select EXTDATA Channels window for multiple plots .................................... 3-20 
Figure 3-19 Control room dose plots for Test23 ................................................................ 3-21 
Figure 3-20 AptPlot Axes window ..................................................................................... 3-22 
Figure 3-21 AptPlot Set appearance window .................................................................... 3-23 
Figure 3-22 AptPlot Graph appearance window ................................................................ 3-24 
Figure 3-23 Reformatted control room dose plots for Test23 ............................................ 3-26 
Figure 3-24 Model Editor tool bar icon description ............................................................ 3-29 
Figure 3-25 Navigator window tool bar icon description .................................................... 3-30 
Figure 3-26 Navigator window with newly added model components ................................ 3-32 
Figure 3-27 View / Dock window for 4-node model (unconnected) .................................... 3-32 
Figure 3-28 View / Dock window for 4-node model (connected) ........................................ 3-34 
Figure 3-29 Navigator window with all nodes expanded .................................................... 3-35 
Figure 3-30 Navigator window with the black bar menu for the engineering units                      

selection ........................................................................................................ 3-36 
Figure 3-31 Property window with volume entry for Compartment 2 (Containment) .......... 3-36 
Figure 3-32 Pathway input windows for sample problem ................................................... 3-37 
Figure 3-33 X/Q input tables for EAB (left) and LPZ (right) ................................................ 3-38 
Figure 3-34 SNAP/RADTRAD Edit Total Inventories window editing features ................... 3-40 
Figure 3-35 Setting the power plant level .......................................................................... 3-40 
Figure 3-36 Selecting from available SNAP/RADTRAD inventories .................................. 3-41 
Figure 3-37 Edit Total Inventories window Accident Parameters tab ................................. 3-42 
Figure 3-38 Edit Total Inventories window Adjusted Inventory tab .................................... 3-42 
Figure 3-39 Edit Total Inventories window Release Fractions and Timings tab ................. 3-43 
Figure 3-40 Edit Total Inventories window Source Term tab ............................................. 3-43 
Figure 3-41 Property window for source term iodine chemical form settings ..................... 3-44 



 

viii 

Figure 3-42 Model Editor Message window with icons ...................................................... 3-44 
Figure 3-43 Example of a SNAP model editor Error Report window .................................. 3-45 
Figure 3-44 View / Dock window tool bar icons ................................................................. 3-45 
Figure 3-45 Features of the Paste Special window ........................................................... 3-46 
Figure 3-46 Zoom and size features.................................................................................. 3-47 
Figure 3-47 View / Dock window model canvas ................................................................ 3-48 
Figure 3-48 Component Insertion icon feature menus ....................................................... 3-48 
Figure 3-49 Cylinder drawn using the Annotation features of SNAP.................................. 3-49 
Figure 3-50 Property window for the Model Options node ................................................. 3-51 
Figure 3-51 Setting dose conversion factors in the Model Option Property window ........... 3-57 
Figure 3-52 Viewing “FGR11&12” Dose Conversion Defaults window .............................. 3-58 
Figure 3-53 User-Defined Dose Conversion Factors window ............................................ 3-58 
Figure 3-54 RCS Activity Calculator window ..................................................................... 3-60 
Figure 3-55 RCS Activity Inputs – PWR window ............................................................... 3-61 
Figure 3-56 RCS Activity Inputs – BWR window ............................................................... 3-61 
Figure 3-57 Calculate Iodine Activity window .................................................................... 3-62 
Figure 3-58 Available pre-defined SNAP/RADTRAD release models ................................ 3-63 
Figure 3-59 Onsite Χ/Q Table Map window ....................................................................... 3-78 
Figure 4-1 Schematic of a typical SNAP/RADTRAD dose assessment model .................. 4-2 
Figure 4-2 Property widow for the Model Option node..................................................... 4-11 
Figure 4-3 Editing Time Step Table window .................................................................... 4-11 
  



 

ix 

LIST OF TABLES 
Table 3-1 Files available for viewing using the file viewer in the job status window ........ 3-15 
Table 3-2 Summary of Model Editor menu commands ................................................... 3-27 
Table 3-3 Icons used in the View / Dock window ........................................................... 3-33 
Table 3-4 Sample problem X/Q values .......................................................................... 3-38 
Table 3-5 Summary of SNAP/RADTRAD inputs – General Model Options .................... 3-52 
Table 3-6 Summary of SNAP/RADTRAD inputs – Nuclear Data .................................... 3-64 
Table 3-7 Summary of SNAP/RADTRAD inputs – Sources............................................ 3-64 
Table 3-8 Summary of SNAP/RADTRAD inputs – Compartments ................................. 3-65 
Table 3-9 Summary of SNAP/RADTRAD inputs – Pathways ......................................... 3-67 
Table 3-10 Summary of SNAP/RADTRAD inputs – Natural Deposition ........................... 3-70 
Table 3-11 Summary of SNAP/RADTRAD inputs – Filters ............................................... 3-72 
Table 3-12 Summary of SNAP/RADTRAD inputs – Sprays ............................................. 3-72 
Table 3-13 Summary of SNAP/RADTRAD inputs – Dose Locations ................................ 3-76 
Table 3-14 Summary of SNAP/RADTRAD inputs – Χ/Q Tables ....................................... 3-77 
Table 3-15 Summary of SNAP/RADTRAD inputs – Remaining inputs ............................. 3-78 
Table 4-1 Local error solutions for I-131 and I-132 ........................................................... 4-9 
Table 4-2 Chemical element grouping for SNAP/RADTRAD .......................................... 4-12 
Table 4-3 Release phase durations for PWRs and BWRs ............................................. 4-14 
Table 4-4 Gap release fractions used in SNAP/RADTRAD ............................................ 4-14 
Table 4-5 SNAP/RADTRAD release fractions to RCS for an REA-CRDA accident ........ 4-15 
Table 4-6 Formulations used to determine RCS water radionuclide concentrations               

in PWRs with U-tube steam generators ......................................................... 4-16 
Table 4-7 RCS radionuclide concentrations for a reference PWR plant ......................... 4-17 
Table 4-8 Formulations used to determine RCS water radionuclide concentrations                

in BWRs ......................................................................................................... 4-18 
Table 4-9 RCS radionuclide concentrations for a reference BWR plant ......................... 4-19 
Table 4-10 Values for coefficients used in the Powers’ spray removal model .................. 4-22 
Table 4-11 Correlations of natural deposition decontamination coefficients                              

for PWRs DBAs ............................................................................................. 4-24 
Table 4-12 Correlations of natural deposition decontamination coefficients                              

for BWRs DBAs ............................................................................................. 4-25 
Table 4-13 Correlations of natural deposition decontamination coefficients                              

for APWR DBAs ............................................................................................. 4-26 

 



 

 



 

xi 

ACKNOWLEDGMENTS 
Many people, both with the U.S. Nuclear Regulatory Commission as well as at contractor 
organizations have contributed to the development of SNAP/RADTRAD.  The individual who 
has provided unflagging support for the development of SNAP/RADTRAD over the past several 
years is Mark Blumberg from the Office of Nuclear Reactor Regulation.  Mark has been the 
Technical Monitor for the RADTRAD code’s design, computational methods and testing since 
1997.  He has also provided much insight into dose analysis for licensing applications 
throughout the code’s conversion to the Java computer programming language and the entire 
SNAP/RADTRAD development process.  The agency would like to recognize Chester Gingrich 
from the Office of Nuclear Regulatory Research who was responsible for the initial conversion 
and code programming of RADTRAD into Java.  Another individual who is acknowledged is 
Stephen LaVie from the Office of Nuclear Security and Incident Response whose development 
of the RNEditor code is a key element of the source term modeling approach used in 
SNAP/RADTRAD.  Finally, the support of John Tomon of the Office of Research who is the 
current Contracting Officer’s Representative and whose patience and guidance is greatly 
appreciated. 

In the contractor organizations, the contributions of Ken Jones of Applied Programming 
Technology who, along with his programming staff, develop and maintain the SNAP code are 
greatly appreciated. 



 

 

 



 

xiii 

ABBREVIATIONS 
APT Applied Programming Technology 
AptPlot Applied Programming Technology plotting package 
APWR advanced pressurized-water reactor 
APWR-DBA advanced pressurized-water reactor design basis accident 
Bq Becquerels 
BWR boiling-water reactor 
BWR-DBA boiling-water reactor design basis accident 
BWR-GALE boiling-water reactor gaseous and liquid effluent code 
CEDE committed effective dose equivalent 
Ci Curies 
CRDA control rod drop accident 
DCF dose conversion factor 
DE dose equivalent 
DE I-131 dose equivalent iodine 131 
DE Xe-133 dose equivalent xenon 133 
DF decontamination factor 
DBA-TID design-basis accident based on TID-14844 
DBA-AST design-basis accident using NUREG-1465 (Regulatory Guide 1.183) 

models 
EAB exclusion area boundary 
FGR Federal Guidance Report 
FHA fuel handling accident 
GUI graphical user interface 
HEPA high-efficiency particulate air 
LOCA loss-of-coolant accident 
LPZ low population zone 
Mwt megawatt thermal 
NRC U.S. Nuclear Regulatory Commission 
ODE ordinary differential equation 
PWR pressurized-water reactor 
PWR-DBA pressurized-water reactor design basis accident 
PWR-GALE pressurized -water reactor gaseous and liquid effluent code 
RCS reactor coolant system 
RADTRAD RADionuclide Transport, Removal, And Dose Estimation 
RAMP Radiation Protection Computer Code Analysis and Maintenance Program 
REA rod ejection accident 
RG Regulatory Guide 
SI International System of Units 
SNAP Symbolic Nuclear Analysis Package 
Sv Sieverts 
TEDE total effective dose equivalent 
T/S technical specification 
XML extensible markup language 
 



 

 



 

1-1 

1.0 INTRODUCTION 
The purpose of the Symbolic Nuclear Analysis Package/RADionuclide Transport, Removal and 
Dose Estimation (SNAP/RADTRAD) code is to determine the dose from a release of 
radionuclides during a design basis accident to the exclusion area boundary (EAB), the low 
population zone (LPZ), and the control room and other locations of interest.  As radioactive 
material is transported through the containment, the user can account for sprays and natural 
deposition to reduce the quantity of radioactive material.  Material can flow between buildings, 
from buildings to the environment, or into control rooms through high-efficiency particulate air 
(HEPA) and charcoal filters, piping, or other connectors.  Decay and in-growth of daughters can 
be calculated over time as the material is transported. 

The focus of SNAP/RADTRAD is licensing analysis to show compliance with nuclear plant siting 
and control room dose limits for various loss-of-coolant accidents (LOCAs) and non-LOCA 
accidents.  The RADTRAD code was originally developed by the Accident Analysis and 
Consequence Assessment Department at Sandia National Laboratories for the U.S. Nuclear 
Regulatory Commission (NRC) in 1997 as documented in NUREG/CR-6604, “RADTRAD: A 
Simplified Model for RADionuclide Transport and Removal and Dose Estimation,” [1].  The code 
was revised to include a Visual Basic graphical user interface (GUI) for user convenience in 
1999, which is described in NUREG/CR-6604, Supplement 1, “RADTRAD: A Simplified Model 
for RADionuclide Transport and Removal and Dose Estimation,” [2].  Finally, NUREG/CR-6604, 
Supplement 2, “RADTRAD: A Simplified Model for RADionuclide Transport and Removal and 
Dose Estimation,” [3] was published in 2002 discussing the testing of RADTRAD version 3.03. 

The NRC decided to update RADTRAD by converting the code into Java and develop a 
RADTRAD plugin to interface with the SNAP Model Editor GUI.  As part of this update to 
RADTRAD, the RADTRAD analytical code (RADTRAD-AC) was separated from SNAP and 
distributed as SNAP/RADTRAD version 4.0.  The SNAP Model Editor GUI with the RADTRAD 
plugin is used to develop models and prepare input which is then processed by the RADTRAD-
AC (version 4.5.2).  The RADTRAD-AC then calculates the dose and generates the results.  
The combined package is referred to as SNAP/RADTRAD.  Use of RADTRAD in the SNAP 
framework allows use of the SNAP features including the Model Editor for developing plant 
models.  The Model Editor also provides tools for user input checking, for submitting and 
monitoring calculations, and for running multiple cases.  The RADTRAD-AC generates data 
output files suitable for plotting with the Applied Programming Technology plotting package 
(AptPot). 

As part of the development of the RADTRAD plugin for SNAP, the user documentation is being 
updated.  This report provides the documentation for the use of and the calculation models in 
SNAP/RADTRAD. 
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2.0 INSTALLATION GUIDE 
This section of the report discusses how to obtain and install SNAP/RADTRAD and the 
RADTRAD-AC codes. 

2.1 Distribution 

SNAP/RADTRAD is distributed in two parts: the SNAP Model Editor GUI with the RADTRAD 
plugin and the RADTRAD-AC.  SNAP with the RADTRAD plugin is used for model development 
and input preparation while the RADTRAD-AC carries out the calculations and generates the 
results.  SNAP with the RADTRAD plugin is maintained by Applied Programming Technologies, 
Inc. (APT) and the RADTRAD-AC analytical code is maintained by Information Systems 
Laboratory, Inc. 

Directions for obtaining the SNAP Model Editor GUI with the RADTRAD plugin and the 
RADTRAD-AC are available at the Radiation Protection Computer Code Analysis and 
Maintenance Program (RAMP) website (https://www.usnrc-ramp.com).  Current version 
information for SNAP with the RADTRAD plugin and RADTRAD-AC are also available at the 
NRC RAMP website.  Note that results plotting capability has been built into SNAP/RADTRAD 
using the AptPlot program. 

The SNAP Model Editor GUI with the RADTRAD plugin and the AptPlot program is available 
from the APT website (https://www.snaphome.com).  The RADTRAD-AC analytical code is 
available from the RAMP website (https://www.usnrc-ramp.com).  This code is designed to be 
compatible with the SNAP Model Editor GUI with the RADTRAD plugin. 

2.2 Hardware and Software Requirements 

The SNAP Model Editor GUI with the RADTRAD plugin and the RADTRAD-AC code 
(SNAP/RADTRAD) can be executed on any computer that supports Java applications.  Any of 
the current generation of personal computers that can run the Java runtime environment is 
capable of running SNAP/RADTRAD.  For a Windows computer, the Windows operating 
systems that can be used are Vista, Windows 7, Windows 8, and Windows 10.  It should be 
noted that the following software is required: 

• Java Standard Edition (SE) 6.0 or later.  This package is currently available on 
http://www.oracle.com/technetwork/java/javase/downloads/index.html. 

• SNAP Model Editor GUI with the RADTRAD plugin code maintained by APT. 

• RADTRAD-AC packaged separately, and distributed by RAMP. 

• AptPlot – plotting package maintained by APT.  For further details, see 
https://www.appliedprog.com. 

Although not required, the jedit text editing program adds some user conveniences in 
SNAP/RADTRAD.  This package is available from www.jedit.org.  

http://www.jedit.org/
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2.3 Installation 

Installation of SNAP is very similar to installation of any software package on a Windows 
system.  Basically, directory locations on the hard drive to install SNAP are selected.  If not 
already accepted earlier, license agreements are then displayed, which the user needs to agree 
to before proceeding.  For SNAP and AptPlot, a Java-based installer file named 
Snapinstaller.jar and AptPlotinstaller.jar are provided that guides the installation process of 
SNAP and AptPlot.  During the installation process, windows showing installation process and 
user-selectable installation options are displayed. 

2.3.1 Installation of AptPlot 

To download and install AptPlot select the download AptPlot Installer link (Step 2) on the APT 
website.  This will open the AptPlot Installation Option window (Figure 2-1), which provides the 
user with three installation options for installation.  The easiest and simplest option is installing 
AptPlot from the internet; however, some users prefer to download the AptPlot Installation Tool 
(AptPlotinstaller.jar) to a local directory and then perform the installation from the local directory.  
If installing AptPlot from the local directory you should be able to double-click on the 
AptPlotinstaller.jar file from Windows Explorer to launch the application.  If your system does not 
automatically launch jar files in this manner or if you default Java Runtime is earlier than 6.0 
follow the directions on the APT website (Step 3) to run the installer. 

 

Figure 2-1 AptPlot Installation Options window 

Screenshots of the windows for the AptPlot Installation Tool, Figure 2-2, shows the progress of 
the installation.  The location of the installation directory is shown in the Installation Directory 
window.  The user can change the location although the default location is usually adequate.  
After selecting the installation directory, the Java Runtime Environment License Agreement 
appears which the user must agree to in order for the installation process to proceed forward.  
Once this step is completed, a second license agreement for AptPlot (the GNU General Public 
license) will appear which again the user must agree to in order to continue. 
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Figure 2-2 AptPlot Installation Tool screenshots 

The user will then be required to select plugins.  In the case of AptPlot, the user will select the 
analysis code support (ACS) Plugin and then click on Continue.  The installation will proceed to 
completion and the user clicks on Close in the AptPlot Installation Tool window to exit the 
AptPlot installation. 

2.3.2 Installation of SNAP 

The installation steps for the SNAP are essentially the same as for AptPlot, although the 
windows are somewhat different.  The SNAP Installation Tool (Snapinstaller.jar) is downloaded 
from the APT website in a manner similar to that described in Section 2.3.1 above, with the 
exception that the user must first read and accept the Binary Code License Agreement prior to 
downloading SNAP.  Once this agreement is accepted a download instructions webpage similar 
to the one described in Section 2.3.1 above opens.  Select the download SNAP Installer link 
(Step 2) on the webpage to open the SNAP Installation Option window.  The selections on this 
window are identical to those described for Figure 2-1. 

Screenshots of the windows for the SNAP Installation Tool, Figure 2-3, shows the progress of 
the installation.  The location of the installation directory is shown in the Installation Directory 
window.  The user can change the location although the default location is usually adequate.  
After selecting the installation directory, the Java Runtime Environment License Agreement 
appears which the user must agree to in order to continue the installation.  Once this step is 
completed, a second license agreement for the APT binary code license agreement appears 
which again the user must agree to in order to continue. 
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Figure 2-3 SNAP Installation Tool screenshots 

The user will then be required to select plugins.  In the case of SNAP/RADTRAD, the user will 
select the AVF, ENGTMPL, EXTDATA, RADTRAD, and Uncertainty plugins and then click on 
Continue.  The installation will proceed to completion and the user clicks on Close in the SNAP 
Installation Tool window to exit the SNAP installation.  If the user wants to know the purpose of 
each plugin, the user can click on each package name and a description will appear on the 
right-hand side of the plugin manager window as illustrated in Figure 2-3. 

The installation files are written to the \users\homedir where homedir is the home directory for 
the login ID being used unless you specified a different location.  These files are included in the 
snap and .snap directories.  The code files are written to the snap directory and files needed to 
use SNAP on a given system are written to .snap directory.  For example, the location of the 
root folder on a given computer is written to the .snap directory.  The installation files for AptPlot 
are also in \users\homedir in the AptPlot and .aptplot directories.  If the user is uncertain of the 
location of the home directory, a command window can be opened by going to Start and typing 
in command in the Search textbox (Windows 7).  A command prompt window should appear 
(select Command Prompt from menu above if necessary).  Then, type in echo 
%USERPROFILE% and your home directory will be displayed.  
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2.3.3 Installation of the RADTRAD-AC 

The RADTRAD-AC should be installed in the user created radtrad subdirectory under the snap 
directory in the \users\homedir.  The RADTRAD-AC distribution consists of a group of Java .jar 
files that are distributed as a zip file from the NRC RAMP website (https://www.usnrc-
ramp.com/Ramp-Code-Download/2/Code/SNAP%20RADTRAD%20Code).  These files are: 

• castor-codegen.jar 
• castor-core.jar, 
• castor-xml.jar, 
• castor-xml-schema.jar, 
• commons-logging.jar, and 
• radtrad.jar. 

To install these file, create a subdirectory named radtrad in the directory for SNAP/RADTRAD, 
unzip the files and copy them to that directory.  Note:  The path to the radtrad.jar file needs to 
be set using the configuration tool (see Section 3.2.2) to the following setting: 

$snap\radtrad\radtrad.jar, 

If the aforementioned .jar files are copied to a radtrad subdirectory in the SNAP/RADTRAD 
directory, the code should be ready for use.  The location of this link within the SNAP framework 
is discussed in Section 2.2. 

2.3.4 Updates to SNAP, AptPlot and the RADTRAD-AC 

SNAP will automatically make users aware of any available updates to SNAP and its associated 
loaded plugins when the user opens the SNAP Model Editor and the Welcome to Model Editor 
screen appears (Figure 2-4). 

If the computer has an internet connection, SNAP will compare the currently installed version of 
SNAP and all its associated plugins to the latest versions available on the APT website listed in 
Section 2.1.  If there are updates available to either SNAP or any of the loaded plugins the 
Welcome to Model Editor screen will indicate the number of update available to the user.  The 
user may perform these updates by logging into the APT website (Section 2.1) to download and 
run the SNAP Installer Tool.  The SNAP installer samples the version of SNAP which the user 
has loaded to see what plugins are being used and if they are the latest versions of those 
plugins.  The SNAP installer will then ask the user during the installation process to check or 
uncheck the option boxes for the plugins to be installed on the update.  The SNAP Installer will 
automatically update these plugins. 
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Figure 2-4 Welcome to Model Editor screen 

There is no automatic means by which users are notified of updates to AptPlot and the 
RADTRAD-AC.  In the case of AptPlot the users can verify the latest version of the code by 
logging into the APT website (Section 2.1) and checking the site for the latest version of the 
AptPlot code.  Likewise for the RADTRAD-AC, users can verify the latest version of the code by 
logging into the RAMP website (Section 2.1) and checking the site for the latest version of the 
RADTRAD-AC. 

2.4 Sample Problems 

A set of sample problems for SNAP/RADTRAD are provided on the RAMP website.  These 
problems provide a starting point for the user.  In addition, there is a Test23 sample problem 
provided with the SNAP installation files from APT.  This problem is used to illustrate the use of 
SNAP/RADTRAD in Section 3.0.  The user will also find the information on the QuickStart.pdf 
file on the RAMP website to be useful. 

2.5 Contact Information 

Any questions, suggestions, corrections or comments concerning this the code or its 
documentation should be submitted via the SNAP/RADTRAD Support link on the RAMP 
website. 

2.6 Code Error and Problem Reporting 

While every effort has been made to minimize errors in SNAP/RADTRAD, there may be 
unanticipated circumstances that lead to errors and problems (bugs).  To report errors and bugs 
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with the program, first collect as much information as possible about the error or bug.  This 
information should include answers to the following questions: 

• What version of the SNAP/RADTRAD program are you running?  The information for 
SNAP can be found on the screen displayed at startup or by using the Help | About 
menu item.  Click the Plugins button at the bottom of the popup screen to get the 
information about the SNAP/RADTRAD Plugin. 

• What computer operating system is SNAP/RADTRAD being executed on? 

• Is the error or bug reproducible? 

• What are the steps leading up to the problem? 

• What are the exact symptoms (e.g. program crash, error message, etc.)? 

• Save the case files and attach them to an issue report. 

To report a problem, send a zip file with the case files and answers to the above questions to the 
SNAP/RADTRAD Forum webpage under the SNAP/RADTRAD Support link (https://www.usnrc-
ramp.com/content/snapradtrad-support) on the US NRC RAMP website. 

https://www.usnrc-ramp.com/content/snapradtrad-support
https://www.usnrc-ramp.com/content/snapradtrad-support
https://www.usnrc-ramp.com/content/snapradtrad-support
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3.0 MODEL DEVELOPMENT USING SNAP/RADTRAD 
To run SNAP/RADTRAD will require some familiarity with the overall SNAP approach to 
developing and running models.  In this section, the approach to using SNAP to develop, modify 
and execute RADTRAD problems will be discussed.  However, SNAP includes many features 
which will not be discussed here.  For the interested user, the Symbolic Nuclear Analysis 
Package User's Manual [4] provides more detailed information on the use of SNAP. 

3.1 Overview of SNAP/RADTRAD 

SNAP is actually a suite of computer applications used to develop, modify, and execute 
computer models principally for thermal hydraulic codes such as the TRAC/RELAP Advanced 
Computational Engine (TRACE) and Reactor Excursion and Leak Analysis Program (RELAP5).  
Of these tools, the Configuration Tool, Model Editor and the Job Status tools are most relevant 
to RADTRAD analysis.  The Configuration Tool is used to configure global properties for running 
RADTRAD under SNAP.  The Model Editor provides a GUI used to develop RADTRAD models.  
The Job Status tool is used to obtain the job status.  Of these tools, the Model Editor is the tool 
used the most as it is the primary tool for developing SNAP/RADTRAD models. 

Generally, the approach for developing a new SNAP/RADTRAD model is to define the 
compartments and connections in flow pathways that represent the plant and optionally the 
control room and/or the technical support center being analyzed.  Note that flow pathways are 
used to connect components in SNAP/RADTRAD.  During the specification of components and 
flow pathways, removal models should be considered and specified for each normal 
compartment as appropriate.  For compartments, these removal models include filtration, 
sprays, or natural deposition.  The user will need to specify each model required and specify the 
required data using the SNAP Model Editor GUI as a guide. 

Once the geometric, flow/leakage and removal information is specified for the compartments 
and flow pathways, a source term is then specified.  A comprehensive list of nuclides based on 
International Commission on Radiological Protection (ICRP) Report 38 (ICRP-38) [5] has been 
included in SNAP/RADTRAD.  The user will need to decide whether the analysis is either being 
done based on the occurrence of a LOCA by selecting either TID-14844, “Calculation of 
Distance Factors for Power and Test Reactor Sites,” [6] or NUREG-1465, “Accident Source 
Terms for Light-Water Nuclear Power Plants,” [7] and for a non-LOCA where both radionuclides 
from the fuel and the reactor coolant activity may be important contributors and make the 
appropriate selections for the plant being analyzed.  A plant power level must be defined to 
obtain the correct source term.  The iodine physical form must also be defined as the rate of 
removal and filtration depends on the physical form of iodine. 

Parameters related to the dose rate are specified, including Χ/Q data for each receptor location 
and dose conversion factors (DCFs).  Default DCFs based on EPA-520/1-88-020, “Limiting 
Values of Radionuclide Intake and Air Concentration and Dose Conversion Factors for 
Inhalation, Submersion, and Ingestion,” Federal Guidance Report No. 11 (FGR 11) [8] and EPA-
402-R-93-081, “External Exposure to Radionuclides in Air, Water, and Soil,” Federal Guidance 
Report No. 12 (FGR 12) [9] (see Section 4.6) are built into SNAP/RADTRAD.  The EAB and the 
LPZ are defined by default in SNAP/RADTRAD.  Other dose receptors can be added as 
needed.  For each dose receptor that is located in the environment or draws from the 
environment such as a control room, time-dependent Χ/Q and breathing rate values must be 
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specified.  For the control room, occupancy factors must also be specified.  Note that default 
values for breathing rates are provided which are suitable for most analyses. 

SNAP/RADTRAD can be used to develop new models and is backwards compatible to import 
and modify existing RADTRAD version 3.03 and 3.10 models (“*.psf” files).  The key aspect of 
model development is the use of compartments and connecting flow pathways to model a 
system.  The approach used to prepare this section was to open the SNAP Model Editor GUI 
and start exploring the features for RADTRAD model development.  Therefore, the discussion in 
the following sections assumes that the user has SNAP available and open and that the user 
will follow along with the discussion by using the SNAP Model Editor.  There is no better way to 
learn how to use the SNAP Model Editor GUI except to actually use it. 

3.2 The Model Editor User Interface- Model Development 

This subsection describes working within the SNAP/RADTRAD Model Editor to develop and 
modify models. 

3.2.1 Overview of Existing Model Features 

As noted earlier, the SNAP/RADTRAD Model Editor is the basic tool used to create, modify and 
run input models.  To start the Model Editor, navigate to Start->All Programs->SNAP->Model 
Editor, and the Model Editor should start. 

To illustrate many of the features in SNAP, the Test 23 sample problem will be used.  This 
problem is found in the snap\Samples\RADTRAD\Test23 subdirectory in the snap directory (see 
Section 2.3).  It is recommended that a copy of the Test23.med file be placed in the user’s 
working directory, which is the directory where the input and output files will be kept.  It is also 
recommended that the user open Test23 and follow along with the presentation in this section. 

When the Model Editor is started, a splash screen appears for several seconds and then a 
Welcome to Model Editor screen appears as shown in Figure 3-1 with the Model Editor window 
in the background.  Note that if a previous Model Editor session has been exited without first 
closing the model in use then the Restore Session prompt screen will open, as also shown in 
Figure 3-1. 

Several options are available on the Welcome to Model Editor screen, which are listed below: 

• Create A New Model 
• Open a Model Document 
• Import a New Model 
• Start an Empty Session 
• SNAP Version Updates 

Under each of these items a short description of each option is provided to explain what each 
option does. 
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Figure 3-1 Opening the Model Editor 

Once the SNAP Model Editor is open, the user selects Continue under Open a Model Document 
on the Figure 3-1.  Navigate to the location of the Test23 subdirectory under the samples 
directory.  Click on the file Test23.med.  The Model Editor rendering of Test23 will open as 
shown in Figure 3-2.  If not, click on the “default view” tab at the bottom of the page to see this 
view.  Alternately, the user can click on the Test23.med file in the working directory to start the 
SNAP Model Editor. 

Finally, the model can also be opened by selecting File->Open, navigating to the input file (.med 
file) of interest, selecting that file and clicking on open, much like any Windows program.  Notice 
that there are three separate input sections in the SNAP Model Editor window shown in Figure 
3-2 which are: the Navigator window, the Property window and the View / Dock window where 
the model rendering appears.  Also, notice that there are two tabs in the View / Dock window 
labeled Default View and Test23 View.  In Figure 3-2 the Default View for Test23 is shown 
which gives the model rendering for Test23.  The Test23 View provides the job stream view for 
Test23 and the tabs can be clicked-on to show either the modeling rendering or the job stream 
(similar to Microsoft Excel).  Job streams will be discussed later in this section.  There is also a 
Message window underneath the View / Dock window which lists messages from 
SNAP/RADTRAD. 

Before editing, the user should note that each of the windows shown in Figure 3-2 can be 
resized either horizontally or vertically.  Resizing is done by hovering the mouse cursor over the 
border between the windows until a double-headed arrow appears.  Then the user clicks and 
drags the border to the desired location. 
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The user will need to unlock the model by clicking on the Lock ( ) icon shown in Figure 3-2.  
Notice that other icons adjacent to the Lock ( ) icon will change to unlocked ( ) on the toolbar. 

 

Figure 3-2 SNAP Model Editor screen 

One powerful feature in SNAP/RADTRAD is the ability to check the model for input errors.  To 
illustrate the use of this feature, click on Tools->Check Model to perform a model check.  Note 
that the message Note: Model check complete.  No errors found in the Message window at the 
bottom of the screen. 

The input groups are shown in the Navigator window.  Clicking on the Expand ( ) icon will 
expand each group and node, showing the associated input data for that input group and node.  
Figure 3-3 presents an illustration of a node expansion which is obtained by clicking on the 
Expand ( ) icon next to Compartments, then clicking on Compartment 1.  Note that the 
Compartment 1 input appears in the Property window (lower left).  The user should experiment 
with other input groups as the approach is the same.  Input specification will be presented later 
in this section. 

Note that the black bar where the input model name appears (Test23.med) contains some 
important features which are summarized in Section 3.4.  One of these features is the ability to 
switch units from British to International System of Units (SI).  Units switching is done by right-
clicking on the black bar, selecting Engineering Units->British to change the units from SI to 
British. 
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Figure 3-3 Illustration of the expand icon 

Icons are used to represent the various components used in the View / Dock window that 
comprise a typical model.  Figure 3-4 presents an illustration of the various icons used. 
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Figure 3-4 Illustration of the various icons used to represent a SNAP/RADTRAD 
model 

3.2.2 Job Streams and Case Execution in SNAP/RADTRAD 

Before continuing the discussion of existing model features and developing a new model, the 
Test23 case will be run to illustrate how cases are run. 

Case execution is dependent on the job stream, which may be a source of confusion for new 
SNAP/RADTRAD users.  Simply put, job streams are used to pass input and output data from 
one code to another for cases where multiple codes are used.  SNAP is used to support a wide 
variety of analysis programs that pass data from one program to another.  This feature is less of 
an issue with SNAP/RADTRAD because in most cases, output from SNAP/RADTRAD 
(RADTRAD-AC) is only passed to AptPlot for plotting.  For the convenience of the user, a 
default job stream is predefined for all SNAP/RADTRAD cases. 

Figure 3-5 presents a typical SNAP/RADTRAD job stream.  The default job stream for 
SNAP/RADTRAD shows three steps: 1) input preparation shown in the RADTRAD Model 
(Base_Model node), 2) the analytical code execution in the RADTRAD (RADTRAD node) 
(middle box in Figure 3-5), and 3) the passing of plot data from SNAP/RADTRAD to AptPlot 
(PlotStep node).  The input is passed from the Model Editor (Base_Model node) to the 
RADTRAD-AC (RADTRAD node) and then the plot file data generated by the RADTRAD-AC is 
passed to the AptPlot (PlotStep node). 
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Figure 3-5 Typical job stream in SNAP/RADTRAD 

As in the case of model input, job streams specification can also be checked.  In the case of the 
Test23 problem, expand the Job Stream node in the Navigator window; select Test23 and right-
click, then select Check Stream.  An error report window will appear in the Message window 
and in this case, no errors were found. 

Part of the job stream input specification is to determine where the RADTRAD-AC output will be 
written.  To display the location of the RADTRAD-AC output clicking on the Expand ( ) icon for 
the Job Streams node and select the Test23 job stream to open the Property window as 
illustrated in Figure 3-6. 

 

Figure 3-6 Job stream Property window 

The two job stream properties which determine where the output is written are the Root Folder 
text box and the Relative Location text box.  The SNAP/RADTRAD output is then the Relative 
Folder location appended to the Root Folder location.  To review the root folder settings, click on 
the Custom Editors ( ) icon and a window similar to that shown in Figure 3-7 appears.  In this 
example, three root folders along with the path locations are shown. 
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Figure 3-7 Typical root folder settings in SNAP/RADTRAD 

Assuming that the root folder is set to Samples, the path to the output will be 
Samples\RADTRAD or C:\Work\Current\0-RADTRAD\Training\Samples\RADTRAD.  In a new 
installation, the root folder is not set.  When the root folder is not set, the message No Root 
Folders Available appears in red as shown in Figure 3-8. 

 

Figure 3-8 Job stream Property window with an unset root folder 

Setting the root folder requires selecting the Custom Editors ( ) icon under the Root Folder text 
box to open the Edit Calculation Server Root Folders window (Figure 3-7).  Click on the New      
( ) icon and navigate to the desired location in the Select Folder Location window.  The root 
folder name will change to the last folder name in the directory path. 



 

3-9 

The relative location can be reset and should be reset to a name more mnemonic so that the 
SNAP/RADTRAD cases can be tracked.  For example, to change the name, highlight the 
Relative Location Name and type in a new name (Sample to Test23).  Note that the file location 
is automatically appended. 

Note that multiple root folders are allowed which is handy for organizing SNAP/RADTRAD case 
files.  To add a root folder, navigate to Tools->Job Status or click on the Job Status ( ) icon and 
expand Local.  Right-click on Local and select Root Folders.  Click on the New ( ) icon (left on 
Toolbar) and navigate to where you want the root folder (ex. NPP Dose Analysis).  The root 
folder path will be created.  Also, a path of subdirectories can be specified in the Relative 
Location text box separated by a backslash ( \ ).  For example, the relative location can be set to 
RADTRAD\LOCA, so that the path to the output would be snap\Samples\RADTRAD\LOCA 
assuming that the root folder is set to Samples. 

A couple of points should be noted about root folders.  First, the root folder directory needs to 
exist – otherwise you’ll get a warning that the directory doesn’t exist and the root folder will 
not be defined.  Second, overlapping paths are not allowed and will generate an error. 

Finally, one remaining item should be configured before proceeding to submit the job stream 
for execution.  This remaining item is to the link the SNAP Model Editor to the RADTRAD-AC 
by navigating to Tools->Configuration Tool to open the SNAP Configuration window and then 
expanding the Applications node by clicking on the Expand ( ) icon.  After the Applications 
node has been expanded, right click the Applications node to open the drop-down menu as 
shown in Figure 3-9.  Select New on the drop-down menu to open the Create Application 
window.  Enter RADTRAD in the Application Name text box and scroll down to select the 
RADTRAD application and click OK as shown in Figure 3-9. 
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Figure 3-9 Linking the RADTRAD-AC using the SNAP configuration tool 

The SNAP Configuration window will then change to display the RADTRAD application with 
an error under the Applications node (Figure 3-10).  On the right hand side of the SNAP 
Configuration window under the Application Location->Local Location text box click the Select 
( ) icon to open Windows File navigator.  Navigate to radtrad subdirectory under the snap 
directory in the in the user’s home directory as discussed in Section 2.3.3 and select the 
radtrad.jar file for the RADTRAD-AC (not the RADTRAD Plugin).  (Note:  The file directory 
path should look something like “C:\Users\{User Name}\snap\radtrad\radtrad.jar” and not 
“C:\Users\{User Name}\snap\Plugins\radtrad.jar.”)  Be sure to save these changes by 
selecting the Save ( ) icon and the Close button on the Save Complete window as shown in 
Figure 3-10.  At this point, the user can run Test23. 
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Figure 3-10 Saving the RADTRAD-AC using in the SNAP configuration tool 

To run the Test23 or any other case, click on Tools->Submit Job.  A Submit Job Stream window 
will appear as shown in Figure 3-11.  Click on OK and a confirmatory Submit Stream window 
will appear.  Finally, click OK and the run will start.  The SNAP Job Status window will appear 
which is also shown in Figure 3-11.  The SNAP Job Status window, in Figure 3-11 displays a 
completed job stream run. 
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Figure 3-11 SNAP/RADTRAD job stream and status windows 

The relationship between the SNAP/RADTRAD job stream and the actual case execution is 
shown in Figure 3-12.  In the upper left-hand corner, the graphical job stream representation is 
shown.  As noted earlier, this representation shows passing input from the Model Editor to the 
RADTRAD-AC and then to AptPlot.  The job stream properties are shown in the Navigator 
window shown in the upper-right corner of Figure 3-12.  The links between the various nodes 
are also shown.  In the SNAP Job Status window, the status of each of the job stream steps is 
shown.  Again three steps are shown.  The user interaction with the SNAP Job Status window 
will be discussed in Section 3.2.3.  
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Figure 3-12 Relationship between job stream steps and code execution 

Note that the SNAP Job Status window can be accessed from Tools->Job Status in the Model 
Editor for subsequent viewing.  A summary of features relevant to SNAP/RADTRAD available in 
the SNAP Job Status window are listed below: 

• The Job Console ( ) icon – provides the time step history for the current job. 

• The Job Execution ( ) icon – terminates the execution of the current job.  This is only 
available when the job is running. 

• The Job Deletion ( ) icon – removes the current job and files. 

• The AptPlot ( ) icon – opens the selected job for plotting in AptPlot. 

• The File Viewer ( ) icon – starts the output file viewer. 
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3.2.3 SNAP/RADTRAD Input and Output Files 

There are a number of files produced that the user should be aware of in SNAP/RADTRAD.  
The main SNAP/RADTRAD interface file is the casename.med file where casename is the 
name of the case being analyzed.  The casename.med file contains the data needed to render 
the model in the SNAP Model Editor GUI, the default data used by the code and the user-
specified input data.  Section 3.4 discusses the actual input that can be specified for a 
SNAP/RADTRAD model. 

When a SNAP/RADTRAD case is executed through the RADTRAD-AC, the data flow is not 
directly from the casename.med file.  Rather, there are a number of data files that are produced 
by the SNAP/RADTRAD plugin that are read by RADTRAD-AC.  These files, which are in 
extensible markup language (XML) format, include DCFs (“*.dfx”), nuclide data (“*.nix”), plant 
information (“*.psx”), release fraction (“*.srx”), and nuclide inventory (“*.icx”) files.  Output files 
(.out, .screen and .plot) are produced by the RADTRAD-AC.  Log files produced by 
SNAP/RADTRAD are job stream related files (“*.streamlog” and “*.tasklog”).  Table 3-1 provides 
a brief description of these files. 

When case execution is completed, the SNAP/RADTRAD output can be reviewed by clicking on 
the File Viewer ( ) icon.  Note that there is a context in terms of the active job stream step and 
the output that is displayed.  If the casename step is highlighted, then the job stream log will be 
available for viewing.  If the RADTRAD step is highlighted as shown in the SNAP Job Status 
window in Figure 3-13, then the RADTRAD-AC output is available.  If the PlotStep is 
highlighted, then the plot file data can be viewed using AptPlot.  Figure 3-13 shows a 
screenshot of the drop-down menu cascade from the File Viewer ( ) icon for the RADTRAD job 
step from the SNAP Job Status window. 

 

Figure 3-13 Drop-down menus for SNAP/RADTRAD output 
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Table 3-1 Files available for viewing using the file viewer in the job status window 

File Name Description 

Job Status Window Casename Files 

StreamLog - Casename.streamlog a 

Output from job stream manager.  Provides a high-
level summary of the execution steps for the job 
stream.  Typically not reviewed by the 
SNAP/RADTRAD user. 

Job Status Window RADTRAD Files 

Plot Files->plot - radtrad.plt c Data file for AptPlot from the RADTRAD-AC. 

Text Files->input – radtrad.psx b 

Plant data input file in XML format.  Includes the plant-
specific data specified by the user including model 
parameters, information for plant geometry for each 
compartment, information for each flow path, dose 
point information including Χ/Q and breathing rates, 
occupancy factors, and information for various 
radionuclide removal models (sprays, natural 
deposition, and filters). 

Text Files->nix – radtrad.nix b 
Nuclide data information from ICRP-38 in XML format.  
Includes the atomic mass, half-life (s), and branching 
ratios for radionuclide daughters. 

Text Files->dfx – radtrad.dfx b 

DCF file in XML format based on FGR 11 and 12 (see 
Section 4.6).  Includes the organ-specific DCFs.  Note 
that only the cloudshine (immersion), the inhaled 
chronic [total effective dose equivalent (TEDE)] and 
thyroid skin DCFs are used to determine dose.  
Organ-specific factors as well as those factors for 
groundshine, inhaled acute and ingestion are not 
used. 

Text Files->icx_1 – radtrad_1.icx b 

Text Files->icx_2 – radtrad_2.icx b 

(etc.) 

Initial radionuclide inventory file in XML format. 

Duration of source term release and release fractions. 

Text Files->srx_1 – radtrad_1.srx b 

Text Files->srx_2 – radtrad_2.srx b 

(etc.) 

Release fraction information file for each radionuclide 
group. 

Text Files->output – radtrad.out c Output file from the RADTRAD-AC in the original 
format. 

Text Files->NRC-out – radtradNRC.out c Output file from the RADTRAD-AC in the revised NRC 
format. 

Text Files->log – radtrad.log a Debug output (usually not referred to by the user). 
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Table 3-1 Files available for viewing using the file viewer in the job status window 
(cont.) 

File Name Description 

Text Files->screen – radtrad.screen c Problem time output to show progress of a given 
case. 

Text Files->Task Log – RADTRAD_tasklog a 
Output from SNAP job steam showing RADTRAD job 
step execution information (usually not referred to by 
the user). 

Job Status Window PlotStep Files 

PDF Documents – time_pdf – time.pdf c Time step results (usually not referred to by the user). 

Text-Files->screen – aptplot.screen Screen output from AptPlot (usually not referred to by 
the user). 

Text-Files->Task Log – PlotStep.tasklog 
Output from SNAP job steam showing AptPlot job 
step execution information (usually not referred to by 
the user). 

a.  SNAP/RADTRAD specific output. 
b.  Input file to the RADTRAD-AC generated by SNAP/RADTRAD plugin. 
c.  Output file from the RADTRAD-AC. 

The files produced by the RADTRAD-AC code, radtrad.out, radtradNRC.out, radtrad.plt, and 
radtrad.screen are the most relevant to the user.  The radtrad.out file is basically the original 
(version 3.03/3.10) output file.  Major sections of this output file are: 

• Input listing – provides a listing of the input in XML format that is used by the 
RADTRAD-AC. 

• Input echo – provides an edited input summary of plant description (model), scenario 
(radionuclide source term/DCF) information, compartment/pathway data, Χ/Q, DCF 
and decay data, and other relevant input. 

• Breakdown of dose results and nuclide inventory in various compartments at various 
time points generally selected by changes in events (i.e. time at which flow rate 
changes, and time at which Χ/Q changes).  Activity balance information is also given. 

• I-131 inventory in various compartments as a function of time. 

• Cumulative dose results at various dose locations as a function of time. 

• Worst two-hour doses at the EAB and the final doses and final doses for the LPZ and 
other dose locations. 

The output contents can be controlled from Model Options node by expanding the Output 
Parameters tab in the Property window as shown in Figure 3-14.  The main difference in the 
output is generally the editing of results for supplemental time steps when they are used and the 
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model removal/decontamination factors.  The Output Parameters flags are discussed in more 
detail in Table 3-5. 

 

Figure 3-14 Expanded Output Parameters tab in the Property window 

The radtradNRC.out output file provides a time-dependent summary of activity and dose 
calculations by nuclide.  The contents of the radtradNRC.out file are controlled by expanding the 
NRC Output Flags tab under Model Options node in the Property window.  See Figure 3-15 for 
the output parameters available.  Major sections of this output are: 

• Input echo – provides an edited input summary of plant description (model), scenario 
(radionuclide source term/DCF) information, compartment/pathway data, Χ/Q, DCF 
and decay data, and other relevant input. 

• Output – activity distribution, cumulative and dose difference (delta-dose) for each 
dose component (inhalation, cloudshine, skin, thyroid, and TEDE). 

• I-131 inventory in various compartments as a function of time. 

• Cumulative dose results at various dose locations as a function of time. 

• Worst two-hour doses at the EAB and the final doses and final doses for the LPZ and 
other dose locations. 

The NRC Output Flags are discussed in more detail in Table 3-5.  The radtrad.screen file lists 
the time step history for a given SNAP/RADTRAD case. 
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Figure 3-15 Expanded NRC Output Flags tab in the Property window 

3.2.4 AptPlot Plotting Program 

A feature of SNAP/RADTRAD is the ability to display plots of dose results.  To display a plot, 
click on Plot Files and select plot – radtrad.plt.  AptPlot will open.  Alternately, click on the 
AptPlot ( ) icon in the SNAP Job Status window and AptPlot will open as illustrated in Figure 3-
16. 

 

Figure 3-16 SNAP/RADTRAD Job Status window with AptPlot icon highlighted 
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When AptPlot opens, the windows presented in Figure 3-17 will appear.  Dose information by 
dose location (ExclusionAreaBoundary, LowPopulationZone, and ControlRoom spaces omitted) 
and dose category (body, cloudshine, skin, tede, and thyroid) for each nuclide separated by 
periods will be presented in the Select EXTDATA Channels window in Figure 3-18.  In AptPlot, 
each data set is referred to as a data channel.  Test Problem 23 is used to illustrate the features 
of AptPlot and it is suggested that the user open AptPlot for Test Problem 23 and follow the 
discussion below. 

 

Figure 3-17 AptPlot startup view 

Basically to make a plot, the user scrolls to the result of interest, highlights that result, clicks on 
the Plot button and the plot will appear.  Note that the default time units are in seconds, but that 
can be changed to hours in the drop-down menu next to Time Units text box on the Select 
EXTDATA Channels window (Figure 3-18) prior to actually generating the plot. 

AptPlot has many features for generating and formatting plots and the discussion presented 
here is not meant to be exhaustive.  A comprehensive help manual can be obtained by selecting 
Help->Help Topics from the top menu.  However, some of the more commonly used features 
are illustrated here. 

As the user gains familiarity with the naming convention, the filter feature can be used to locate 
specific results of interest by entering the dose location, dose category, and nuclide of interest in 
the Filter text box (Figure 3-18).  If the user wants to plot the TEDE dose results for the control 
room, enter the text string ControlRoom.tede* in the Filter text box.  Note that the total TEDE 
dose ends with tede (i.e. no nuclide is listed).  Also note that the asterisks (wildcard) symbol is 
used to control the list of all items.  Wildcards can be embedded in the string (i.e. 
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ControlRoom.*.I*) to list the control room dose categories for all iodine nuclides.  It is very 
important to note that the case of a character counts in applying filters in AptPlot, otherwise the 
wildcard search feature will not work properly.  The spelling of the dataset name in the data 
channel window provides a guide for spelling a channel name. 

 

Figure 3-18 Select EXTDATA Channels window for multiple plots 

Multiple data results can be plotted by highlighting the data of interest and clicking the Plot 
button.  As an example, suppose the user wants to plot the thyroid dose for I-131 through I-135 
for Test Problem 23.  The user would enter ControlRoom.thyroid.I* in the Filter text box, then 
select the resulting data channels in the Select EXTDATA Channels window and click on the 
Plot button to make the plot.  This string can be shortened to C*R*th*I* as a further example of 
the application of wildcards.  To select multiple data channels requires the use of shift-click or 
control-click feature as described below: 

• Shift-click – used to select a range of datasets.  In this case, click on 
ControlRoom.thyroid.I131.  Then hold down the shift key and select 
ControlRoom.thyroid.I135. 

• Control-click – used to select multiple datasets one at a time.  Hold down the control key 
and click on each dataset, selecting that dataset.  Each dataset is highlighted after 
selection. 

With either approach, all of the dose datasets will be highlighted as shown in Figure 3-18.  Once 
the datasets are highlighted, click on the Plot button and the plot will be generated.  The 
resulting plot is shown on Figure 3-19. 
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Figure 3-19 Control room dose plots for Test23 

Adjustments can be made to the plot by using the plot editing features in AptPlot.  These 
features are accessed by selecting Plot in the top menu.  A number of features are available, 
but generally Plot->Graph appearance, Plot->Set appearance and Plot->Axis properties provide 
the features needed to edit the plot.  Screenshots of each of these windows are shown in 
Figures 3-20 through 3-22.  Clicking on the tabs in each window shows various properties and 
features available to the user.  A subset of these features is used to edit the plot. 

Some typical AptPlot adjustments are illustrated below: 

• Change the x-axis scale from seconds to hours: – Navigate to the Select EXTDATA 
Channel window shown in Figure 3-18 and click on Clear Sets in the lower left-hand 
portion of the screen.  Then change the units in the Time Units drop-down menu from 
Seconds to Hours.  Confirm that the dose components are highlighted as shown in 
Figure 3-18 using shift-click or control-click.  Then, click on Plot and Time (hours) will 
appear on the x-axis. 
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• Reset y-axis to logarithmic scale: – Given that the I-131 dose is so dominant, it is hard 
to read the dose contributions from the other iodine nuclides.  The y-axis scale can be 
changed to logarithmic by selecting Plot->Axis properties to open the Axes window 
(Figure 3-20).  Change the axis setting in Edit text box from X axis to Y axis and click 
on the Main tab if it is not already selected in the Axes window (Figure 3-20).  Then 
change the Scale text box from Normal to Logarithmic and click the Apply button to 
change the y-axis to logarithmic. 

• Expand y-axis to cover dose range: – The dose range can be expanded by changing 
the Start and Stop values to 0.0001 and 10.0 in the Axes window.  The Axes window is 
obtained by selecting Plot->Axis properties to open the Axes window (Figure 3-20).  
Click on the Main tab if it is not already selected.  Change the edit box to Y axis.  Then, 
enter 0.0001 in the Start text box and 10.0 in the Stop text box.  Then click the Apply 
button to apply the change. 

 

Figure 3-20 AptPlot Axes window 

• Use scientific notation for the y-axis: – The format for the y-axis labels is set by 
changing the Edit drop-down menu setting in the General section of Figure 3-20.  
Then, set the number format in the Format drop-down menu in the Tick properties 
section to Scientific from General.  Also set the precision to 0 in the Precision drop-
down menu and click the Apply button to reset the format. 

• Line colors: – The line colors selected by AptPlot can be hard to see.  Each line color 
can be individually adjusted by the user.  To adjust a line color select Plot->Set 
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appearance to open the Set appearance window (Figure 3-21).  Highlight the dataset 
to be changed in the Data sets section near the top of the Set appearance window 
(Figure 3-21).  Note that the name of the data contained in a given dataset is identified 
by the String text box in the Legend section in the lower part of the window.  Also, note 
that the current color of a particular dataset is shown in the Color drop-down menu in 
the Line Properties section.  Using that drop-down menu, select the desired color and 
click on the Apply button.  Alternately, to change the color of all lines to black for 
example, highlight all datasets using shift-click or control-click or alternately clicking on 
the All button.  Then, select Black in the Color drop-down menu (if it is not already 
selected) and click on the Apply button. 

 

Figure 3-21 AptPlot Set appearance window 

• Line symbols: – Symbols for the lines are set from the Main tab in the Set appearance 
window (Figure 3-21).  To select a symbol for a particular data set, highlight the 
dataset in the Data sets section, then select a symbol type (circle, square, etc.) under 
the Type drop-down menu in the Symbol Properties section.  Also, select the desired 
color in the Color drop-down menu and click the Apply button.  A symbol will appear 
for each data point and since there are hundreds of data points, a symbol skip will 
have to be set.  Select the Symbols tab in the Set appearance window and highlight 
the dataset to be changed.  Then, set the Symbol skip to a value like 50 or 75 and click 
on the Apply button.  This setting will display a symbol for every 50th or 75th point.  
Repeat these steps for each dataset. 
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• Line style: – Line styles (solid, dash, dot-dash, etc.) can be set by selecting the Main 
tab in the Set appearance window (Figure 3-21), highlighting the desired data set in 
the Data sets sections and selecting the desired style using the Style drop-down menu 
in the Line Properties section in a manner similar to setting line colors and line 
symbols.  Each line is set individually, and then click the Apply button as the settings 
for each dataset are completed. 

• Titles and subtitles: – To add a title and subtitle to the plot select Plot->Graph 
appearance to open the Graph appearance window (Figure 3-22).  In the Main tab 
section enter a title and subtitle as appropriate, then click on the Apply button.  The 
title and subtitle will appear.  Select the Titles tab and use the sliders to adjust the font 
size for the title and subtitle as desired.  Note the font size can be incremented by 
clicking on the channel to the left or right of the slider icon. 

 

Figure 3-22 AptPlot Graph appearance window 

Sometimes the legend box overwrites the dose results as in the plot shown in Figure 3-19.  In 
order to correct this issue, the plot needs to be shrunk, which will require using several AptPlot 
features.  These features are listed below: 

• Edit the legend titles: – The title for each legend can be edited.  This change is made 
by selecting Plot->Set appearance to open the Set appearance window (Figure 3-21) 
and highlighting the desired data set.  Change the title in the String text box in the 
Legend section as appropriate.  In this case, the iodine nuclide name is used.  Click on 
the Apply button after each title modification is made. 
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• Change the font size for the legend: – First, the font size used in legend box will need 
to be reduced, which entails changing the legend title font and the symbol font.  To 
change the font size of the legend title, select Plot->Graph appearance to open the 
Graph appearance window (Figure 3-22) and click on the Legends tab.  Then, use the 
slider bar to adjust the font size to 75 for example and click on Apply button.  The font 
size will change for all datasets.  For the symbol size, navigate to the Set appearance 
window (Figure 3-21) and select all datasets.  Then, change the Size setting in the 
Symbol Properties section to 75 using the slider. 

• Change the size of the plot: – The plot overlays a white background which is basically 
set to allow a plot to be printed on 8.5 x 11 paper in landscape mode.  So, it is 
desirable to maintain this setting although it can be changed by navigating to View-
>Page setup.  However, the approach used here is to shrink the plot by adjusting the 
settings in the Viewport section in the Graph appearance window (Figure 3-22) by 
entering suitable values.  In this case, the X max and Y max text box settings are 
changed to 1.0 and 0.8, respectively.  These settings permit the legend box to be 
moved to the right-hand side of the plot, and then click on the Apply button.  Then, to 
move the legend box, select the Leg. Box tab in the Graph appearance window (Figure 
3-22) and adjust the box location in the X and Y text boxes in the Location section.  
Values of 1.05 and 0.60 will move the legend box to the right-hand side of the plot.  
Another approach is to change the X max text box setting to 1000 which will allow 
sufficient space for the legend box within the plot frame, although it will probably need 
to be moved for aesthetic reasons. 

The plot is saved by selecting File->Save and then navigating to the desired directory location, 
entering a suitable name, then click on OK, similar to any Windows program.  To access a 
previously saved AptPlot plot, select File->Open, and navigate to the directory location where 
the plot file is saved and select that file.  Also, the format and title settings can be saved by 
selecting Plot->Save defaults and overwriting the Defaults.agr file.  Note that Plot->Reset 
defaults will reset the defaults to the original settings.  Figure 3-23 shows the resulting plot with 
the above modifications. 

Note that plots can be generated in a picture format such as “*.png” or “*.jpeg” by navigating to 
File->Print setup.  At the top of the Device setup window, change the device to “*.png” for 
example.  In the Output section, check that the directory path and filename are suitable.  Then, 
click on the Print button and the plot will be saved in “*.png” format using the filename set for the 
plot file. 
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Figure 3-23 Reformatted control room dose plots for Test23 

For those users who wish to use a spreadsheet for data analysis or for plotting, the dose data 
can be exported.  The easiest way is to initiate a new plot session in a comma-delimited format 
that can be read by Microsoft Excel.  This feature is accessed from the Select EXTDATA 
Channels window (Figure 3-18).  As an example, set up and apply a filter for the I-131 to I-135 
thyroid dose in the control room and select the resulting data channels as done previously.  
Then, highlight the data channels and click on the Export button at the bottom of the window.  A 
Save window will appear.  Provide a filename, ending the filename with the “*.csv” suffix and 
select comma separated values as the file type (right hand side of the Save window).  Then, 
click on Save to write the file.  Microsoft Excel will read and organize the dose data by column 
for subsequent use. 

3.3 SNAP/RADTRAD Model Development and Modification 

Sections 3.1 and 3.2 introduced the SNAP/RADTRAD Model Editor user interface using Test 
Problem 23 as an example.  In this section, the details of building a new model are presented.  
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For this illustration, a model consisting of a simple containment compartment, leakage pathway, 
source and an environment compartment will be developed. 

3.3.1 Model Editor Menus 

The commands available in the Model Editor are typical of Windows programs.  Across the top 
of the Model Editor, the File, Edit, Tools, Window, and Help commands are presented.  Table 3-
2 describes the commands associated with each of these menu items. 

Table 3-2 Summary of Model Editor menu commands 

Menu Command Description 

File Commands 

File->New 
Creates a new model.  A Select Model Type menu appears with 
available models listed.  The SNAP/RADTRAD user picks RADTRAD 
and clicks on the OK button. 

File->Open 
Opens a previously developed model (“*.med” file).  The user navigates 
to the directory where the file is located and selects the file to be 
opened similar to any Windows program. 

File->Open Recent 
Allows the user to open a recently used SNAP/RADTRAD model (or 
AVF file).  The user selects the file of interest and it will open in a new 
Model Editor session. 

File->Save Saves the current model with the same name as in any Windows 
program. 

File->Save As 
Saves the file under a new filename.  The user navigates to the desired 
directory location and/or updates the filename and clicks the Save 
button as in any Windows program. 

File->Close Closes the current model.  Provides a warning to the user in the case 
of any unsaved changes made to the model. 

File->Close All Closes multiple open models.  Provides a warning to the user in the 
case of any unsaved changes made to the model. 

File->Import 

Imports a previously exported RADTRAD model from a set of ASCII or 
XML input files (see Section 3.1).  Note that a “*.psf” file is an ASCII file 
from RADTRAD version 3.03 or 3.10 with the same input data as the 
XML formatted “*.psx” files. 

File->Export Exports a set of SNAP/RADTRAD XML input files (“*.psx”, “*.nix”, 
“*.srx”, “*.icx”, and “*.dfx”) to a directory selected by the user 

File->Exit Exits the Model Editor. 
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Table 3-2 Summary of Model Editor menu commands (cont.) 

Menu Command Description 

Edit Commands 

Edit->Undo Reverses previous user inputs to a model similar to most Windows 
program. 

Edit->Redo Redoes a previous undo command similar to most Windows program. 

Edit->Preferences Allows the user to set various preferences related to fonts, colors, and 
other Model Editor features. 

Edit->Plugin Manager 

Opens a dialog listing all of the available SNAP plugins.  Toggling the 
check-box next to each plugin allows for loading and unloading the 
plugin.  This feature is not generally used for SNAP/RADTRAD 
because the RADTRAD-AC only uses the RADTRAD Plugin. 

Tools Commands 

Tools->Check Model Provides a check of the SNAP/RADTRAD input model.  This feature is 
very useful for model development in SNAP/RADTRAD. 

Tools->Submit Job Submits a model through the job stream and starts the SNAP Job 
Status Tool (see Section 3.2.2). 

Tools->Steam Tables Not used in SNAP/RADTRAD. 

Tools->Configuration Tool Starts the SNAP/RADTRAD Configuration Tool used to configure 
global properties for running RADTRAD under SNAP 

Tools->Job Status Starts the SNAP/RADTRAD SNAP Job Status window (see Section 
3.2.2). 

Tools->Model Note Viewer Displays model notes.  The user can set up and edit notes as part of 
the model documentation. 

Tools->Export to jEdit Exports a model to the jEdit editing program.  This feature requires the 
installation of jEdit. 

Windows Commands 

Windows->Commands Scripting commands window – not used in SNAP/RADTRAD. 
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Table 3-2 Summary of Model Editor menu commands (cont.) 

Menu Command Description 

Help Commands 

Help->Contents Link to the SNAP Model Editor manual, which includes information 
about the RADTRAD Plugin. 

Help->Check for Updates Checks for updates at the APT, Inc. website.  Note that computer 
security settings may inhibit this feature. 

Help->Report an Issue 

Allows the user to submit Issue Reports on SNAP/RADTRAD directly 
to APT, Inc.  Note that issues related to the RADTRAD-AC should be 
reported via the SNAP/RADTRAD Forum webpage under the 
SNAP/RADTRAD Support link on the RAMP website. 

Help->About 

Provides information on the SNAP Model Editor GUI and Plugin 
version, licensing agreements, and contact information.  Note that 
plugin version numbers can be obtained by clicking on the Plugins 
button. 

Figure 3-24 shows the icon arrangement and function of each icon in the Model Editor.  Of 
particular interest is the ability to separate the Navigator, Property, and View / Dock windows 
into separate windows and to also arrange the windows vertically by clicking on the 
Single/Multiple Windows Modes icons shown in Figure 3-24.  The remaining icons provide a 
shortcut to some of the menu commands listed in Table 3-2. 

 

Figure 3-24 Model Editor tool bar icon description 

Figure 3-25 shows the icon arrangement and the function for each icon in the Navigator window.  
Basically, these tools aid the user in navigating component nodes in the Navigator window and 
multiple models in the SNAP Model Editor GUI. 



 

3-30 

 

Figure 3-25 Navigator window tool bar icon description 

3.3.2 Building a SNAP/RADTRAD Model – Component Specification 

The first step is to start the SNAP Model Editor and click on Create a New Model in the 
Welcome screen (Figure 3-1).  Alternately, a new model in SNAP/RADTRAD can also be 
created by selecting the File->New command as noted in Table 3-2.  Select RADTRAD model in 
the Select Model Type screen and notice that the Model Editor opens with no icons in the View / 
Dock window (similar to Figure 3-2).  The basic model nodes are shown in the Navigator 
window.  Expand the Compartment [1] node using the Expand ( ) icon in the Navigator window.  
Highlight (click on) the Compartment 1 (Environment) node, so that data fields for this 
compartment will appear in the Property window.  Note that an environment compartment is 
defined by default. 

The basic approach to building a SNAP/RADTRAD model is to set up an array of 
compartments, flow pathways and specify key parameters in the various components of the 
model.  For sources, compartments, and pathways that ultimately appear in the View / Dock 
window, the basic pattern is to highlight (select) the component category (i.e. Source, 
Compartments and Pathways), right-click on the component category, and select New from the 
menu to add a numbered component to that component category.  These steps result in a new 
model component being created. 

A new compartment is added by right-clicking on the Compartment node in the Navigator 
window and selecting New from the drop-down menu that appears.  A new compartment 
component Compartment 2 is created.  Components are not automatically added to the View / 
Dock window, but must be added by the user.  The new component (Compartment 2) is added 
to the View / Dock window by right-clicking on the Compartment 2 and selecting Add to View-
>Default View from the drop-down menu.  Compartment 2 now appears in the View / Dock 
window. 

The new component (Compartment 2) is unnamed.  To add a name to the component, type a 
name (i.e. Containment) in the Name text box in the Property window.  The name will 
simultaneously appear in both the Navigator and View / Dock windows [Compartment 2 
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(Containment)].  Alternately, newly-defined components can also be dragged from the Navigator 
window to the View / Dock window by clicking on the component of interest and dragging it by 
holding the left mouse button down and moving the cursor to the View / Dock window. 

The pre-defined Environment compartment is added to the View / Dock window in a manner 
similar to Compartment 2 (Containment) above.  Right-click on Compartment 1 (Environment) 
and select Add to View->Default View or drag the component by clicking on the Compartment 1 
(Environment) node and dragging it into the View / Dock window.  The environment 
compartment will appear in the View / Dock window.  Note that two dose locations (EAB and 
LPZ) are automatically specified with the environment compartment. 

The next step is to define a flow pathway which is done by right-clicking on the pathway group 
node (Pathways [0]) and selecting New from the drop-down menu that appears.  Add Pathway 1 
to the View / Dock window by right-clicking on Pathway 1 and then selecting Add to View-
>Default View or drag the component by clicking on the Pathway 1 node and dragging it into the 
View / Dock window.  The flow pathway should be named by entering a suitable name in the 
Name text box in the Property window (i.e. Leakage). 

Similarly a source can be added by right-clicking on the Sources node in the Navigator window 
(Sources [0]) and selecting New from the drop-down menu that appears.  After naming the 
component (i.e. Fuel Release), the component can be added to the View / Dock window in the 
same manner as used above for the compartments and flow pathways. 

At this point, the user can see that a pattern is emerging.  Each input group has an associated 
group node where components within that group can be defined and added to the Navigator 
window.  Figure 3-26 displays the Navigator window for the components added in the previous 
steps above.  The component nodes that can be added as part of a model are: Sources, 
Compartments, and Pathways.  The nodes for Dose Locations, Natural Deposition, Filters, 
Sprays, and Χ/Q Tables are not drawn, but are defined in the same manner as compartments, 
pathways, and sources by right-clicking on the component group node and selecting New from 
the drop-down menu that appears. 

The user has developed a new model consisting of a source, a compartment representing the 
containment, a leakage pathway and an environment compartment.  Also, this new model was 
added to the View / Dock window by either dragging the new component nodes to the View / 
Dock window or right-clicking on the new component nodes, then selecting Add to View-
>Default View.  Figure 3-27 shows the View / Dock window with the new model’s components.  
Additionally, once the components are added to the View / Dock window, they can be moved 
around by the user for presentation clarity.  Make sure the Selection Tool ( ) icon is activated 
before selecting a component icon to be moved in the View / Dock window.  Features common 
to most Windows-based programs are available to aid the user in editing and arranging icons.  
The function of each icon can be determined by hovering the mouse pointer above the icon of 
interest.  This action should cause a text pop-up to appear with a short statement of the function 
of that icon.  The tools and features most commonly used in SNAP/RADTRAD are illustrated in 
Section 3.3.4. 
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Figure 3-26 Navigator window with newly added model components 

 

Figure 3-27 View / Dock window for 4-node model (unconnected) 
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Table 3-3 shows all of the icons which are available in the View / Dock window with a 
description of each icon.  All of the icons for the compartments, sources and pathways have 
connection points for connecting flow pathways and source components to compartment 
components as illustrated in Figure 3-27.  The number in the different icons in Figure 3-27 are 
the component numbers (i.e. the number of Compartments, Pathways, and Sources), which are 
generally consecutive in SNAP/RADTRAD models. 

One feature that the user should be aware of is the orientation feature for flow pathway icons.  
In Figure 3-27, the orientation is pointing right; however, the orientation can be changed to 
pointing up, pointing down, or pointing left by right-clicking on the flow pathway icon and 
selecting Drawn Orientation from the drop-down menu that appears and then pick the desired 
orientation. 

Table 3-3 Icons used in the View / Dock window 

View / Dock Window Icons Description 

 
Compartment Icon 

Flow pathway connection point indicated by small circles on 
each edge.  Small square at the upper-left corner is a source 
connection point. 

 
Source Icon 

Small square at the lower edge is a source connection point to a 
compartment. 

 
Flow Pathway Icon 

Flow pathway connection point indicated by small circles on 
each side. 

 
Environment Icon 

Flow pathway connection point indicated by small circles on 
each edge.  Small square at the upper-left corner is a source 
connection point. 

 
Natural Deposition Icon 

Icon denoting that natural deposition is active in a component 
(grayed-out indicates inactive). 

 
Filters Icon 

Icon denoting that a filter is defined in a component (grayed- out 
indicates no filter). 

 
Sprays Icon 

Icon denoting that a spray is defined in a component (grayed-
out indicates no spray). 

The next step is to connect the components using the Connection Tool ( ) icon shown in the 
View / Dock window tool bar (see Section 3.3.4).  Connection points for the various icons are 
shown in Figure 3-27.  These connection points are indicated by circles and squares on 
periphery of the icons.  The first step is to click on the Connection Tool ( ) icon or (cross hairs) 
icon in the View / Dock window tool bar, which activates the connection tool.  Then for 
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compartment to flow pathway connections, click on the connection point (circle) on the edge of 
the compartment to be connected and drag holding the left mouse button down to the desired 
connection point (circle) on the flow pathway icon and release the button.  The procedure is the 
same for the source to compartment connections except the connection points are denoted by 
squares.  Note that square connection points can only be connect to other square connection 
points and likewise circle connection points to only other circle connection points.  Figure 3-28 
shows the model with the connections made. 

 

Figure 3-28 View / Dock window for 4-node model (connected) 

Figure 3-29 shows the expanded node view of the Navigator window corresponding to all the 
components modeled in Figure 3-28.  Basically, it is an expanded node view of the schematic 
representation shown in Figure 3-26.  Users should get into the habit of naming the various 
components of their models. This practice will help avoid errors, particularly as models get more 
complicated. 
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Figure 3-29 Navigator window with all nodes expanded 

3.3.3 Building a SNAP/RADTRAD Model – Input Specification 

Input specification is the next step in developing a SNAP/RADTRAD model.  The Model Editor 
design basically guides the user through the various input parameters required.  Clicking on any 
of the defined compartments presents a list of input data that needs to be specified in the 
Property window.  Also, an important feature in SNAP/RADTRAD is the ability to check the 
model using the Check Model feature which is found by navigating to Tools->Check Model. 

This illustration will start by completing the input for Compartment 2 (Containment) shown in 
Figure 3-28.  The volume of this compartment will be set to 2.5E+06 ft3.  Note that the default 
units of the Model Editor are in SI.  To switch units to British units, right-click on the black bar in 
the Navigator window, select Engineering Units->British from the drop-down menu to change 
the units.  Figure 3-30 shows the location of the black bar and the accompanying drop-down 
menu.  Once the desired units are selected, click on the Compartment 2 (Containment) icon in 
the View / Dock window or in the Navigator window to open the Compartment 2 (Containment) 
Property window.  Enter 2.5E6 in the Volume text box in the Property window.  Also check that 
the Compartment Type text box is set to Normal.  Other compartment types are discussed in 
Table 3-8.  Figure 3-31 shows the Property window with the volume set to 2.5E6.  Note that 
deposition, filter, and sprays models are not used. 
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Figure 3-30 Navigator window with the black bar menu for the engineering units 
selection 

 

Figure 3-31 Property window with volume entry for Compartment 2 (Containment) 

Input for the flow pathway involves a data entry table to capture the time dependence of the 
assumed containment leakage rate of 0.1 percent per day (%/day).  The first step is to change 
the Pathway Type text box in the Property window from Piping (default) to Air leakage (typically 
used for containments).  Next, specify a leakage rate by clicking on the Custom Editors ( ) icon 
adjacent to the Leakage Rate text box to open the Editing Leakage Rate window Figure 3-32.  A 
data entry table window will open, which is one of the most common ways to specify input 
entries in SNAP/RADTRAD. 
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Figure 3-32 Pathway input windows for sample problem 

The user can click on the Add button and add a leakage rate of 0.1 %/day for 0 to 720 h.  Two 
rows will be needed in this instance.  Users should be aware that there are several ways of 
entering the data using the Custom Editors ( ) icon and the edit table features in 
SNAP/RADTRAD.  Some users prefer to set up the number of rows needed for all the data prior 
to entering the time and leakage rate data (e.g. select the Add button twice for this entry).  While 
other users prefer to enter one row of data at a time before adding another row to the table.  
When using the second method, users should note that if a cell in an existing row is highlighted 
then the Add button will add the row before the existing row in the table.  Likewise if there is no 
cell highlighted in a row and the Add button is selected then the row will appear as the last entry 
row on the table.  The user should also note that when new row is added the row will contain 
“Unknown” in the data cells to be entered by the user.  To enter data into the newly created cell 
the user should select the cell with the mouse and enter the data.  The Tab button on the 
keyboard allows the user to move from cell to cell without selecting the cell with the mouse.  
Data initially entered into a cell will appear in red until the user selects the Enter or the Tab key 
on the keyboard to move to the next cell in the row.  Finally, the SNAP Model Editor also allows 
the user to sort data entered out of sequential order by selecting the Sort button on the bottom 
of the Editing Leakage Rate window Figure 3-32.  To delete a row, highlight the row to be 
deleted and click on the Remove button. 
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The next step is to specify the Χ/Q tables.  The Χ/Q values used for this illustration are listed in 
Table 3-4 and the approach is basically the same as that used for the data table entry for the 
flow pathway.  The first step is to click on the Expand ( ) icon next to the Χ/Q Tables node in 
the Navigator window, then click on Χ/Q Table 1 (Exclusion Area Boundary) node.  In the 
Property window for the Χ/Q Table 1 (Exclusion Area Boundary) click on the Custom Editors ( ) 
icon adjacent to the X/Q Table text box to open the Editing X/Q Table window Figure 3-33.  As 
in the case of the Editing Leakage Rate window described above, the user can enter X/Q values 
from Table 3-4 in the Editing X/Q Table window.  Using the Add and Remove buttons, the X/Q 
values for the EAB and LPZ can be completed by the user.  Figure 3-33 also shows the 
completed Editing X/Q Table windows. 

Table 3-4 Sample problem X/Q values 

Time Interval 
(h) 

Χ/Q Value by Location 
(s/m3) 

EAB LPZ 

0 – 2 1.4E-04 4.5E-05 

2 – 8  2.39E-05 

8 – 24  1.29E-05 

24 – 96  5.49E-06 

96 – 720  1.61E-06 

 

Figure 3-33 X/Q input tables for EAB (left) and LPZ (right) 

The final item to be completed is the source term specification.  The source term specification 
consists of two parts.  The first part is to specify the radionuclide inventory in the fuel or reactor 
coolant and the second is the source or release fraction scenario specific to the accident type.  
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Both combine to generate the radionuclide inventory to determine an overall source term.  
Additionally, there is also the setting for core power in the Model Options node that is used to 
determine the radionuclide inventory. 

There are two sample default core inventory libraries (PWR and BWR) from Tables 1.4.3.2-2 
and 1.4.3.2-3 of NUREG/CR-6604, which are not editable by the user. 

• PWR – normalized Methods for Estimation of Leakages and Consequences of 
Releases (MELCOR) / Accident Consequence Code System (MACCS) sample 3412 
megawatt thermal (Mwt) PWR core inventory (60 nuclides). 

• BWR – normalized MELCOR/MACCS sample 3578 Mwt BWR core inventory (60 
nuclides). 

To view and access these sample default core inventory libraries in SNAP/RADTRAD, left-click 
on Nuclide Data node in the Navigator window and locate the Total Inventories text box in the 
Property window.  Select the Custom Editors ( ) icon adjacent to the Total Inventories text box 
to open the Editing Total Inventories window Figure 3-34.  The basic editing features for the Edit 
Total Inventories window are also shown in Figure 3-34.  These features can be used to either 
edit an existing file or specify a new inventory file.  For example, the PWR inventory file can be 
duplicated by selecting the PWR inventory and then clicking on the Copy Existing File ( ) icon 
which will make a duplicate and append a number to the file that can then be renamed by the 
user.  Once a copy is made, the data becomes editable.  Nuclides can be added, deleted, and 
rearranged using the Nuclide Editing Tools shown in Figure 3-34.  In addition, nuclide files can 
be exported and imported.  The user should note that values in the Inventory (Ci) column will 
appear as “Unknown” until the plant power lever is entered as described below. 

For this illustration, the generic PWR inventory with a core power level of 3637 Mwt and the 
alternative source term release fractions from Regulatory Guide 1.183 (RG 1.183), “Alternative 
Radiological Source Terms for Evaluating Design Basis Accidents at Nuclear Power Reactors” 
[10] will be demonstrated.  The source specification steps are as follows: 

• Left-click on the Model Options node in the Navigator window, locate the Plant Power 
Level text box in the Property window and set the plant power level to 3637 as shown 
in Figure 3-35. 

• Expand the Sources [1] node and left-click on Source 1 (Fuel Release), locate Source 
Scenarios text box in the Property window and left-click on the Custom Editors ( ) 
icon.  In the Edit Inventory Scenarios window, add a new scenario by clicking on the 
New ( ) icon.  When the Select from Total Available Inventories window opens select 
PWR and click the OK button to return to the Edit Inventory Scenarios window as 
shown in Figure 3-36. 
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Figure 3-34 SNAP/RADTRAD Edit Total Inventories window editing features 

 

Figure 3-35 Setting the power plant level 
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Figure 3-36 Selecting from available SNAP/RADTRAD inventories 

• Enter the name PWR Source in the Scenario Name text box on the Edit Inventory 
Scenarios window.  Notice that the Active Scenario name changes to PWR Source.  
Under the Accident Parameters tab, pick the DBA AST option under the Accident Type 
drop-down menu and select the PWR button under Defaults Type (see Figure 3-37). 

• At this point, the user should review the data comprising the source term by clicking on 
each tab in the Edit Total Inventories window and noting the progression of the 
calculations leading to the total source term definition. 

• Clicking on the Adjusted Inventory tab will list the core inventory based on the generic 
PWR file as shown in Figure 3-38.  Note in Figure 3-38 that there are two columns.  
The column labeled Amount (Ci)/MWth lists the activity in curies (Ci)/MWth and the 
column labeled Inventory lists the total activity in Ci.  Note that the inventory is 
calculated using the values in the Amount (Ci)/MWth column and the Plant Power 
Level set previously in the Model Options node. 
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Figure 3-37 Edit Total Inventories window Accident Parameters tab 

 

Figure 3-38 Edit Total Inventories window Adjusted Inventory tab 

• Clicking on the Release Fractions and Timings tab displays the release fractions from 
Table 2 of RG 1.183 (see Section 4.3 for more details on this tab).  The Release 
Durations (hrs) are also listed and are from Table 4 of RG 1.183 as shown on Figure 
3-39. 
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Figure 3-39 Edit Total Inventories window Release Fractions and Timings tab 

• Finally, clicking on the Source Term tab shows the calculated source term associated 
with the particular nuclide as shown in Figure 3-40.  Further discussion of source term 
modeling in SNAP/RADTRAD is presented in Sections 3.4.2. 

 

Figure 3-40 Edit Total Inventories window Source Term tab 

The final step for the source term specification is to set the source term fraction and the iodine 
chemical forms to the RG 1.183 (NUREG-1465) values.  The user sets the source term fraction 
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by entering the value of 1 in the Source Term Fraction text box of the Property window for 
Source 1 (Fuel Release) as shown in Figure 3-41.  The iodine chemical form is set by using the 
drop-down menu associated with the Iodine Physical Form text box in the Property window for 
Source 1 (Fuel Release) as shown in Figure 3-41.  The aerosol, elemental and organic iodine 
fractions are listed but are not editable (grayed-out). 

 

Figure 3-41 Property window for source term iodine chemical form settings 

The user can now run a model check by navigating to Tools->Check Model and looking for the 
notes in the Message window in the lower part of the Model Editor indicating that no errors were 
found as shown in Figure 3-42.  There are three icons to the right of the message window used 
to copy or delete messages. 

 

Figure 3-42 Model Editor Message window with icons 

If an error is detected, an Error Report window appears listing the errors and warning messages 
as shown in the example Error Report window shown in Figure 3-43.  The error messages, 
which are generally self-explanatory, provide a guide of what needs to be fixed.  Note that there 
are other classifications of messages (Notes, Alerts, Warnings, and Errors).  Generally, SNAP 
displays messages in these different classifications automatically.  The goal for model 
development is to have no errors or warnings generated by the SNAP Model Editor.  Users 
should note that models may execute with warnings detected by the Model Editor, but they will 
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not execute with errors.  Once error checking is complete and no errors or warnings exist in the 
model, the user can run the case as described in Section 3.2.2 (Tools->Submit Job). 

  

Figure 3-43 Example of a SNAP model editor Error Report window 

3.3.4 Building a SNAP/RADTRAD Model – Additional Features 

There are a number of features and icons in the View / Dock window, as shown in Figure 3-44, 
that the SNAP/RADTRAD user should become familiar with for general model building.  These 
features include the Cut ( ), Copy ( ) and Paste ( ) icons which are used by selecting the 
icon (Compartment, Pathway, etc.) in the View / Dock window to be cut or copied, then clicking 
on the Cut ( ) or Copy ( ) icon and pasting it in the View / Dock window. 

 

Figure 3-44 View / Dock window tool bar icons 

The Paste Special ( ) icon allows the user to paste multiple copies or to control component 
renumbering.  The features of the Paste Special ( ) icon are shown in Figure 3-45.  The utility 
of this tool is to maintain unique component numbers in the copy and paste process.  To 
duplicate a component using the Copy ( ) icon and Paste Special ( ) icon, confirm the 
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Selection Tool ( ) icon is activated (Figure 3-44) and then click on the component to be 
duplicated.  Click on Paste Special ( ) icon and confirm that the numbering offset is selected, a 
value of 1 for the offset is fine.  Then click on the OK button and the component will be 
duplicated. 

 

Figure 3-45 Features of the Paste Special window 

The Selection Tool ( ) icon, as the name implies, allow the selection of icons for copying.  This 
tool needs to be activated as shown in Figure 3-44 to allow components to be selected or 
moved.  A component is moved by clicking on the component and holding the left mouse button 
down while dragging the component to the desired location.  The Find Component ( ) icon is 
used to find a component and it is usually used for large models with tens or hundreds of 
components and is typically not needed for SNAP/RADTRAD models. 

Another very useful feature of SNAP/RADTRAD is the ability to group components (rubber band 
selection) and move them as a unit.  The Group ( ) and Ungroup ( ) icons appear inactive 
(grayed out) until a group of components are defined.  To define a component group, click the 
mouse button in an empty area of the View / Dock window, then drag the cursor around the 
group of components to be grouped (rubber banded) together.  The Group ( ) icon, shown in 
Figure 3-44, will now become active.  Click the Group ( ) icon to group the components 
together and note that the Ungroup ( ) icon the View / Dock window tool bar will become 
active.  Clicking on the Ungroup ( ) icon ungroups the components in the previously defined 
group. 

The Zoom ( ) icon is used to zoom in on sections of a model.  Clicking on the Zoom ( ) icon 
and then clicking on the background of the View / Dock window will magnify the components.  
Additionally, some useful zoom and sizing features are available when the Selection Tool ( ) 
icon is activated by right-clicking on the View / Dock window background and clicking on Zoom 
in the drop-down menu.  Alternately these features are available while the Zoom ( ) icon is 
active by right-clicking on the View / Dock window background.  Both methods open the Zoom 
and Size window shown in Figure 3-46 
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Figure 3-46 Zoom and size features 

When the Zoom tab is activated, the zoom level can be set to any desired value by either using 
the slider or entering a number in the percent value in the text box.  Note that clicking on the red 
arrow ( ) displays a drop-down list of preset values from which the user may make a suitable 
selection.  When the Canvas Size tab is active, the width and height of the canvas can be set.  
The canvas is the portion of the View / Dock window surrounded by a thin border on two sides 
(bottom and right sides) and the scaling ruler on the remaining two sides of a model as 
illustrated in Figure 3-47.  All component icons are rendered on the canvas and for larger 
models, sometimes the canvas borders cannot be seen.  The Zoom ( ) icon can be used to 
shrink the model and bring the borders into view.  Also, if the canvas is larger than the model, 
clicking on the Trim Excess button will shrink the canvas area to fit the model. 

In some SNAP models, the scale of icons is of interest to get a sense of perspective particularly 
for models where plant components are represented.  Generally, SNAP/RADTRAD models are 
represented in a manner similar to a block diagram; however, a plant representation can be 
drawn using the Component Insertion ( ) icon on Figure 3-44. 

SNAP/RADTRAD provides the feature of scaling meshes with some of the drawing features 
available using the Component Insertion ( ) icon.  The Component Insertion ( ) icon allows the 
insertion of various components and basic drawing shapes into a model representation.  Figure 
3-48 displays the Component Insertion ( ) icon menus illustrating the available features.  These 
menus are accessed by clicking on the drop-down arrow. 

The features that would be most used in developing a SNAP/RADTRAD model would be the 
Compartments, Sources and Pathways Insertions.  These three features make it easy to build a 
model by navigating the menus to the component of interest, clicking on that component, then 
moving the cursor to the View / Dock window and clicking again.  This approach provides an 
alternative and is quicker than the approach involving right-clicking on the desired nodes in the 
Navigator window described earlier. 
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Figure 3-47 View / Dock window model canvas 

  

 

Figure 3-48 Component Insertion icon feature menus 

The other feature that is useful is the ability to annotate a model using the Annotation feature.  
This Annotation feature allows the user to draw basic shapes and to add descriptive text.  The 
basic approach is to navigate to the annotation feature of interest, select that feature and then 
click on the View / Dock window which will draw the selected icon. 

As an example, to draw an ellipse, navigate to Annotation->Ellipse, click on Ellipse in the menu, 
then move the cursor to the View / Dock window and click in that window to draw the selected 



 

3-49 

shape.  Right-clicking on the shape activates a menu that allows various drawing rendering 
features to be set.  These features are typical of Windows-based drawing programs and are not 
discussed in detail. 

The drawing features combined with scaling may be of interest to some users with an artistic 
tendency.  When a new model is initiated, default values are set for the dimensions of the 
canvas which are a height of 850 pixels and a width of 1100 pixels.  These values can be 
checked in the Canvas Size tab in the Zoom and Size window.  Additionally, the user can enter 
custom values for the height and width by typing them and selecting the Enter key on the 
keyboard.  The default scaling is 20 pixels per meter with a width scale factor of 1.0 which can 
be checked by clicking on the Scaling tab in the Zoom and Size window which is shown in 
Figure 3-46.  Dividing the pixel values by the scaling factor yields a height of 42.5 meters and a 
width of 55 meters.  Note that the ruler at the edge of the canvas shows these dimensions.  
Actually, units are immaterial in this context as the dimensions can be expressed in yards, feet 
or any other units.  The scaling factor is actually the number of pixels per some unit of length. 

Once a suitable scaling is set, scaled drawings representing plant components can be made 
using the annotation features discussed above.  A sample is shown in Figure 3-49 in which a 
cylinder is scaled to be 100 feet in diameter and 100 feet high. 

 

Figure 3-49 Cylinder drawn using the Annotation features of SNAP 

It is noted that, in general, the icons used to represent various components in a 
SNAP/RADTRAD model are adequate for model presentation.  These features are illustrated for 
those users who may want to explore and use these features for additional model annotation. 
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3.4 SNAP/RADTRAD Input Summary 

Up to this point, the user has seen the various approaches to specifying input in 
SNAP/RADTRAD.  The first step is to define a component (compartment, flow pathway, dose 
location, etc. using the right-click and left-click sequences shown earlier) and then specifying the 
actual input parameters using drop-down menus, text boxes, and input tables.  However, up to 
this point, many of the available input parameters have not been discussed. 

Tables 3-5 through 3-15 present a summary of all of the inputs that can be specified in a 
SNAP/RADTRAD model.  The organization of the tables follows the group node organization in 
the Navigator window.  Summary explanations of the input requirements are provided.  In 
addition, screenshots are provided to help orient the user and to provide context with the input.  
Comments are also provided to aid the user in specifying input. 

SNAP/RADTRAD input is largely self-explanatory given that the user has some dose analysis 
background.  However, the user should be aware of the relationships among some of the group 
nodes from an input specification perspective.  These relationships are as follows: 

• general model options (Table 3-5); 

• nuclide data and sources for specifying source terms (Tables 3-6 and 3-7); 

• compartments, pathways, natural deposition, filters and sprays (Tables 3-8 through 3-
12); 

• dose locations (including breathing rates), and Χ/Q tables (Tables 3-13 and 3-14); and 

• remaining inputs (Table 3-15). 

The relationships will become obvious as the user works with the SNAP Model Editor.  
Sometimes the relationship is “one way.”  As an example, the user can tell which Χ/Q table is 
linked to a particular dose location by clicking on one of the Dose Location nodes.  However, if 
the user clicks on a particular Χ/Q Table node, the associated dose location is not readily 
identified.  Hence, it is important to name the various model components to keep track of 
associations. 

3.4.1 Model Options 

Model options are applied to the overall problem and the use of the default values should be 
acceptable for most problems, but should be checked by the user.  Table 3-5 lists the available 
inputs for the Model Options node in SNAP/RADTRAD (Figure 3-50).  Some general comments 
on model options are listed below: 

• Plant Power Level needs to be specified as it is used to determine the overall inventory 
in the source term calculation. 

• Either Decay or Decay with daughter production should be used for most problems. 

• The Onset of Gap Release and the Start of Accident.  Note that the values of the 
Onset of Gap Release and the Start of the Accident should remain at 0.0.  If values 
greater than 0.0 are used, the problem time is advanced by the specified time value.  
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Therefore, specifying a value greater than 0.0 causes the lookup values for time-
dependent data such as Χ/Q to be later than it should be.  This issue will be addressed 
in future versions of the RADTRAD-AC.  An Adaptive Time Step algorithm and a 
Default with Error Calculation options have been added to SNAP/RADTRAD. 

• Options are provided to reduce the volume of output in the Output Parameters and 
NRC Output Flags Property window if the user desires to reduce the volume of output 
data. 

 

Figure 3-50 Property window for the Model Options node 
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Table 3-5 Summary of SNAP/RADTRAD inputs – General Model Options 

Input Description 

Model Options – General 

Title 
Problem title (optional), specified by user.  Typically, it is a good idea to 
name the problem particularly since multiple models can be accessed 
in a single SNAP Model Editor session. 

Description Problem description (optional), specified by user.  It is a good idea to 
provide a short problem description for the record. 

Plant Power Level Core power level in MW(th) (required). 

Decay 

Select one of the following options: 

• Decay and daughtering (default) 
• No decay or daughtering 
• Decay, no daughtering 

Onset of Gap Release 
Specify the time that the gap release from the fuel starts in hours 
(required).  The default is 0.0 hours which is recommended for most 
SNAP/RADTRAD models. 

Start of Accident 

Specify the time that the accident starts in hours (required).  This 
parameter is only significant if radionuclide decay is being calculated.  
The default is 0.0 hours which is recommended for most 
SNAP/RADTRAD models. 

Accident Duration Specify the time the accident ends in hours (required).  The default is 
720 hours which is recommended for most SNAP/RADTRAD models. 

Dose Conversion Type 

Select one of the following options for DCFs: 

• User defined 
• FGR 11 & 12 (default) 

Generally, the default FGR 11&12 DCFs should be used. 

Dose Conversions Values for FGR 11 & 12 can be displayed.  If user-defined is selected, 
then user can input DCFs. 

Time Step Algorithm 

Two algorithms are available for controlling the time step: 

• Adaptive 
• Default 
• Default with Error Calculation 

The Default time step algorithm is the original RADTRAD (version 3.10) 
algorithm implemented with the matrix exponential method [11] (see 
Section 4.1).  The Adaptive and the Default with Error Calculation time 
step algorithms were introduced with the RADTRAD-AC (version 4.5.0) 
and are discussed in Section 4.2. 

  



 

3-53 

Table 3-5 Summary of SNAP/RADTRAD inputs – General Model Options (cont.) 

Input Description 

Time Step Table 

Specified by user.  This option allows the user to specify time steps for 
finer time step resolution for the default time step algorithm and also 
used to control the generation of output.  If this option is not used, 
SNAP/RADTRAD generates time-dependent output at each time point 
where there is a change in the time-dependent input data such as Χ/Q, 
filtration efficiency, etc.  The appropriate time step size is dependent on 
how quickly radioactivity is added or removed from the system being 
modelled.  If the default time step algorithm is used the user should 
manually adjust the time step size to make sure the results are 
independent of the time step size.  Finally, the user should note that 
entering values in this table will override the Adaptive time step 
algorithm if the minimum and maximum time step size are equal (see 
Section 4.2). 

Use Full Time Step 
(if Time Step Algorithm is 

Adaptive) 

When Adaptive time stepping is enabled, a full step solution is 
compared to a two half step solution to determine the error.  The two 
half step solution is generally more accurate and is used by default.  If 
Use Full Time Step is set to True, then the full step solution is used.  
Note that this option is valid if Adaptive time stepping is used or if 
Default with Error Calculation is turned on and the default value is set 
to True. 

Plot All Points 

When the Adaptive time stepping or Default with Error Calculation 
options are enabled, time steps will be repeated in order to calculate 
error.  By default, repeated time steps are not plotted.  If Plot All Points 
is enabled, set to True, then these points are written to the plot file.  
The default value is set to False. 

Max Error 
(if Time Step Algorithm is 

Adaptive) 

When Adaptive time stepping is enabled, this option indicates the error 
threshold used for Adaptive time stepping to determine when time step 
needs to be cut.  This value is the fractional error and the default value 
is set to 1E-03. 

Model Options – Output Parameters 

The following output parameter flags only affect the casename.out output file. 

Dose/Activity Output Units 
This flag option determines whether the RADTRAD output text files are 
generated in Curies and Rem based units [traditional RADTRAD units] 
or SI units (MBq, mSv).  The default units are Curies and Rem. 

Echo Model Definition 
The flag options are either True or False and specified by the user.  If 
set to False, the edited summary of the input is suppressed.  The 
default value is set to True. 

Show Event 
This option determines whether the code should write output at each 
time interval.  The flag options are either True or False and specified by 
the user.  The default value is set to True. 
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Table 3-5 Summary of SNAP/RADTRAD inputs – General Model Options (cont.) 

Input Description 

Show Step 

This option displays each time interval given by the time step control 
input on the output.  The flag options are either True or False and 
specified by the user.  The user should set this flag to True to get the 
output for all time steps.  The default value is set to True. 

Show Model 
This displays the model output at each time interval in the output.  The 
flag options are either True or False and specified by the user.  The 
default value is set to True. 

Model Options – NRC Output Flags 

The available flags that control the generation of output to the NRC-formatted output file.  
Note that the bulk of the output is generated for the Delta Dose and Cumulative Dose 
results. 

Input Echo 
This option defines whether the input model will be echoed to the NRC 
output file.  The flag options are either True or False and the default 
value is set to True. 

General Input Parameters 

This option defines whether general input parameters are written to the 
NRC output file.  These parameters include the number of 
compartments, pathways, dose locations, and nuclides.  The problem 
start and end time are also included in the parameters under this 
option.  The flag options are either True or False and the default value 
is set to True. 

Source Term Parameters 

This option defines whether the source term parameters, as specified 
in the inputs, are written to the NRC output file.  These parameters 
include the plant power level, inventory power, the consideration for 
radioactive decay and daughter production, start time of the release, 
and the delay time for the release if applicable.  The iodine chemical 
fractions, nuclide group release fractions and timings, and nuclide 
inventory file are also included in the parameters under this option.  
The flag options are either True or False and the default value is set to 
True. 

Dose Conversion Factor 
Data 

This option defines whether the DCFs, as specified in the inputs, are 
written to the NRC output file.  These include the nuclide DCFs and 
decay constants.  The flag options are either True or False and the 
default value is set to True. 

Compartment Data 

This option defines whether compartment data parameters, as 
specified in the inputs, are written to the NRC output file.  These 
parameters include the number of compartments and the specific data 
for each compartment such as the number, name, volume, type, dose 
location, radionuclide removal features (sprays, recirculation filters, and 
natural deposition), source input and output from the compartment, and 
flow path connections.  The flag options are either True or False and 
the default value is set to True. 
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Table 3-5 Summary of SNAP/RADTRAD inputs – General Model Options (cont.) 

Input Description 

Flow Path Data 

This option defines whether flow pathway data parameters, as 
specified in the inputs, are written to the NRC output file.  These 
parameters include the number of pathways and the specific data for 
each pathway such as the number, name, to compartment, from 
compartment, nuclide transfer mechanism, and output mode.  The flag 
options are either True or False and the default value is set to True. 

Dose Location Data 

This option defines whether dose location data parameters, as 
specified in the inputs, are written to the NRC output file.  These 
parameters include the number of dose locations and the specific data 
for each dose location such as the name (EAB, LPZ, and control 
room), Χ/Q data, breathing rate data, and occupancy factor data.  The 
flag options are either True or False and the default value is set to 
True. 

Activity Distribution Results 

This option defines whether activity distribution results at the end of 
each time step are written to the NRC output file.  These results include 
the radionuclide, the group number, and the activity (Ci) in each 
compartment of the model at the end of the time step.  The flag options 
are either True or False and the default value is set to True. 

Delta Dose Results 

This option defines whether delta dose results at the end of each time 
step are written to the NRC output file.  These results include the 
change in doses (inhalation, cloudshine, skin, thyroid, and TEDE) for 
each radionuclide at the dose locations (EAB, LPZ, and control room) 
from the previous time step to end of the next time step.  The flag 
options are either True or False and the default value is set to True. 

Cumulative Dose Results 

This option defines whether cumulative dose results at the end of each 
time step are written to the NRC output file.  These results include the 
integrated doses (inhalation, cloudshine, skin, thyroid, and TEDE) for 
each radionuclide and dose location at the end of the time step.  The 
flag options are either True or False and the default value is set to 
True. 

I-131 Activity Summary 

This option defines whether an I-131 activity summary table is written 
to the NRC output file.  The results are a table of the I-131 activity (Ci) 
in each compartment at the end of each time step.  The flag options 
are either True or False and the default value is set to True. 

Cumulative Dose Summary 

This option defines whether the cumulative dose summary table is 
written to the NRC output file.  The results are a table of the cumulative 
thyroid, skin, TEDE and whole body doses at each dose location (EAB, 
LPZ, and control room) at the end of each time step.  The flag options 
are either True or False and the default value is set to True. 
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Table 3-5 Summary of SNAP/RADTRAD inputs – General Model Options (cont.) 

Input Description 

Lines Per Page 
This option specifies the maximum number of lines per page in the 
NRC output before inserting a page break.  The user can adjust this 
value with the default value set at 55 lines per page. 

Cut-off Value 

This option specifies the cut-off value for table data.  The nuclide 
summary tables written at each time step will use this value to 
determine which nuclides are written: at least one column for the 
nuclide must have a value greater than the cut-off, or it will not be 
written for that time step.  The default value is set at 1.0E-04. 

Model Options – Diagnostic Flags 

Level – xxx 

These flags are used for generating additional output for code 
debugging using write statements contained in the code subroutines.  
Increasing the flag value from zero to five will increase the information 
provided.  Higher values indicate a greater amount of output, with a 
value of zero disabling the diagnostic.  The default values for these 
Diagnostic Flags are set to zero.  These flags are not generally used 
for SNAP/RADTRAD analyses.  Some additional information regarding 
these flags can be found in Section 4.2.3 of NUREG/CR-6604. 

3.4.1.1 Dose Conversion Factors 

The DCFs are also managed under the Model Options node and relate concentration and dose 
to organs by nuclide.  There are two modes of DCF management, FGR 11&12 (default) and 
User Defined DCFs.  The user can select the either of these two options by selecting the drop-
down menu button next to the Dose Conversion Type text box as shown in Figure 3-51. 
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Figure 3-51 Setting dose conversion factors in the Model Option Property window 

When set to FGR 11&12 (default) option, the RADTRAD plugin automatically matches the 
nuclides in active scenario inventories (see Section 3.3.3) against an extensive database of 
DCF values taken from the reference data in FGR 11 and FGR 12.  Additionally the user can 
view these DCFs by selecting the View ( ) icon next to the Dose Conversion text box to open 
the Viewing “FGR11&12” Dose Conversion Defaults window as shown in Figure 3-52.  The user 
should note that icons on the tool bar in Figure 3-52 are “greyed” out indicating that these icons 
are not active with this option and that the user cannot change the FGR 11 and FGR 12 DCF 
values.  Additionally, the user should note that the RADTRAD plugin flags an error when the 
source inventory contains nuclides that are not in the DCF file (nuclides in the DCF file that are 
not in a source inventory are not listed as an error).  When exporting models, the RADTRAD 
plugin will only write the DCFs for nuclides found in the active source scenario inventory (in the 
order defined in the inventory).  This helps to preserve the RADTRAD requirement of equivalent 
nuclides in the DCFs and the source inventory. 
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Figure 3-52 Viewing “FGR11&12” Dose Conversion Defaults window 

When the user selects the User Defined option, the icon next to the Dose Conversion text box 
changes from the View ( ) icon to the Custom Editors ( ) icon.  The user can select the 
Custom Editors ( ) icon to open the User-Defined Dose Conversion Factors window as shown 
in Figure 3-53. 

 

Figure 3-53 User-Defined Dose Conversion Factors window 

As noted in Figure 3-53, the icons on the tool bar are active with this option indicating that these 
icons can be used to change the DCF values.  The names and functions of these icons on the 
tool bar are the same as those in Figure 3-34, with the exception of the Import ( ) icon.  The 
Import ( ) icon on Figure 3-53 provides a drop-down menu option in which the user can select 
either the FGR11&12 or Import from file option.  The Import from file option will open a typical 
Windows file navigator window to allow the user to search for a specific file (the default file type 
option is “*.dfx” and “*.inp”).  As shown in Figure 3-53 the DCFs are listed in a table format with 
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one nuclide per row.  Additionally, nuclides that are not present in a source inventory are 
highlighted with a blue background and nuclides listed in a source inventory that are not 
represented in the DCFs are displayed with DCF values listed as <unset>.  For additional 
information on DCFs usage in the dose analysis see Section 4.6. 

3.4.1.2 Adaptive Time Step 

Generally, the Default time step algorithm is adequate for most RADTRAD calculations.  If the 
user wants to determine if there are time step sensitivities then two options are available: 

1. Default with Error Calculation, and 
2. Adaptive time step. 

Error in the dose calculation can be determined by selecting the Default with Error Calculation 
option.  The results can be view using the AptPlot program.  Search for error or error.scaled to 
see the error results.  To use the adaptive time step algorithm, select Adaptive in the Time Step 
option from the drop-down menu. 

The Adaptive time step algorithm is new in SNAP/RADTRAD and it is considered to be 
experimental.  Use of this algorithm adds a significant amount of running time to the problem.  It 
is suggested that the user set up the problem using the Default time step algorithm option and 
check for any time step sensitivities using the Default with Error Calculation or Adaptive time 
step algorithm option.  For additional information on the Adaptive time step algorithm see 
Section 4.2. 

3.4.2 Nuclear Data and Source Scenarios 

The source term specification was introduced in Section 3.3.3.  However, a new feature that has 
been added to SNAP/RADTRAD is the ability to consider the reactor coolant system (RCS) 
activity for either a PWR or BWR.  The user can access the RCS Activity Calculator window, 
Figure 3-54, by clicking on the Nuclide Data node in the Navigator window, and then selecting 
the Custom Editors ( ) icon for Total Inventories text box in the Property window to open the 
Edit Total Inventories window.  Then select the Open RCS Activity Calculator ( ) icon on the 
Edit Total Inventories window as shown in Figure 3-34.  The user has the option to enter RCS 
activity or to allow SNAP/RADTRAD to calculate the RCS activity.  Formulations for the 
calculation of RCS activity are presented in Section 4.4.  Figure 3-54 displays the RCS Activity 
Calculator window where the user can select from either BWR or PWR. 

The user will note that the RCS Activity Calculator window in Figure 3-54 is an input 
specification window where parameters need to be specified to determine the RCS activity.  
There are two options available to calculate RCS activity. 

1. The user can input the RCS specific activity (µCi/g) in the Activity column (Figure 3-54) 
and then add the effect of iodine spiking by checking either the Use pre-incident spike or 
the Use co-incident spike box.  If the user checks the Use co-incident spike box, then the 
Calculate Appearance button on Figure 3-54 will become active.  Note that the co-
incident spike model is not available for BWRs. 

2. The user can also have SNAP/RADTRAD calculate the equilibrium Technical 
Specification (T/S) Limit RCS activity (without spiking) and add the effect of a pre-
incident or co-incident spike to the total RCS activity. 
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In Figure 3-54, the user will note the Activity column is editable so that the user can input the 
known radionuclide specific activity, the RCS mass in kilograms and the RCS inventory will be 
calculated.  Generally, the radionuclide specific activities based upon one percent fuel defects 
are presented in Chapter 11 of the Final Safety Evaluation Report for a given plant.  Once the 
radionuclide specific activity is entered, the user has the option to calculate the iodine and 
xenon equilibrium activities from the specified equilibrium activity for the dose equivalent iodine 
131 (DE I-131) or the dose equivalent xenon 133 (DE Xe-133) from the facility’s technical 
specification (T/S) equilibrium specific activity.  These calculations are done by checking or 
unchecking the appropriate boxes on the RCS Activity Calculator window.  Note that the 
calculations are completed using the user-specified radionuclide specific activity (µCi/g). 

Additionally, after selecting either the BWR or the PWR option on Figure 3-54, when the user 
selects the Calculate Activity button on Figure 3-54 either Figure 3-55 or 3-56 will open 
respectively.  In either instance, the user inputs the required data and clicks the OK button to 
complete the calculation.  Note that for the BWR, the user can apply the calculation to either 
steam or liquid (Calculate activity in steam or liquid?) by clicking on the radio button for either 
the Steam activity or Liquid activity option shown in Figure 3-56. 

 

Figure 3-54 RCS Activity Calculator window 
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Figure 3-55 RCS Activity Inputs – PWR window 

 

Figure 3-56 RCS Activity Inputs – BWR window 

To apply pre-incident or co-incident spiking to either user-supplied or code-calculated RCS 
radionuclide specific activities, the appropriate box is checked on the RCS Activity Calculator 
window (Figure 3-54) and the required input supplied.  For the pre-incident spike, which is 
applicable to either PWRs or BWRs, the user checks the Use pre-incident spike box and 
supplies the T/S spike activity. 

To use the co-incident spike, which is applicable only to PWRs, the user can select either user 
defined values by inputting the iodine appearance rate data into table in the Iodine Appearance 
Rate section of Figure 3-54 or choose to have the code calculate the iodine appearance rate by 
selecting the Calculate Appearance button.  Note that the iodine appearance rate Ci/hr column 
is editable so that the user can enter appropriate values of the iodine appearance rate. 

When the user clicks the Calculate Appearance button the Calculate Iodine Appearance window 
as shown in Figure 3-57 will open.  The user will provide the required inputs and click the OK 
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button which will update the iodine appearance rate values in the table in the Iodine Appearance 
Rate section of Figure 3-54. 

 

Figure 3-57 Calculate Iodine Activity window 

Once the RCS activity calculations are complete, the user clicks on the OK button on the RCS 
Activity Calculator window (Figure 3-54) and the total RCS activity is automatically transferred 
from the RCS activity calculator to the Inventory (Ci) column in the Edit Total Inventories window 
(Figure 3-34) and the specific inventory amount is back-calculated from the core power.  Note 
that a new file is created each time the RCS activity calculator is invoked.  These files are 
automatically named, but the user can rename them using the Name text box in the Edit Total 
Inventories window (Figure 3-34).  Finally the models used to compute the RCS activity are 
discussed in Section 4.4 and an example showing the detailed use of the RCS Activity 
Calculator, in a SNAP/RADTRAD model, is demonstrated in the draft SNAP/RADTRAD 
Workbook (available at the RAMP website (https://www.usnrc-ramp.com). 

Regardless of whether fuel or RCS activity is used, it is the total inventory that is the basis for 
the source term calculation accessed from the Source Scenarios text box, in the Property 
window, once a new source model is initiated.  Recall from earlier discussions that part of the 
specification of a new source scenario is the appropriate nuclide inventory either from the 
reactor fuel, RCS or other source.  Once that step is completed, an appropriate release model is 
specified from the available pre-defined release models listed under the Accident Parameters 
tab on the Edit Inventory Scenario window as shown in Figure 3-58.  Alternately, the user has 
the option of setting release fractions and a release time under the Release Fractions and 
Timings tab.  For releases of radionuclides from the reactor coolant, the release rate is usually 
controlled using the flow pathway leak or flow rate from the compartment where the reactor 
coolant is released.  Accordingly, using a user-specified release fraction of 1.0 for noble gases, 
halogens, and alkali metals and a release duration of 1.0E-04 hours for the gap release as a 
surrogate should suffice.  Note that the initial inventory prior to the application of release 
fractions appears under the Adjusted Inventory tab while the Source Term tab lists the actual 
releases to be used in the model after multiplication by the release fractions. 

• For the Use Total Inventory option, user-defined release data are entered under the 
Release Fractions and Timings tab. 



 

3-63 

• For DBA-TID and DBA-AST options, the release fractions are listed under the Release 
Fractions and Timings tab.  The basis for the values for these options is presented in 
Section 4.3. 

• For the Gap Release, rod ejection accidents-control rod drop accidents (REA-CRDA), 
and fuel handling accidents (FHA) options, the default release fractions are set under 
the Accident Parameters tab as each accident is selected.  The release fractions for 
the relevant nuclide groups are set to 1 under the Release Fractions and Timings tab. 

Tables 3-6 and 3-7 list the available inputs for the Nuclear Data and Source nodes in 
SNAP/RADTRAD. 

  

Figure 3-58 Available pre-defined SNAP/RADTRAD release models 
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Table 3-6 Summary of SNAP/RADTRAD inputs – Nuclear Data 

Input Description 

Nuclide Model 

Select one of the following options: 

• ICRP-38 definitions (default) 
• User Defined 

It is recommended that the ICRP-38 data be used. 

Note that if the User-Defined option is selected and new nuclide 
definitions are specified and then the user switches to the ICRP-38 
option, the new nuclide definitions are deleted.  References in the Total 
Inventories or the Sources to those nuclide definitions will be set to 
“<not defined>.” 

Nuclides 

Specified by user when the User Defined option is chosen in the 
Nuclide Model input.  Note that the nuclide definitions can be reviewed 
by selecting Custom Editors ( ) icon.  This will open the Nuclide 
Definitions window, which contains the nuclide name, atomic mass, 
and half-life on the left-hand side.  When a user clicks on a nuclide on 
the left-hand side the daughter nuclides and its associated branching 
ratios will be displayed on the right-hand side of the window. 

Total Inventories 

Used to develop radionuclide inventories in the fuel or in the RCS.  
This input works in conjunction with the Sources node to develop a 
source term.  The two sample default core inventories for a PWR and 
BWR from RADTRAD 3.03 are included in the SNAP Model Editor.  
Core inventories can also be specified by the user.  Section 3.3.3 and 
Figures 3-34 through 3-40 provide more detailed instructions on how to 
use these inputs. 

Table 3-7 Summary of SNAP/RADTRAD inputs – Sources 

Input Description 

Name Specified by user for the source (optional). 

Component Number 
Multiple sources can be used in a model and the SNAP/RADTRAD 
Model Editor assigns the number.  These numbers must begin with 
number 1 and increase sequentially for each additional source.  

Description Specified by user (optional). 

Source Scenarios 

Various source (release) scenarios are available to the users which are 
linked to the Nuclide Data definition.  Source scenarios include LOCA 
DBAs and non-LOCA DBAs such as FHA, CRDA or REA, and Gap 
releases.  Additionally, scenarios involving RCS activity, such as steam 
generator tube ruptures and main steam line breaks can also be 
defined.  Section 3.4.2 and Figures 3-54 through 3-58 provide more 
detailed instructions on how to use this input to model these scenarios. 
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Table 3-7 Summary of SNAP/RADTRAD inputs – Sources (cont.) 

Input Description 

Source Term Fractions 
User defined value which is the fraction of the inventory being released 
by the source.  Multiple sources referencing the same inventory can 
divide the source term between them through this value. 

Iodine Physical Form 

Specified the fraction of iodine that is in elemental, organic or 
particulate chemical form.  Predefined fractions are listed below and 
are user-selectable from the drop-down menu. 

• TID-14844 – 0.05 aerosol (particulate), 0.91 (elemental), and 
0.04 (organic) 

• NUREG–1465 – 0.95 aerosol (particulate), 0.0485 
(elemental), and 1.5E-03 (organic). 

• User Defined 

Note that if one of the predefined fraction options is selected, the 
above fractions appear in the Aerosol Fraction, Elemental Fraction or 
Organic Fraction text boxes.  These fields are greyed-out and are not 
editable.  Selecting the user-defined option from the iodine physical 
form drop-down menu allows the user to specify the aerosol, 
elemental, and organic fractions. 

Compartments Links the release scenario to a given compartment.  Works in 
conjunction with the compartment specification. 

3.4.3 Compartments, Pathways, Natural Deposition, Filters and Sprays 

Section 3.3.2 presented the approach for defining compartments and pathways and connecting 
these two components.  Once an initial model is developed, completing the model is a matter of 
input specification.  Input specification is done by left clicking on the Expand ( ) icon (if it is not 
already expanded) of the associated component (Compartments, Pathways, Natural Deposition, 
Filters and Sprays) in the Navigator window, and completing the input specification fields of the 
Property window for that component.  The input specification fields for the components in the 
Property window consist of input text boxes, drop-down menus or input tables that are accessed 
by the Custom Editors ( ) icon.  Tables 3-8 through 3-12 list the available inputs for the 
Compartments, Pathways, Natural Deposition, Filters and Sprays in SNAP/RADTRAD. 

Table 3-8 Summary of SNAP/RADTRAD inputs – Compartments 

Input Description 

Name Specified by user (optional). 

Component Number 

Multiple compartments can be used in a model and the 
SNAP/RADTRAD Model Editor assigns the number.  These numbers 
must begin with number 1 and increase sequentially for each additional 
component. 
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Table 3-8 Summary of SNAP/RADTRAD inputs – Compartments (cont.) 

Input Description 

Description Specified by user (optional). 

Type 

The user can select from the following options: 

• Control Room Dose – This option is used for a control room 
compartment which enables a dose location to be associated 
with the compartment. 

• Environment – This option couples radionuclide release points 
and dose locations through the specification of Χ/Q. 

• Normal – A general compartment type that can be 
interconnected to other compartments.  Removal by sprays, 
natural deposition and filtration can be modeled in these 
compartments. 

• Normal Dose – This option is similar to the Normal 
compartment except that a dose location can be specified 
within the compartment. 

Note that an Environment compartment is defined by default in 
SNAP/RADTRAD.  Additional compartments are specified by the user. 

Output Level Detail 

Sets the detail level used to output compartment data (nuclide activity 
and decontamination for the compartment) during model execution.  
The user can select from the following options: 

• No additional detail (default) 
• Full edit at time steps 
• Full edit at end of problem only. 

When set to Full edit at time steps, the editing of nuclide activity and 
decontamination for the compartment are printed to the output.  These 
details may be printed at every time step or only once, at the end of the 
problem. 

Volume 

Specified by user (ft3 or m3 depending on user-specified units 
selection).  Units switching is done by right-clicking on the black bar of 
the Navigator window and selecting Engineering Units and British or SI 
units.  

Deposition 
Works in conjunction with the Natural Deposition node summarized in 
Table 3-10.  Used in Normal and Normal Dose compartments as 
appropriate. 

Filter 
Works in conjunction with the Filter node summarized in Table 3-11.  
Used in Normal, Normal Dose and Control Room Dose compartments 
as appropriate. 

Spray Works in conjunction with the Spray node summarized in Table 3-12.  
Used in Normal and Normal Dose compartments as appropriate. 
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Table 3-9 Summary of SNAP/RADTRAD inputs – Pathways 

Input Description 

Name Specified by user (optional). 

Component Number 
Multiple pathways can be used in a model and the SNAP/RADTRAD 
Model Editor assigns the number.  These numbers must begin with 
number 1 and increase sequentially for each additional component. 

Description Specified by user (optional). 

From Compartment Lists the upstream compartment in this pathway. 

To Compartment Lists the downstream compartment in this pathway. 

Pathway Type 

The method by which radionuclides are transported and deposited 
through the pathway.  The user can select from the following options: 

• Piping (default) – transport in volumetric flow with a 
decontamination factor. 

• Filtered pathway – transport in volumetric flow through filters 
with a specified efficiency. 

• Generic – transport in volumetric flow with a decontamination 
factor (replaces legacy suppression pool mechanism).  Allows 
for the user to independently specify the decontamination 
factors for aerosols (particulate), elemental iodine, organic 
iodine, and noble gases. 

• Air leakage – transport in volumetric percent (%/day).  This is 
the typical path used for containment leakage. 

• Generic w/non-Iodine aerosols – transport is the same as the 
Generic option above without Iodine particulate. 

Printout Level Detail 

Determines what additional pathway details are written to the output 
file.  The user can select from the following options: 

• None (default) – writes no extra details. 
• Transport Each Time Step – writes information about the 

transport for each group (noble gas, elemental, organic, and 
aerosol (particulate)) at each time step. 

• Nuclide and Transport Each Time Step – same as the option 
above, but includes information about each transported 
nuclide. 

• Nuclide and Transport at End Only – same as the option 
above, but only written out at the end of the calculation. 
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Table 3-9 Summary of SNAP/RADTRAD inputs – Pathways (cont.) 

Input Description 

Aerosol Removal Model 
(if pathway type is Piping) 

Specifies how aerosols (particulates) are deposited in the pipe.  The 
user can select from the following options: 

• No aerosol removal (default) – aerosol removal is not 
modeled in the pipe. 

• User Defined Decontamination Factors – if the user selects 
this option the Aerosol DF text box appears below this option.  
Select the Custom Editors ( ) icon for this text box to open 
the Editing Aerosol DF window.  The user enters time-
dependent decontamination factors and flow rates (ft3/min or 
m3/s) in the data entry table (see Section 3.3.3 for details 
regarding data entry using the Custom Editors ( ) icon and 
the edit table features in SNAP/RADTRAD). 

• Brockmann-Bixler Model – If the user selects this option the 
following additional input text boxes appear below this option 
with user-specified values to be entered: 

 pipe volume (ft3 or m3) 
 pipe surface area (ft2 or m2) 
 pipe angle (degrees) 
 pipe temperature (°F or °C) 
 pipe pressure (psi or kPa) 
 pipe aerosol settling velocity (ft/min or m/s) 
 pipe aerosol flow rates are entered by selecting 

the Custom Editors ( ) icon to open the Editing 
Pipe Aerosol Flow Rates window.  Enter the flow 
rates (ft/min or m/s) as a function of time in the 
data entry table. 

Note that addition guidance and information on these inputs is 
available by clicking on the Help ( ) icon and Section 4.5.3. 

Elemental Iodine Removal 
Model 

(if pathway type is Piping) 

Determines how elemental iodine is deposited in the pipe.  The user 
can select from the following options: 

• None (default) – elemental iodine removal is not modeled in 
the pipe. 

• Enter DFs and Flow Rates – if the user selects this option the 
removal rate is defined as a function of flow rate and DFs over 
time.  When this option is selected the Elemental Iodine DF 
text box appears below this option.  Select the Custom Editors 
( ) icon for this text box to open the Editing Elemental Iodine 
DF window.  The user enters time-dependent DFs and flow 
rates (ft3/min or m3/s) in the data entry table. 

• Enter Deposition Velocity – If the user selects this option the 
Elemental Iodine Deposition Velocity text box appears below 
this option.  The user enters iodine the deposition velocity 
(ft/min or m/s). 
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Table 3-9 Summary of SNAP/RADTRAD inputs – Pathways (cont.) 

Input Description 

Organic Iodine Removal 
Model 

(if pathway type is Piping) 

Determines how organic iodine is deposited in the pipe.  The user can 
select from the following options:  

• None (default) – elemental iodine removal is not modeled in 
the pipe. 

• Enter DFs and Flow Rates – if the user selects this option the 
removal rate is defined as a function of flow rate and DFs over 
time.  When this option is selected the Organic Iodine DF text 
box appears below this option.  Select the Custom Editors      
( ) icon for this text box to open the Editing Organic Iodine 
DF window.  The user enters time-dependent DFs and flow 
rates (ft3/min or m3/s) in the data entry table. 

• Enter Deposition Velocity – If the user selects this option the 
Organic Iodine Deposition Velocity text box appears below 
this option.  The user enters iodine the deposition velocity 
(ft/min or m/s). 

Note:  The NRC does not credit organic deposition in design basis 
calculations.  

Filter 
(if pathway type is Filter 

Pathway) 

Specifies the air filter removing radionuclides from transport in the 
pathway.  Use the Select ( ) icon to open the Select from Filters 
window to link to one of the available filter models or creates a filter 
component. 

Aerosol DF 
(if pathway type is Generic 

or Generic w/non-Iodine 
Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the Editing 
Aerosol DF window.  Enter the time-dependent DFs and flow rates 
(ft3/min or m3/s) in the data entry table. 

Elemental Iodine DF 
(if pathway type is Generic 

or Generic w/non-Iodine 
Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the Editing 
Elemental Iodine DF window.  Enter the time-dependent DFs and flow 
rates (ft3/min or m3/s) in the data entry table. 

Organic Iodine DF 
(if pathway type is Generic 

or Generic w/non-Iodine 
Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the Editing 
Organic Iodine DF window.  Enter the time-dependent DFs and flow 
rates (ft3/min or m3/s) in the data entry table. 

Note:  The NRC does not credit organic deposition in design basis 
calculations. 

Noble Gas Flow Rates 
(if pathway type is Generic 

or Generic w/non-Iodine 
Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the Editing 
Noble Gas Flow Rates window.  Enter the time-dependent flow rates 
(ft3/min or m3/s) in the data entry table. 

Leakage Rate 
(if pathway type is Air 

leakage) 

Select the Custom Editors ( ) icon for this text box to open the Editing 
Leakage Rate window.  Enter the time-dependent flow leakage rates 
(%/day) in the data entry table. 
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Table 3-10 Summary of SNAP/RADTRAD inputs – Natural Deposition 

Input Description 

Name Specified by user (optional). 

Component Number 

Multiple natural deposition models can be used in a model and 
the SNAP/RADTRAD Model Editor assigns the number.  These 
numbers must begin with number 1 and increase sequentially for 
each additional component. 

Description Specified by user (optional). 

Aerosol Deposition Model 

Specifies the method by which the deposition removes 
radionuclides from the compartment.  The user can select from 
the following options: 

• None (default) –no deposition is modelled. 
• User Defined Coefficients – deposition is determined 

from user-specified removal rate coefficients over time. 
• Henry’s Model Coefficients – uses Henry’s model for 

natural deposition.  User specifies compartment height 
and particle density over time.  See Section 4.5.2.1 for 
more model details and references. 

• Powers’ Deposition Model – the Powers’ model for 
natural deposition, calculated based on an uncertainty 
percentile associated with a reactor and accident type.  
This model is only for large buildings, and is not valid for 
deposition in passages such as pipes.  See Section 
4.5.2.2 for more model details and references. 

Aerosol Removal Coefficients 
(if Aerosol Deposition Model is 

User Defined Coefficients) 

Defines the aerosol (particulate) radionuclide removal as a 
function of time.  Select the Custom Editors ( ) icon for this text 
box to open the Editing Aerosol Removal Coefficients window.  
Enter the time-dependent removal coefficients (1/hour) in the 
data entry table. 

Henry Deposition Table Data 
(if Aerosol Deposition Model is 

Henry’s Model Coefficients) 

The table is used by the code to determine the particle deposition 
rate from the compartment height and particle density over time.  
Select the Custom Editors ( ) icon for this text box to open the 
Editing Henry’s Deposition Table Data window.  Enter the time-
dependent height (ft or m) and particle density (lb/ft3 or g/cm3) in 
the data entry table. 
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Table 3-10 Summary of SNAP/RADTRAD inputs – Natural Deposition (cont.) 

Input Description 

Powers Accident Model Type 
(if Aerosol Deposition Model is 

Powers Deposition Model) 

Sets the model of decontamination based on the type of reactor 
and accident.  Select the accident type using the drop-down 
menu. 

• PWR-DBA 
• BWR-DBA 
• APWR-DBA 

Power’s Model Percentile 
(if Aerosol Deposition Model is 

Powers Deposition Model) 

Sets the uncertainty percentile for the Powers model for natural 
deposition.  Select the accident type using the drop-down menu. 

• 10% 
• 50% 
• 90% 

Note:  The 10% deposition model yields the most conservative 
aerosol removal coefficients. 

Elemental Deposition Model Type 

Determines the method by which the deposition removes 
elemental iodine from the compartment.  The user can select 
from the following options: 

• None (default) –no decontamination is modelled. 
• User Defined Coefficients – decontamination is specified 

as a function of removal coefficients over time.  When 
this option is selected the Elemental Iodine Removal 
Coefficient text box appears below this option. 

Elemental Iodine Removal 
Coefficient 

(if Elemental Deposition Model 
Type is User Defined Coefficients) 

Defines the elemental iodine radionuclide removal as a function 
of time.  The removal coefficient is defined as the fraction of the 
total elemental iodine mass inserted into the containment 
removed per second.  Select the Custom Editors ( ) icon for this 
text box to open the Editing Elemental Iodine Removal 
Coefficient window.  The user enters time-dependent elemental 
iodine removal coefficients (1/hour) in the data entry table. 
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Table 3-11 Summary of SNAP/RADTRAD inputs – Filters 

Input Description 

Name Specified by user (optional). 

Component Number 

Multiple filters can be used in a model and the SNAP/RADTRAD 
Model Editor assigns the number.  These numbers must begin 
with number 1 and increase sequentially for each additional 
component. 

Description Specified by user (optional). 

Filter Table 

The removal efficiency of filters and flow rate through the filters 
as a function of time.  Select the Custom Editors ( ) icon for this 
text box to open the Editing Filter Table window.  Each row 
defines time dependent filter flows (ft3/min or m3/s) and 
efficiencies (%) for: 

• aerosol (particulate) 
• elemental iodine 
• organic iodine filtration 

There is no noble gas efficiency as it is assumed that the noble 
gases are not filtered.  The efficiencies will change in a stepwise 
fashion at each specified time. 

Table 3-12 Summary of SNAP/RADTRAD inputs – Sprays 

Input Description 

Name Specified by user (optional). 

Component Number 

Multiple spray models can be used in a model and the 
SNAP/RADTRAD Model Editor assigns the number. These 
numbers must begin with number 1 and increase sequentially 
for each additional component.  

Description Specified by user (optional). 
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Table 3-12 Summary of SNAP/RADTRAD inputs – Sprays (cont.) 

Input Description 

Aerosol Removal Model 

Determines the method by which the spray removes aerosol 
(particulate) radionuclides from the compartment.  The user can 
select from the following options:  

• None (default) – aerosols are not removed from the 
compartment. 

• User Defined Coefficient Table – allows the user to 
specify the aerosols removal rate coefficient over time.  
When this option is selected the Aerosol Removal 
Coefficients, Aerosol DF Limit Enabled, Aerosol DF 
Limit, Aerosol Lambda/10 DF Limit Enabled, and the 
Aerosol Lambda/10 DF Limit text boxes appear below 
this option. 

• Powers’ Model – the aerosol removal rate is 
determined using by the Powers and Burson model, 
which takes into account sprayed and non-sprayed 
volume, deposition percentile, and spray flux ratio and 
height over time.  When this option is selected the 
Powers Model Spray Table, Powers Model Spray Ratio 
and the Powers Model Percentile text boxes appear 
below this option.  See Section 4.5.1 for more details. 

Aerosol Removal Coefficients 
(if Aerosol Removal Model type is 
User Defined Coefficient Table) 

Select the Custom Editors ( ) icon for this text box to open the 
Editing Aerosol Removal Coefficients window.  The user enters 
time-dependent aerosol removal coefficients (1/hour) in the data 
entry table. 

Aerosol DF Limit Enabled 
(if Aerosol Removal Model is User 

Defined Coefficient Table) 

The user selects from either True or False.  If True is selected, 
the Aerosol DF Limit text box appears below this option. 

Aerosol DF Limit 
(if Aerosol Removal Model is User 

Defined Coefficient Table) 

The user enters a DF value to limit the amount of aerosol 
removal.  Once this DF is reached in the compartment the 
aerosol lambda or removal coefficient is automatically set to 
zero.  The DF value must be 1.0 or greater and the default value 
is 1.0E+06. 

Aerosol DF Limit, Aerosol 
Lambda/10 DF Limit Enabled 

(if Aerosol Removal Model is User 
Defined Coefficient Table) 

The user selects from either True or False.  If True is selected, 
the Aerosol Lambda/10DF Limit text box appears below this 
option. 

Aerosol Lambda/10 DF Limit 
(if Aerosol Removal Model is the 

Powers Model) 

The user enters a DF value to limit the amount of aerosol 
removal.  Once this DF is reached in the compartment the 
aerosol lambda or removal coefficient is automatically set to 
1/10th its original value.  The DF value must be 1.0 or greater 
and the default value is 50. 
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Table 3-12 Summary of SNAP/RADTRAD inputs – Sprays (cont.) 

Input Description 

Powers Model Spray Table 
(if Aerosol Removal Model is the 

Powers Model) 

Specified as a function of spray flux and the fall height of the 
spray droplets (typically the distance between the spray headers 
and the containment floor).  Select the Custom Editors ( ) icon 
for this text box to open the Editing Powers Model Spray Table 
window.  Enter the time-dependent spray flux (cfm/ft2 or 
(m3/s)/m2) and spray height (ft or m).  Unit switching is done by 
right-clicking on the black bar of the Navigator window and 
selecting Engineering Units and choosing either British or SI 
units. 

The spray flux and height are discussed in NUREG/CR-5966, “A 
Simplified Model of Aerosol Removal by Containment Sprays” 
[12]. 

The Powers’ model is valid in the spray flux ratio range 1.0E-05 
to 2.5E-03 m3/s-m2 (0.002 and 0.5 cfm/ft2) and a range of spray 
fall heights between 5 to 50 m (16.4 and 164 ft). 

Powers Model Spray Ratio 
(if Aerosol Removal Model is the 

Powers Model) 

The ratio of unsprayed to sprayed volume in the compartment.  
This is typically zero, as the unsprayed volume is often modeled 
as a separate compartment.  Good mixing is assumed for any 
ratio above zero; if good mixing is not available, the sprayed and 
unsprayed compartments should be modeled separately. 

Powers Model Percentile 
(if Aerosol Removal Model is the 

Powers Model) 

The percentile model used in the calculation.  Select the percent 
using the drop-down menu. 

• 10% 
• 50% 
• 90% 

Note: the 10% model yields the most conservative aerosol 
removal coefficients. 

Elemental Iodine Removal Model 

Determines the method by which the spray removes aerosol 
(particulate) radionuclides from the compartment.  The user can 
select from the following options:  

• None (default) – elemental iodine is not removed from 
the compartment. 

• User Defined Coefficient Table – elemental iodine is 
removed using user-specific removal rate coefficients 
input by the user.  When this option is selected the 
Elemental Iodine Removal Coefficients, Elemental-I DF 
Limit Enabled, and Elemental-I DF Limit text boxes 
appear below this option. 

Elemental Iodine Removal 
Coefficients 

(if Elemental Iodine Removal Model 
is the User Defined Coefficients) 

Defines the elemental iodine radionuclide removal coefficients 
used to determine the elemental iodine removal rate as a 
function of time.  Select the Custom Editors ( ) icon for this text 
box to open the Editing Elemental Iodine Removal Coefficients 
window.  The user enters time-dependent elemental iodine 
removal coefficients (1/hour) in the data entry table. 
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Table 3-12 Summary of SNAP/RADTRAD inputs – Sprays (cont.) 

Input Description 

Elemental-I DF Limit Enabled 
(if Elemental Iodine Removal Model 

is the User Defined Coefficients) 

The user selects from either True or False.  If True is selected, 
the Elemental-I DF Limit text box appears below this option. 

Elemental-I DF Limit 
(if Elemental Iodine Removal Model 

is the User Defined Coefficients) 

The user enters a DF value to limit the amount of elemental 
removal.  Once this DF is reached in the compartment the 
elemental lambda or removal coefficient is automatically set to 
zero.  The DF value must be 1.0 or greater and the default value 
is 20. 

Organic Iodine Removal Model 

Determines the method by which the spray removes organic 
iodine from the compartment.  The user can select from the 
following options:  

• None (default) – organic iodine is not removed from the 
compartment. 

• User Defined Coefficient Table – organic iodine is 
removed using user-specified removal rate coefficients 
as an organic removal coefficient over time.  When this 
option is selected the Organic Iodine Removal 
Coefficients text box appear below this option. 

Organic Iodine Removal 
Coefficients 

(if Organic Iodine Removal Model 
is the User Defined Coefficients) 

Defines the organic iodine radionuclide removal as a function of 
time.  Select the Custom Editors ( ) icon for this text box to 
open the Editing Organic Iodine Removal Coefficients window.  
The user enters time-dependent elemental iodine removal 
coefficients (1/hour) in the data entry table. 

Note:  The NRC does not credit organic deposition in design 
basis calculations. 

3.4.4 Dose Locations, Breathing Rates, and Χ/Q Tables 

Section 3.3.3 demonstrates the general approach for defining dose locations, breathing rates, 
and Χ/Q tables.  Generally, the default breathing rates are used for most analyses and are 
entered under the Dose Locations node in the Property window.  The values for Χ/Q are 
specified through the use of data entry tables as illustrated in Section 3.3.3 (Figure 3-33).  
Tables 3-13 and 3-14 list the available inputs for the Dose Locations and Χ/Q Tables nodes in 
SNAP/RADTRAD. 
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Table 3-13 Summary of SNAP/RADTRAD inputs – Dose Locations 

Input Description 

Name 
The EAB or LPZ dose location names are set by 
SNAP/RADTRAD.  Other dose location names (i.e. control 
room) are created by the user. 

Description 
The EAB or LPZ dose location descriptions are set by 
SNAP/RADTRAD.  Other dose location descriptions (i.e. control 
room) must be created manually by the user. 

Component Number 

Multiple dose locations can be used in a model and the 
SNAP/RADTRAD Model Editor assigns the number.  These 
numbers must begin with number 1 and increase sequentially 
for each additional component. 

Breathing Rates 

Defines the breathing rates at the dose locations as a function 
of time.  Select the Custom Editors ( ) icon for this text box to 
open the Editing Breathing Rates window.  The user can then, if 
necessary, select the default breathing rates by left clicking the 
Default button and choosing between either the EAB/LPZ or 
Control Room options.  The default breathing rates for each are 
listed below: 

• EAB/LPZ 

Time 
(h) 

Breathing 
Rates 
(m3/s) 

0.0 3.5E-04 

8.0 1.8E-04 

24.0 2.3E-04 

• Control Room 

Time 
(h) 

Breathing 
Rates 
(m3/s) 

0.0 3.5E-04 

Additionally the user can enter time-dependent breathing rates 
(ft3/min or m3/s) in the data entry table. 

Χ/Q Table 
Specifies the Χ/Q table to be used with this dose location.  Use 
the Select ( ) icon to open the Select from Χ/Q Tables window 
to link to one of the available Χ/Q Tables. 

Occupancy Factors 

Specifies the occupancy factors table to be used with the 
control room (or the technical support center) dose location.  
Use the Custom Editors ( ) icon to open the Editing 
Occupancy Factors window.  The user can then use the provide 
time dependent occupancy factors for the dose location.  
Occupancy factors may only be input for the control room 
compartment. 
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Table 3-14 Summary of SNAP/RADTRAD inputs – Χ/Q Tables 

Input Description 

Name 

X/Q values are specified for the EAB and LPZ dose locations by 
default in SNAP/RADTRAD.  Users must specify X/Q data for 
the EAB and LPZ.  X/Q data for additional dose locations can be 
specified by the user (optional). 

Component Number 
The EAB is set to Χ/Q Table 1 and LPZ is set to Χ/Q Table 2 by 
SNAP/RADTRAD.  User-specified X/Q tables are automatically 
numbered by SNAP/RADTRAD. 

Description Specified by user (optional). 

X/Q Table 
Select the Custom Editors ( ) icon for this text box to open the 
Editing X/Q Tables window.  The user enters time-dependent 
X/Q values (s/m3) in the data entry table. 

One item of note is the link between the dose location and Χ/Q table.  Like most of the functions 
in the SNAP Model Editor there is a couple of different ways to create the link between the dose 
location and the Χ/Q table.  The easiest way to establish this link is by clicking on the main Χ/Q 
Tables [2] node in the Navigator window to view the Property window for this node.  In the 
Property window select the Custom Editors ( ) icon to the right of the Onsite Χ/Q Tables text 
box to open the Onsite Χ/Q Table Map window (Figure 3-59).  Alternatively, the user can also 
open the Onsite Χ/Q Table Map window by opening the Property window for the environment 
compartment and select the Custom Editors ( ) icon to the right of the Onsite Χ/Q Tables text 
box. 

The Onsite Χ/Q Table Map window will appear and the user can link the Χ/Q table and dose 
location.  In the Onsite Χ/Q Table Map window (Figure 3-59), the provided row headers list each 
of the pathways which are entering the environment.  These are annotated further by the 
Release to Environment label to the left of the rows.  Column headers in the Onsite Χ/Q Table 
Map window represent the pathways out of the environment.  These are annotated by an Intake 
from Environment label placed above the table.  Each column represents an exhaust while 
every row represents an inflow.  To map an X/Q table, click within a cell to enable the Select ( ) 
icon.  Click the Select ( ) icon to open the Select from X/Q Tables window; use this window to 
select the X/Q Table mapped to the inflow and exhaust.  Users should note that 
SNAP/RADTRAD does not allow X/Q tables to be defined for exhaust from the control room to 
the environment.  The remaining nodes under the Navigator window are listed and described in 
Table 3-15. 
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Figure 3-59 Onsite Χ/Q Table Map window 

Table 3-15 Summary of SNAP/RADTRAD inputs – Remaining inputs 

Input Description 

Connections 

Connections among compartments (paths), dose locations, and source connections can be specified.  
Usually, drag and drop is used.  Note that connections between compartments cannot be created by 
the Navigator window.  A pathway needs to be defined and then the connection needs to be made 
using the Connection Tool ( ) icon in the View / Dock window (see Section 3.3.2). 

Job Streams 

Name 

The name for this job stream.  This will be used to generate the 
relative path for the tasks that make up this stream.  The default 
value for the name is Simple_Stream and it is recommended 
that SNAP/RADTRAD users change this to a unique name that 
is identifiable to the model (see Section 3.2.2). 

Description Specified by user (optional). 
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Table 3-15 Summary of SNAP/RADTRAD inputs – Remaining inputs (cont.) 

Input Description 

Stream Type 

Defines the type of calculation that may be implemented through 
this job stream.  The user can select from the following options:  

• Basic Job Stream (default) – a simple job stream. 
• Numeric Combination – builds a set of input models by 

modifying one or more shared numeric variables.  Each 
selected shared numeric will either iterate through a list 
of predefined values or increment from a start value to 
an end value. 

• Tabular Parametric – the parametric case takes the 
form of a table of shared variable values. 

• Dakota Uncertainty – uncertainty support for the 
Dakota toolkit. 

SNAP/RADTRAD user should use the default value. 

File Groups 

Typically, the File Groups text box is not used in 
SNAP/RADTRAD.  Defines groups of input sources and forces 
files inside file sets to be associated one-to-one with other file 
sets or parametric model node outputs. 

Platform The platform that this stream will be submitted to by default.  
The default value for SNAP/RADTRAD is Local. 

Root Folder 

The calculation server folder where the job stream is executed 
(see Section 3.2.2).  Select the Custom Editors ( ) icon for this 
text box to open the Edit Calculation Server Root Folders 
window. 

Relative Location 

The relative location of this stream in relation to the selected 
staging location.  The staging location is where intermediate 
files, such as the stream definition, will be stored while a job 
stream is running (see Section 3.4.2 of reference [4] for more 
details). 

Log Level 
Typically, the Log Level text box is not changed from the default 
value (Information) in SNAP/RADTRAD.  Defines the current log 
level for messages produced by this stream.   

View in Job Status 
This property determines whether the SNAP Job Status window 
will be opened to view the status of this stream after submission.  
The default value for SNAP/RADTRAD is Yes. 
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Table 3-15 Summary of SNAP/RADTRAD inputs – Remaining inputs (cont.) 

Input Description 

Linear Execution 

Job Streams using Linear Execution are executed one task at a 
time, prioritized by their Step Number.  In a normal (non-linear) 
Job Stream, tasks will be executed as soon as their 
dependencies are available (i.e. up-stream tasks are complete) 
up to the maximum number allowed by the platform.  This option 
should only be used in situations where the stream must 
execute one task at a time and each task must complete before 
another can be executed. 

In most cases, including SNAP/RADTRAD, this value should be 
left at its default value (No). 

Numerics 

The SNAP user-defined Numerics feature is designed to allow properties of a model to be modified 
and/or calculated outside the normal input for the model.  A user may create real, integer, Boolean, 
string, and table variables, as well and functions.  Typically, the Numerics node is not used in 
SNAP/RADTRAD.  See Section 2.5 of reference [4] for more details about User-Defined Numerics in 
other SNAP applications. 

Views 

The user can specify multiple views so that various model icons can be seen.  Usually, one view 
(Default View) is sufficient for SNAP/RADTRAD models.  The Property window for the Default View 
node values can be modified by the user as needed, but typically the default values for the text boxes 
will be sufficient for most models.  Section 3.3.4 describes some of the options associated with the 
Default View node Property window text boxes.  The user can select the Help ( ) icon for each 
Default View node Property window text box to obtain more information on each one. 

 



 

4-1 

4.0 MODELS USED IN RADTRAD 
The radiological consequences of an accident in a nuclear reactor depend upon the quantity of 
the radioactive material that escapes to the environment or enters into the control room.  
SNAP/RADTRAD is designed to calculate doses at offsite locations, such as the EAB, LPZ and 
in the control room.  Source term models from TID-14844 or from NUREG-1465 are 
incorporated into SNAP/RADTRAD to describe fission product release from the fuel to the 
containment.  Models for natural deposition within a compartment and engineered removal 
mechanisms, such as sprays and filters are available in the code.  Flow between compartments 
is modeled and HEPA and charcoal filters can be included in the flow paths for radionuclide 
removal due to filtration.  Leakage to the environment can also be modeled and doses 
calculated to various points in the environment, such as the EAB and LPZ.  After transporting 
the nuclides to different locations, SNAP/RADTRAD calculates the dose at user-specified 
locations.  Note that much of the discussion in this section is based on the original RADTRAD 
documentation in NUREG/CR-6604 and its two supplements. 

4.1 Governing Equations in RADTRAD 

The basic RADTRAD-AC model is a multi-compartment model where each compartment 
represents a portion of the plant being analyzed.  Generally, the containment volume(s), 
environment, and control room(s) are modeled as compartments.  Figure 4-1 presents a 
diagram illustrating a typical SNAP/RADTRAD model.  This figure shows a two-volume 
containment connected to the environment.  A two-volume containment compartment may be 
used to represent the sprayed and unsprayed portions of the containment.  A control room is 
shown which contains ventilation intakes from the environment through two filtered flow 
pathways, one recirculating and one that intakes directly from the environment.  Recirculating 
filtered flow paths are typically used to reduce the airborne radionuclide concentration in the 
control room.  An unfiltered intake to the control room from the environment representing in 
leakage is also represented.  The control room ventilation discharges back to the environment.  
Dashed lines denote connections with transfer rates of zero and are shown for completeness 
(e.g. no backflow from the control room or environment to the containment). 

The governing equations in the RADTRAD-AC are balanced first-order linear differential 
equations relating the release of radionuclides typically from the reactor core to a given 
compartment to the removal of radionuclides within a given compartment and the transfer of 
radionuclides among compartments.  Within each compartment except the environment, the 
radionuclides that are airborne within that compartment are assumed to be uniformly distributed 
or mixed.  The environment compartment is where the EAB and LPZ dose points are located.  
In many cases, the control room ventilation system draws suction from the environment.  Note 
that coupling of transfer pathways from the containment to the EAB, LPZ and control room 
intakes is done using Χ/Q values.  The Χ/Q values relate the amount of radionuclide released to 
the environment to the dispersed radionuclide concentration at a particular location in the 
environment.  Since each Χ/Q value is associated with a release point and an intake location, 
the radionuclide inventory is not uniformly distributed in the environment compartment. 
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Figure 4-1 Schematic of a typical SNAP/RADTRAD dose assessment model 

The equations used to calculate the quantity of radionuclide in each compartment can be 
presented concisely in terms of the Λ𝑘𝑘,𝑗𝑗

𝑖𝑖  coefficients.  However, it is important to note that 
multiple factors contribute to each of these transfer and removal rate coefficients.  After 
presenting the concise form of the transport equations, the specific terms included in the Λ𝑘𝑘,𝑗𝑗

𝑖𝑖  
coefficients will be presented. 

In developing equations representing the system shown in Figure 4-1, the quantity within each 
compartment or transferred from compartment is expressed in terms of the number of atoms in 
a chemical element group presented in Section 4.3 (Table 4-2).  The quantity can also be 
expressed in terms of radionuclide inventory for each nuclide.  In the equations below, the term 
species can refer to a radionuclide or chemical element.  
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Referring to Figure 4-1, the rate of change of the number of atoms in compartment 1 (upper left) 
is determined from Equation (4-1): 

𝑑𝑑𝑁𝑁1
𝑖𝑖

𝑑𝑑𝑑𝑑
= 𝑅𝑅1

𝑖𝑖 − Λ1,1
𝑖𝑖 𝑁𝑁1

𝑖𝑖 + Λ1,2
𝑖𝑖 𝑁𝑁2

𝑖𝑖 + Λ1,3
𝑖𝑖 𝑁𝑁3

𝑖𝑖 + Λ1,4
𝑖𝑖 𝑁𝑁4

𝑖𝑖 (4-1) 

where 

  𝑅𝑅1
𝑖𝑖  = the source release rate of species i in compartment 1 in atoms/s 

 Λ1,1
𝑖𝑖  = the removal rate of species i within compartment 1 in 1/s 

 𝑁𝑁1
𝑖𝑖 = the inventory of species i in compartment 1 in atoms 

 Λ1,2
𝑖𝑖  = the transfer rate of species i from compartment 2 to compartment 1 in 1/s 

 𝑁𝑁2
𝑖𝑖 = the inventory of species i in compartment 2 in atoms 

 Λ1,3
𝑖𝑖  = the transfer rate of species i from compartment 3 to compartment 1 in 1/s 

 𝑁𝑁3
𝑖𝑖 = the inventory of species i in compartment 3 in atoms 

 Λ1,4
𝑖𝑖  = the transfer rate of species i from compartment 4 to compartment 1 in 1/s 

 𝑁𝑁4
𝑖𝑖 = the inventory of species i in compartment 4 in atoms. 

The rate of change of the number of atoms in compartment 2 is given by Equation (4-2): 

𝑑𝑑𝑁𝑁2
𝑖𝑖

𝑑𝑑𝑑𝑑
= 𝑅𝑅2

𝑖𝑖 − Λ2,2
𝑖𝑖 𝑁𝑁2

𝑖𝑖 +  Λ2,1
𝑖𝑖 𝑁𝑁1

𝑖𝑖 + Λ2,3
𝑖𝑖 𝑁𝑁3

𝑖𝑖 + Λ2,4
𝑖𝑖 𝑁𝑁4

𝑖𝑖 (4-2) 

where: 

 𝑅𝑅2
𝑖𝑖  = the source release rate of species i in compartment 2 in atoms/s 

 Λ2,2
𝑖𝑖  = the removal rate of species i within compartment 2 in 1/s 

 Λ2,1
𝑖𝑖  = the transfer rate of species i from compartment 1 to compartment 2 in 1/s 

 Λ2,3
𝑖𝑖  = the transfer rate of species i from compartment 3 to compartment 2 in 1/s 

 Λ2,4
𝑖𝑖  = the transfer rate of species i from compartment 4 to compartment 2 in 1/s. 

The rate of change in the number of atoms in compartment 3 is given by Equation (4-3): 

𝑑𝑑𝑁𝑁3
𝑖𝑖

𝑑𝑑𝑑𝑑
= 𝑅𝑅3

𝑖𝑖 − Λ3,3
𝑖𝑖 𝑁𝑁3

𝑖𝑖 +  Λ3,1
𝑖𝑖 𝑁𝑁1

𝑖𝑖 + Λ3,2
𝑖𝑖 𝑁𝑁3

𝑖𝑖 + Λ3,4
𝑖𝑖 𝑁𝑁4

𝑖𝑖 (4-3) 

where: 

 𝑅𝑅3
𝑖𝑖  = the source release rate of species i in compartment 3 in atoms/s 

 Λ3,3
𝑖𝑖  = the removal rate of species i within compartment 3 in 1/s 

 Λ3,1
𝑖𝑖  = the transfer rate of species i from compartment 1 to compartment 3 in 1/s 

 Λ3,2
𝑖𝑖  = the transfer rate of species i from compartment 2 to compartment 3 in 1/s 

 Λ3,4
𝑖𝑖  = the transfer rate of species i from compartment 4 to compartment 3 in 1/s. 

The rate of change of the number of atoms in compartment 4 is given by Equation (4-4): 

𝑑𝑑𝑁𝑁4
𝑖𝑖

𝑑𝑑𝑑𝑑
= 𝑅𝑅4

𝑖𝑖 − Λ4,4
𝑖𝑖 𝑁𝑁4

𝑖𝑖 + Λ4,1
𝑖𝑖 𝑁𝑁1

𝑖𝑖 + Λ4,2
𝑖𝑖 𝑁𝑁2

𝑖𝑖 + Λ4,3
𝑖𝑖 𝑁𝑁3

𝑖𝑖 (4-4) 

where: 

 𝑅𝑅4
𝑖𝑖  = the source release rate of species i in compartment 4 in atoms/s 
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 Λ4,4
𝑖𝑖  = the removal rate of species i within compartment 4 in 1/s 

 Λ4,1
𝑖𝑖  = the transfer rate of species i from compartment 1 to compartment 4 in 1/s 

 Λ4,2
𝑖𝑖  = the transfer rate of species i from compartment 2 to compartment 4 in 1/s 

 Λ4,3
𝑖𝑖  = the transfer rate of species i from compartment 3 to compartment 4 in 1/s. 

More generally, the rate of change of the number of atoms in the kth compartment in a set of n 
interconnected compartment is given by Equation (4-5) below: 

𝑑𝑑𝑁𝑁𝑘𝑘
𝑖𝑖

𝑑𝑑𝑑𝑑
= 𝑅𝑅𝑘𝑘

𝑖𝑖 −  � 𝜆𝜆𝑗𝑗,𝑗𝑗
𝑖𝑖 𝑁𝑁𝑘𝑘

𝑖𝑖
𝑛𝑛

𝑗𝑗=1

+ � 𝜆𝜆𝑘𝑘,𝑗𝑗
𝑖𝑖 𝑁𝑁𝑗𝑗

𝑖𝑖
𝑛𝑛

𝑗𝑗=1,𝑗𝑗≠𝑘𝑘

 (4-5) 

In Equation (4-5), 𝑅𝑅𝑘𝑘
𝑖𝑖  is the source release rate of species i in compartment k in atoms/s.  The 

first summation represents the removal terms from compartment k due either to removal within 
the compartment or transfer to another compartment.  The second summation represents 
transfer from compartment j to compartment k.  The general matrix formulation of transport 
Equation (4-5) is represented in Equation (4-6). 
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Note that the time derivative is represented by �̇�𝑁𝑗𝑗
𝑖𝑖.  The Λ coefficient matrix is a transfer matrix 

where the diagonal terms are the removal coefficients applicable to a given compartment j 
(hence the – sign) and the off-diagonal terms are transfer coefficients relating the transfer of 
material from various compartments to compartment j. 

Off-diagonal transfer terms are calculated as f/V where f is the flow rate out of a compartment 
(volume units/s) and V is the compartment volume, yielding units of 1/s.  This ratio is multiplied 
by the radionuclide inventory in the upstream connecting compartment to provide a source to 
the connecting downstream compartment.  Diagonal terms or removal terms are more complex 
because of the various removal processes that are modeled in the RADTRAD-AC.  However, 
the idea is the same in that a removal coefficient expressed in units of 1/s is multiplied by the 
radionuclide inventory to yield a removal rate.  The terms included in the diagonal removal 
coefficients and the off-diagonal transfer coefficients are shown below (Equation 4-7) with 
details on the calculation of removal coefficients provided in Section 4.5. 

The terms included in the diagonal removal coefficients each have unit of 1/s and are: 

Λ𝑗𝑗,𝑗𝑗
𝑖𝑖 = 𝜆𝜆𝑗𝑗,𝑠𝑠𝑠𝑠𝑠𝑠

𝑖𝑖 + 𝜆𝜆𝑗𝑗,𝑑𝑑𝑑𝑑𝑠𝑠
𝑖𝑖 + 𝜆𝜆𝑗𝑗,𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠

𝑖𝑖 + � 𝜆𝜆𝑘𝑘,𝑗𝑗
𝑖𝑖

𝑛𝑛

𝑘𝑘=1
𝑘𝑘≠𝑗𝑗

 (4-7) 

where: 

 𝜆𝜆𝑗𝑗,𝑠𝑠𝑠𝑠𝑠𝑠
𝑖𝑖  = the spray removal coefficient in 1/s 

 𝜆𝜆𝑗𝑗,𝑑𝑑𝑑𝑑𝑠𝑠
𝑖𝑖  = the natural deposition removal rate in 1/s 
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 𝜆𝜆𝑗𝑗,𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠
𝑖𝑖  = the filtered removal rated within compartment in 1/s 

 𝜆𝜆𝑘𝑘,𝑗𝑗
𝑖𝑖  = the removal rate from compartment j toward compartment k in 1/s. 

The removal rate 𝜆𝜆𝑘𝑘,𝑗𝑗
𝑖𝑖  includes a few different types of transfer between compartments as shown 

in Equation (4-8). 

𝜆𝜆𝑘𝑘,𝑗𝑗
𝑖𝑖 = 𝜆𝜆𝑘𝑘,𝑗𝑗,𝑓𝑓𝑑𝑑𝑙𝑙𝑘𝑘

𝑖𝑖 + 𝜆𝜆𝑘𝑘,𝑗𝑗,𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠
𝑖𝑖 +

𝑓𝑓𝑘𝑘,𝑗𝑗

𝑉𝑉𝑗𝑗
 (4-8) 

where: 

 𝜆𝜆𝑘𝑘,𝑗𝑗,𝑓𝑓𝑑𝑑𝑙𝑙𝑘𝑘
𝑖𝑖  = the transfer via leakage paths in 1/s 

 𝜆𝜆𝑘𝑘,𝑗𝑗,𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠
𝑖𝑖  = the transfer through a filtered path in 1/s 

 𝑓𝑓𝑘𝑘,𝑗𝑗 = the flow in m3/s from j to k through a path with a DF 
 𝑉𝑉𝑗𝑗 = the volume of compartment j in m3. 

The removal terms from Equation (4-8) are related to the off-diagonal transfer terms in Equation 
(4-6).  However not all of the nuclide leaving compartment j necessarily reaches compartment k.  
The filtered flow and the DF related flow terms require an additional coefficient that indicates the 
fraction of the nuclide that was removed in transit.  The terms in the off-diagonal transfer 
coefficients are shown in Equation (4-9). 

Λ𝑗𝑗,𝑘𝑘
𝑖𝑖 = 𝜆𝜆𝑗𝑗,𝑘𝑘,𝑓𝑓𝑑𝑑𝑙𝑙𝑘𝑘

𝑖𝑖 + �1 −
𝜂𝜂𝑗𝑗,𝑘𝑘

𝑖𝑖

100� 𝜆𝜆𝑗𝑗,𝑘𝑘,𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠
𝑖𝑖 + �

1
𝐷𝐷𝐷𝐷

�
 𝑓𝑓𝑗𝑗,𝑘𝑘

𝑖𝑖

𝑉𝑉𝑘𝑘
  (4-9) 

where: 

 𝜂𝜂𝑗𝑗,𝑘𝑘
𝑖𝑖  = the percent efficiency of the filter in the path from compartment k to j 

 𝐷𝐷𝐷𝐷 = the nondimensional DF for path with flow from compartment k to j.  

Equation (4-6) is solved in the RADTRAD-AC using a matrix exponential method based on work 
done in references [11] and [13].  Matrix exponential methods are used to solve systems of 
linear differential equations of the form �̇�𝑁 = 𝑅𝑅 +  Λ𝑁𝑁 subject to an initial condition N0.  The units 
of the solution variable are expressed in atoms.  This quantity can be converted to other units 
such as grams or Becquerels (Bq).  Section 4.6 discusses how dose is calculated from the 
number of atoms. 

Note that radionuclide decay is not explicitly included in Equation (4-6).  Rather, decay is 
accounted for in the RADTRAD-AC by dividing the solution of the differential equations into two 
parts: (1) radioactive decay and daughter in-growth, and (2) radionuclide transport.  Inclusion of 
radioactive decay and daughter in-growth modeling with Equation (4-4) significantly increases 
the size of the linear system as well as the computational load to solve the system.  The 
separation of these calculations was used to overcome the limitations of personal computers 
available at the time the original version of the RADTRAD-AC was developed and has been 
retained to the present time. 

Radioactive decay and daughter production occur within a compartment, so no 
intercompartmental transfer needs to be considered.  The equations that are solved for these 
processes at each time step are shown in Equation (4-10). 
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𝑑𝑑𝑁𝑁𝑗𝑗
𝑖𝑖

𝑑𝑑𝑑𝑑
= � 𝜆𝜆𝜈𝜈𝛽𝛽𝜈𝜈

𝑖𝑖
𝑛𝑛−1

𝜈𝜈=1
𝑁𝑁𝑗𝑗

𝜈𝜈 + 𝜆𝜆𝑑𝑑𝑑𝑑𝑑𝑑𝑙𝑙𝑑𝑑
𝑖𝑖 𝑁𝑁𝑗𝑗

𝑖𝑖 (4-10) 

where: 

 𝛽𝛽𝜈𝜈
𝑖𝑖  = the fraction of nuclide 𝜈𝜈 that decays to nuclide 𝑖𝑖 (dimensionless) 

 𝜆𝜆𝜈𝜈 = the decay rate associated with 𝛽𝛽𝜈𝜈
𝑖𝑖  in 1/s 

 𝑁𝑁𝑗𝑗
𝜈𝜈 = the quantity of nuclide 𝜈𝜈 in compartment 𝑗𝑗 

 𝜆𝜆𝑑𝑑𝑑𝑑𝑑𝑑𝑙𝑙𝑑𝑑
𝑖𝑖  = the rate of decay of nuclide 𝑖𝑖 in 1/s. 

The decay and transport calculations are performed alternately.  That is, the code begins its 
integration over a time step by analyzing the effect of radioactive decay and daughter in-growth 
on the inventory of all compartments using Equation (4-10).  After updating the inventory, the 
code calculates the effect of radionuclide transport between compartments during that same 
time step using Equation (4-6).  This process of alternating between radioactive decay and 
daughter in-growth and radionuclide transport continues until the specified end time is reached.  
In calculations where radioactive decay is not modeled, the solution algorithm is simplified to the 
single step of calculating radionuclide transport. 

During the course of its numerical integration, the code keeps track of the quantity of each 
nuclide at each location.  Locations include not only compartment volumes, but surfaces and 
filters as well.  By tracking the radionuclides in this manner, conservation of mass can be 
verified. 

The analytical solution of a matrix equation in the form Ṅ = ΛN + R is N(t) = N(0)eAt - A-1(eAt -1)R 
from Equation 3.7 and 3.8 of reference [13], can be confirmed by substituting the solution into 
the matrix equation.  Numerical solution of the transport equations is accomplished by 
constructing the solution as a Taylor series expansion of the analytical matric exponential 
solution in terms of t (specifically the eAt term which is the only time dependent term) and 
truncating the series when the estimated relative error is less than 1E-08.  One advantage of 
this approach is its capacity to obtain good solutions over large time intervals.  The key 
assumption is that there is no change in any phenomenon during a time step, i.e., that the 
coefficients in the ordinary differential equations (ODEs) are constant. 

Without this assumption, the method would not apply.  In order to accommodate this 
assumption, the code synchronizes time steps with the user-supplied phenomena in order to 
capture changes in the coefficients.  Another advantage of this approach is that it is very fast 
and extremely robust.  The algorithm is essentially identical to the one described in reference 
[13].  A useful discussion of matrix exponential methods and how they are solved is given in 
reference [14]. 

The assumption that all nuclides can be grouped according to their chemical and transport 
similarities is also applied in the solution.  Thus, four transport groups were used: noble gases, 
elemental iodine, organic iodine, and aerosols.  Note that the aerosol transport group includes 
all radionuclides assumed to be aerosol as listed in Section 4.3.  These transport groups 
interact with their surroundings differently, but all components of any one group act the same.  
This implies that all xenon and krypton isotopes will transport identically and that cesium, 
barium, and all other aerosol isotopes will transport identically.  The user specifies the fractions 
for the released iodine and thus partitions the iodine within the latter three groups. 
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4.2 Adaptive Time Step Algorithm 

The RADTRAD-AC includes a default algorithm for selecting time step size that is fast and has 
proven to produce good results for typical models.  However, the default time step algorithm 
does not perform error checking to verify that a solution has converged.  The Adaptive Time 
Step option increases the computational cost significantly, but allows the RADTRAD-AC to 
estimate error and adjust the time step size keeping the error within a specified limit.  For many 
models, the Adaptive Time Step option will not change results significantly because the default 
time step algorithm is adequate to achieve convergence. 

As discussed above, a single system of coupled ODEs that simultaneously represents all of the 
phenomena considered by the RADTRAD-AC is defined.  Computation time can be reduced by 
dividing the calculations into two parts: (1) transport and (2) radioactive decay.  The 
fundamental premise behind this approach is that during a time step of small enough duration, 
ignoring the interdependence of the two components of the calculations results in negligible 
error.  That is, numerically solving the transport equations defining transfer of material between 
compartments during a time step can be solved numerically, without taking account of the 
radioactive decay and in-growth occurring over that period, will have a negligible impact on the 
transport solution.  Likewise, solving the radioactive decay and in-growth equations during a 
time step, without considering the simultaneous phenomenon of transport between 
compartments, will have a negligible impact on the decay and in- growth results.  Reducing the 
time step size reduces the error that results from separately calculating transport and 
radioactive decay, and the RADTRAD-AC automatically reduces the default time step size when 
decay is active.  If the user is concerned with this approach, adaptive time step control can be 
enabled to assure that the error introduced by this assumption is small. 

The purpose of an adaptive time step algorithm is to actively choose the time step size in order 
to keep the solution error below a specified limit.  The exact error is not known, so error must be 
estimated.  The error estimate is then used to decide if the time step is too large (or too small) 
and adjust the time step size accordingly.  The adaptive time step algorithm involves the 
following steps: 

1. The error is estimated at each time step by calculating two solutions for the next time 
step, with one solution being more accurate.  The magnitude of the difference between 
the solutions is used to estimate the error.  The errors range from 0, if there is no error, 
to a maximum error of 1.  The error is scaled in order to reduce the number of time steps 
taken in regions where the solution is not changing significantly.  The scaled error is also 
limited to the range 0 to 1. 

2. The scaled error is compared to the user specified maximum error and the following 
steps are taken depending on the magnitude of the error: 

a. If the error value is above the maximum error value (0.001 by default, but can be 
set by the user), then the time step size is cut in half and the calculation is 
repeated. 

b. If the error value is between the maximum error and 1/10 the maximum error, the 
time step size is kept. 

c. If the error is below 1/10 the maximum error the time step size is doubled starting 
with the next time step. 
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This algorithm works without modifications as long as error decreases as the time step size 
decreases and the time step size stay above the minimum time step size.  Modifications to this 
logic to address special cases are discussed later in this section. 

The governing equations for the RADTRAD-AC are defined and solved in terms of the 
radionuclide inventory (atoms) in each compartment.  However, the key results are the dose to 
hypothetical individuals located at specified locations.  The dose values were used in calculating 
an error estimate since they are the primary values of interest.  Additionally, the dose values are 
included in the plot file which makes it easier to understand the adaptive time step controller 
behavior and diagnose problems. 

The ODE solves for 𝑁𝑁𝑗𝑗
𝑖𝑖(𝑑𝑑𝑚𝑚), which is the number or atoms of nuclide i in compartment at time tm 

(the time at time step m).  Based on the nuclide quantities, dose values are calculated at each 
dose location specified in the model.  Two different dose pathways are modeled, cloudshine and 
inhalation, to calculate dose to the skin, thyroid, and TEDE.  These doses are referred to as 
‘dose categories’ for the remainder of this section.  The dose that is calculated can be 
represented as a function of time by a vector 𝐷𝐷𝑘𝑘(𝑑𝑑𝑚𝑚), where the 𝑘𝑘 index represents the different 
dose categories.  A separate error is calculated for each category, and the largest of these is 
recorded as the error. 

To estimate the error at each time step m, two solutions are calculated for time tm+1 = tm + Δt 
starting from the base solution point 𝑁𝑁𝑗𝑗

𝑖𝑖(𝑑𝑑𝑚𝑚), with associated dose represented as Dk,B (dose for 
category 𝑘𝑘 at the base point): 

1. The first solution at time tm+1 is calculated by advancing the ODE solver by a full time 
step of size Δt.  The associated dose is represented as Dk,S1 (solution 1 dose for category 
𝑘𝑘). 

2. The second solution for time tm+1 is calculated by advancing the ODE solver by two half 
time steps (i.e. time steps of size Δt/2).  The associated dose is represented as Dk,S2 
(solution 2 dose for category 𝑘𝑘). 

In order to estimate the error, it is useful to define a measure of magnitude for the dose vector.  
The most obvious choice is the Euclidean length, which gives an overall measure of the 
magnitude of the dose vector.  The magnitude (or norm) of the dose vector will be represented 
as ‖D‖. 

To estimate the local error for dose category 𝑘𝑘, the magnitude of the difference between the two 
solutions ‖Dk,S2 ─ Dk,S1‖ is compared to the magnitude of the change in the solution over the time 
step.  The magnitude of the change in the dose over the current time step for solution 1 and 2 is 
‖Dk,S1 ─ Dk,B‖ and ‖Dk,S2 ─ Dk,B‖ respectively.  To characterize the change in the magnitude, the 
two values are averaged (‖Dk,S1 ─ Dk,B‖ + ‖Dk,S2 ─ Dk,B‖)/2.  A slightly modified version of the 
following formula is used in Equation (4-11) to calculate a local error: 

𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒 =
2�𝐷𝐷𝑘𝑘,𝑆𝑆2 − 𝐷𝐷𝑘𝑘,𝑆𝑆1�

�𝐷𝐷𝑘𝑘,𝑆𝑆1 − 𝐷𝐷𝑘𝑘,𝐵𝐵� + �𝐷𝐷𝑘𝑘,𝑆𝑆2 − 𝐷𝐷𝑘𝑘,𝐵𝐵�
 (4-11) 

If we consider that the points Dk,B, Dk,S1, and Dk,S2 form a triangle, and that the error above is the 
magnitude (or length) of one side of the triangle compared to the average magnitude of the two 
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remaining sides, it can be shown that the range of values for the error is 0 to 2.  A value of 0 
occurs if the dose solutions Dk,S1 and Dk,S2 are identical, in which case the numerator is 0.  The 
range 0 to 1 seems to be a more natural choice for specifying an allowable error fraction, so the 
error equation was modified slightly by dropping the factor of 2, resulting in Equation (4-12) for 
local error: 

𝑙𝑙𝑒𝑒𝑙𝑙𝑙𝑙𝑙𝑙 𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒 =
�𝐷𝐷𝑘𝑘,𝑆𝑆2 − 𝐷𝐷𝑘𝑘,𝑆𝑆1�

�𝐷𝐷𝑘𝑘,𝑆𝑆1 − 𝐷𝐷𝑘𝑘,𝐵𝐵� + �𝐷𝐷𝑘𝑘,𝑆𝑆2 − 𝐷𝐷𝑘𝑘,𝐵𝐵�
 (4-12) 

To provide an example of how Equation (4-12) works, the error will be calculated for a set of two 
nuclides (I-131 and I-132).  Table 4-1 represents the values for I-131 and I-132 at the base step 
and after solution 1 and solution 2 are calculated. 

Table 4-1 Local error solutions for I-131 and I-132 

Solution Step 
I-131 Dose 

(rem) 
I-132 Dose 

(rem) 
Magnitude 

(I-1312 + I-1322)0.5 

(rem) 

DB (20 h) 0.75 0.00130  

DS1 (24 h) 0.92 0.00153  

DS2 (24 h) 0.90 0.00150  

DS1 – DB 0.17 0.00023 0.17000016 

DS2 – DB 0.15 0.0002 0.15000013 

DS1 – DS2 0.02 0.00003 0.020000002 

Note that the change in the dose value (0.17) over a solution step for I-131 (Dk,S1 ─ Dk,B) is much 
larger than the change in the dose value of 0.00023 for I-132.  This is reflected in the magnitude 
of the dose vector since the value is very close to the I-131 value of 0.17 rem.  In the error 
calculation below the small tail value is dropped.  In general, it is the dose channels with the 
largest change in dose over a time step that dominates the error calculation.  Over this time 
step, the local error is calculated by Equation (4-13). 

𝑙𝑙𝑒𝑒𝑙𝑙𝑙𝑙𝑙𝑙 𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒 =
0.02

(0.17 + 0.15) = 0.0625 (4-13) 

The default threshold for error is 0.001, so the local error exceeds the default threshold by an 
order of magnitude. 

In test simulations it was found that the RADTRAD-AC required very small time steps to limit 
error despite the fact that the rate of dose increase was very small over the first few seconds in 
these cases.  In order to avoid taking an excessive number of time steps over a time period 
when the changes in dose were small, the error is scaled in proportion to how quickly the dose 
is increasing compared to a more global measure of the rate of change in dose. 

An error scaling factor is calculated using the following steps: 
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1. The local rate of change for the dose is characterized by taking the change in dose (rem) 
over the time step (i.e. ‖Dk,S2 ─ Dk,B‖) and dividing this by the time step size Δt.  This 
gives a local rate of change d‖D‖/dt. 

2. Two more global rate of change values are then calculated: 

a. One global estimate of d‖D‖/dt  is calculated by taking a time step of the default 
time step size.  The error may be large for this time step, but the rate of change 
in dose provides a general estimate of how rapidly the dose is expected to 
increase over time steps of the default size.  The calculation is only performed 
over the first 1/10 of the simulation because early on, this is the best estimate 
that can be obtained of the rate of change in dose.  Later in the simulation, the 
calculated dose provides a reasonable estimate. 

b. The value d‖D‖ = ‖Dk,S ─ Dk,B‖ is integrated (i.e. summed over the time steps) 
and divided by the total simulation time DT.  This basically gives a rate at which 
dose would have to increase over the whole simulation to get the current dose 
magnitude. 

3. The scaling factor is calculated by dividing the local rate of change by the maximum of 
the two global rate estimates from step 2.  If the local dose is changing at a very slow 
rate compared to the global measure, then the error is of less concern since the error is 
small in comparison to time when dose is increasing rapidly.  If the scaling factor 
exceeds 1, it is set to 1. 

4. The scaled error is calculated by multiplying the error by the scaling factor.  The scaled 
error can then be used to decide if the time step size needs to be cut, held constant, or 
increased. 

In some cases, it may be desirable to directly control the time step size even if the adaptive time 
step algorithm is used.  This can be done by opening the Property window for the Model 
Options node and then left-clicking on the Custom Editors ( ) icon for the Time Step Table text 
box to open the Editing Time Step Table window as shown in Figure 4-2.  The user can then 
use the Add button to add rows to the table and specify a time step table with the minimum and 
maximum time step size set to the same value as shown in Figure 4-3.  This will override the 
adaptive time step algorithm.  
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Figure 4-2 Property widow for the Model Option node 

 

Figure 4-3 Editing Time Step Table window 

In test cases, it was found that the reported error was always large over the first few time steps.  
To stabilize the simulation, a few time steps are taken at the minimum time step size.  The 
adaptive time step logic is interrupted occasionally over the first 1/10 of the simulation to take a 
step of the default size in order to calculate a scaling factor.  In some cases the error may 
increase as the time step size is decreased due to round off error or due to instability of the 
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numerical algorithm (which can happen if the time step size is too large).  The adaptive time 
step algorithm tracks the error vs. time step size.  If it detects a region where the error increases 
as the time step size decreases, the algorithm just uses a default time step for a few steps and 
returns control to the adaptive time step logic.  In some cases the adaptive time step algorithm 
cuts the time step until the minimum time step size is reached.  The adaptive time stepper will 
count how many steps it remains at the minimum time step size.  If more than a few time steps 
are taken at the minimum time step, a time step of the default size is requested.  This approach 
is used to keep the adaptive time algorithm from performing calculations for long periods at the 
minimum time step size. 

4.3 Radionuclide Release Mechanisms 

A large number of radionuclides in various chemical forms are generated in the fuel as the 
reactor operates.  The nuclides which are generated are categorized into chemical groups in 
order to make the problem more tractable.  Table 4-2 lists the chemical grouping used in 
SNAP/RADTRAD.  Note that the chemical grouping was revised from RADTRAD version 3.03 
because of the addition of the ICRP-38 nuclide set by combining strontium and barium into a 
single group and adding the other chemical elements as Group 9.  Since SNAP/RADTRAD 
treats all nuclides that are in Groups 3 and above as aerosols, there was no internal coding 
changes needed.  A representative nuclide is used to identify each chemical group.  The tenth 
group for non-radioactive aerosols is retained in SNAP/RADTRAD. 

Table 4-2 Chemical element grouping for SNAP/RADTRAD 

Group 
Number Group Name 

RG 1.183 
Chemical 
Grouping 

Additional Nuclides 

1 Noble Gases Kr, Xe H (H-3), Ne, Ar, Rn, N, O 
2 Halogens I Br 
3 Alkali Metals Cs, Rb  
4 Tellurium Group Te, Sb Se 

5 
Barium, Strontium 
(Alkaline Earth 
Metals) 

Sr, Ba Sr, Ba 

6 Noble Metals Ru, Rh, Mo, 
Tc, Co Pd 

7 Cerium Group Ce, Pu, Np  

8 Lanthanides 
La, Zr, Nd, 
Nb, Pr, Y, Cm, 
Am 

Eu, Pm, Sm 

9 Others  

Ac, Ag, Al, As, At, Au, Be, Bi, Bk, C, Ca, Cd, 
Cf, Cl, Cr, Cu, Dy, Er, Es, F, Fe, Fm, Fr, Ga, 
Gd, Ge, Hf, Hg, Ho, In, Ir, K, Lu, Md, Mg, Mn, 
Na, Ni, Os, P, Pa, Pb, Po, Pt, Ra, Re, S, Sc, 
Si, Sn, Ta, Tb, Th, Ti, Tl, Tm, U, V, W, Yb, Zn 

10 Non-Radioactive 
Aerosols No change F, Cl a 

a.  F and Cl (halogens) are included in Group 10 since they likely do not behave like iodine. 
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The iodine group is further subdivided into three physical forms, which are elemental, organic 
and aerosols.  The fraction of each form depends on the source term model used.  The 
radionuclide inventory for the fuel for all radionuclides of interest in dose analysis on a per Mwt 
basis for PWR and BWR plants is included in SNAP/RADTRAD. 

Two models available in SNAP/RADTRAD in which to model the release from the fuel are the 
TID-14844 model and the NUREG-1465 model.  The TID-14844 model, which is generally 
applied to LOCA analysis, is based on the assumption that 100 percent of the noble gas 
radionuclides and 50 percent of the iodine radionuclides are available for release to the 
containment.  The iodine release is reduced by a factor of 2 to account for deposition within the 
containment so that 25 percent of the iodine remains airborne in the containment based on the 
assumptions in Regulatory Guide 1.3 (RG 1.3), Revision 2, “Assumptions used for Evaluating 
the Potential Radiological Consequences of a Loss of Coolant Accidents for Boiling Water 
Reactors,” [15] and Regulatory Guide 1.4 (RG 1.4), Revision 2, “Assumptions used for 
evaluating the Potential Radiological Consequences of a Loss of Coolant Accidents for 
Pressurized Water Reactors” [16].  No adjustment is made for the noble gases since 
radionuclides in this group are inert.  The release is assumed to be instantaneous (a puff 
release) and is assumed to occur at the beginning of the accident (t=0).  The fractions for the 
physical form of iodine used in the TID-14844 model are: elemental – 0.91, organic – 0.04, and 
aerosol – 0.05. 

An alternative release model was developed in NUREG-1465 for LOCA analysis that 
considered the results of severe accident research conducted by the NRC.  In this model, the 
release from the fuel is subdivided into the Gap release and the Early In-vessel release.  
Radionuclides that have accumulated in the gap between the fuel pellet and the cladding that is 
released when cladding failure commences is the Gap release.  The Early In-vessel release 
occurs as fuel rod temperatures increase driving the volatile nuclides, such as iodine from the 
fuel pellet into the vessel through the failed cladding.  The release fractions for the Gap and 
Early In-vessel releases are summarized below: 

• Noble gases – 0.05 for the Gap release and 0.95 for the Early In-vessel releases. 

• Iodine – 0.05 for the Gap release for both PWR and BWR.  For Early In-vessel, the 
iodine release fraction is 0.35 for PWR and 0.25 for BWR. 

• Cesium – 0.05 for the Gap release for both PWR and BWR.  For Early In-vessel, the 
cesium release fraction is 0.25 for PWR and 0.2 for BWR. 

• Remaining groups – 0.05 and less. 

The fractions for the physical form of iodine used in the NUREG-1465 model are: elemental – 
0.0485, organic – 0.0015, and aerosol – 0.95. 

Release phase duration is considered in NUREG-1465 in contrast to the instantaneous release 
model used in TID-14844.  The release phase durations from Table 3-6 of NUREG-1465 are 
listed in Table 4-3.  Additionally, the radionuclides for each phase are assumed to be uniformly 
released over the time period corresponding to that phase.  
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Table 4-3 Release phase durations for PWRs and BWRs 

Release Phase 
Duration (h) 

PWR BWR 

Gap 0.5 0.5 

Early In-Vessel 1.3 1.5 

Note that Gap release fraction models are available in SNAP/RADTRAD.  The two models 
which are available are based on Table 3 of RG 1.183 and Regulatory Guide 1.25 (RG 1.25), 
“Assumptions Used for Evaluating the Potential Radiological Consequences of a Fuel Handling 
Accident in the Fuel Handling and Storage Facility for Boiling and Pressurized Water Reactors,” 
[17].  The Gap release fractions used are listed in Table 4-4. 

Table 4-4 Gap release fractions used in SNAP/RADTRAD 

Radionuclide RG 1.25 RG 1.183 

I-131 0.12 a 0.08 

Kr-85 0.3 0.1 

Other Noble Gases 0.1 0.05 

Other Iodines 0.1 0.05 

Alkali Metals 0.0 0.12 
a.  The value in RG 1.25 is 0.1 and this value was increased by 20 percent to account for 

the use of extended burnup fuel, per NUREG/CR-5009, “Assessment of the Use of 
Extended Burnup Fuel in Light Water Power Reactors,” [18]. 

The FHA also requires several other input parameters including the number of fuel rods or 
assemblies in the core, the number of fuel rods or assemblies damaged, the fraction of fuel rods 
or assemblies damaged, the radial peaking factor for the damaged assemblies, the pool iodine 
DF and the decay period.  The pool iodine DF is set to a default value of 200 which is from 
Appendix B of RG 1.183 for water pool depths of 23 feet or greater and the decay time, 
essentially the time since plant shutdown.  Note that the decay calculation carried out by the 
SNAP/RADTRAD Model Editor input for the fuel handling accident does not include 
contributions from daughter products. 

4.4 Reactor Coolant System Activity Calculations 

Models for specifying the release during a FHA, a REA, and CRDA have also been incorporated 
into SNAP/RADTRAD.  The models generally follow those specified in RG 1.183.  For the FHA, 
the user-selectable Gap release fractions are based on either RG 1.25 or RG 1.183 as listed in 
Table 4-4.  In addition, relevant plant parameters (number of rods or assemblies in the core, 
number of rods or assemblies damaged, fraction of fuel rods or assemblies damaged, radial 
peaking factor, pool iodine DF, and decay period) for modeling a FHA can be specified by the 
user.  Similarly, for the REA-CRDA, a release model based on RG 1.183 is available in 
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SNAP/RADTRAD.  The release fractions used are listed in Table 4-5.  Also, the relevant plant 
parameters for cladding breach, fuel melt fraction and radial peaking factor can be set by the 
user in SNAP/RADTRAD. 

Table 4-5 SNAP/RADTRAD release fractions to RCS for an REA-CRDA accident 

Radionuclide Gap Release Melt Release 

Noble Gas 0.1 1.0 

Iodine 0.1 0.5 

Alkali Metals 0.0 0.0 

It should be noted that the release assumptions used in SNAP/RADTRAD can be confirmed 
through the SNAP Model Editor by defining a source, then reviewing the nuclide definitions for 
that source.  This approach is better because the user can confirm the values actually used in 
the SNAP/RADTRAD calculations.  The ability to calculate the RCS activity, consider 
equilibrium activities based on DE I-131 and DE Xe-133 and iodine spiking has been 
incorporated into SNAP/RADTRAD. 

The RCS activity calculator, described in Section 3.4.2, determines the RCS concentrations 
using formulations based on the NUREG-0017, Revision 1, “Calculation of Releases of 
Radioactive Materials in Gaseous and Liquid Effluents from Pressurized Water Reactors (PWR-
GALE Code),” [19], NUREG-0016, Revision 1, “Calculation of Releases of Radioactive Materials 
in Gaseous and Liquid Effluents from Boiling Water Reactors (BWR-GALE Code),” [20], and the 
ANSI/ANS-18.1-1999, “Radioactive Source Term for Normal Operation of Light Water 
Reactors,” [21].  The formulations used are basically correlations correcting for plant-to-plant 
variations in power, system fluid and steam mass and flow rates and other plant-specific 
parameters applied to a reference PWR or BWR plant.  The RCS activity calculations performed 
in SNAP/RADTRAD are similar to, but basically a subset of those performed by the PWR and 
BWR Gale codes. 

Table 4-6 presents the formulae used by the SNAP/RADTRAD RCS activity calculator for the 
reference PWR plant to calculate coolant concentration adjustment factors for the radionuclide 
concentration in the RCS.  Note that these formulations are applicable to plants with U-tube 
steam generators.  The adjustment factors presented in Table 4-6 are multiplied by the 
reference PWR radionuclide concentrations given in Table 4-7 to obtain the RCS concentration 
(μCi/g).  
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Table 4-6 Formulations used to determine RCS water radionuclide concentrations in 
PWRs with U-tube steam generators 

Element Class Adjustment Factor Formula a 

Noble Gases = �
162 ∙ 𝑃𝑃

𝑊𝑊𝑃𝑃
� ∙ �

0.0009 + 𝜆𝜆
𝑅𝑅 + 𝜆𝜆

� 

Halogens = �
162 ∙ 𝑃𝑃

𝑊𝑊𝑃𝑃
� ∙ �

0.067 + 𝜆𝜆
𝑅𝑅 + 𝜆𝜆

� 

Cs, Rb = �
162 ∙ 𝑃𝑃

𝑊𝑊𝑃𝑃
� ∙ �

0.037 + 𝜆𝜆
𝑅𝑅 + 𝜆𝜆

� 

where: 
 R = the removal rate - reactor coolant 1/h 
 λ = the radionuclide decay constant in 1/h 
 P = the core power in Mwt 
 WP = the mass of reactor coolant system water lbm 

Formulas for the removal rate (R) are presented below b 

Noble Gases 𝑅𝑅 =
𝐷𝐷𝐹𝐹 + (𝐷𝐷𝐷𝐷 − 𝐷𝐷𝐹𝐹) ∙ 𝑌𝑌

𝑊𝑊𝑃𝑃
 

Halogens & Cs, Rb 𝑅𝑅 =
𝐷𝐷𝐷𝐷 ∙ 𝑁𝑁𝐹𝐹 + (1 − 𝑁𝑁𝐹𝐹) ∙ (𝐷𝐷𝐹𝐹 + 𝐷𝐷𝐹𝐹 ∙ 𝑁𝑁𝐹𝐹)

𝑊𝑊𝑃𝑃
 

where: 
 FD = the removal rate in the reactor coolant in 1/h 
 NB = the fraction of material removed in passing through the purification 

demineralizer 
 FB = the reactor coolant letdown flow in 1/h 
 FA = the flow through the purification system cation demineralizer 
 NA = the fraction of material removed in passing through the cation 

demineralizer 
 Y = the ratio of the total amount of noble gases routed to gaseous 

radwaste from the purification system to the total amount routed 
from the primary coolant system (not including the boron recovery 
system) 

a. The adjustment factor formula is from Table 2-7 of reference [19]. 
b. The formulas for the removal rates (R) are from Table 2-6 of reference [19] and Table 9 of 

reference [21].  The values for the constants are from a reference PWR described in Table 2-4 of 
reference [19] and Table 2 of reference [21].  The PWR-GALE code calculates the removal rates 
(R) for these nuclides for PWRs other than the reference PWR plant described in Table 2-4 of 
reference [19] and Table 2 of reference [21]. 
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Table 4-7 RCS radionuclide concentrations for a reference PWR plant 

Radionuclide Concentration 
(µCi/g) a Radionuclide Concentration 

(µCi/g) a 

Kr-83m b 0.0E+00 I-131 2.0E-03 

Kr-85 4.3E-01 I-132 6.0E-02 

Kr-85m 1.6E-02 I-133 2.6E-02 

Kr-87 1.7E-02 I-134 1.0E-01 

Kr-88 1.8E-02 I-135 5.5E-02 
 

Xe-131m 7.3E-01 Cs-134 3.7E-05 

Xe-133 2.9E-02 Cs-136 8.7E-04 

Xe-133m 7.0E-02 Cs-137 5.3E-05 

Xe-135 6.7E-02 Rb-86 b 0.0E+00 

Xe-135m 1.3E-01   

Xe-138 6.1E-02   

a. The radionuclide concentrations are from Table 6 of reference [21]. 
b. The radionuclide concentration is not from Table 6 of reference [21]. 

Table 4-8 presents the formulae used by the SNAP/RADTRAD RCS activity calculator for the 
reference BWR plant to calculate coolant concentration adjustment factors for the radionuclide 
concentration in the RCS water and steam.  The adjustment factors presented in Table 4-8 are 
multiplied by the reference BWR radionuclide concentrations given in Table 4-9 to obtain the 
RCS concentration (μCi/g) for either the RCS water or steam.  
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Table 4-8 Formulations used to determine RCS water radionuclide concentrations in 
BWRs 

Element Class Adjustment Factor Formula 

Noble Gases a 1.0 

Halogens = �
112 ∙ 𝑃𝑃

𝑊𝑊𝑃𝑃
� ∙ �

1.01 + 𝜆𝜆
𝑅𝑅 + 𝜆𝜆

� 

Cs, Rb = �
112 ∙ 𝑃𝑃

𝑊𝑊𝑃𝑃
� ∙ �

0.19 + 𝜆𝜆
𝑅𝑅 + 𝜆𝜆

� 

where: 
 R = the removal rate - reactor coolant 1/h 
 λ = the radionuclide decay constant in 1/h 
 P = the core power in Mwt 
 WP = the mass of RCS water lbm 

Formulas for the removal rate (R) are presented below b 

Noble Gases 1.0 

Halogens & Cs, Rb 𝑅𝑅 =
𝐷𝐷𝐹𝐹 ∙ 𝑁𝑁𝐹𝐹 + 𝑁𝑁𝑁𝑁 ∙ 𝐷𝐷𝐹𝐹 ∙ 𝑁𝑁𝐹𝐹 ∙ 𝑁𝑁𝐹𝐹

𝑊𝑊𝑃𝑃
 

where: 
 FA = the water cleanup demineralizer flow rate in lb/h 
 NA = the reactor water cleanup demineralizer DFs 
 NC = the ratio of condensate demineralizer flow rate to steam flow rate 
 FS = the steam flow rate in lb/h 
 NS = the ratio of radionuclide concentration in reactor steam to the 

concentration in reactor water 
 NB = the condensate demineralizer DF 

a. The adjustment factor formulas are from Table 2-5 of reference [20] and Table 10 of reference 
[21]. 

b. The formulas for the removal rates (R) are from Table 2-4 of reference [20] and Table 8 of 
reference [21].  The values for the constants are from a reference BWR described in Table 2-3 of 
reference [20] and Table 1 of reference [21].  The BWR-GALE code calculates the removal rates 
(R) for these nuclides for BWRs other than the reference BWR plant described in Table 2-3 of 
reference [20] and Table 1 of reference [21]. 
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Table 4-9 RCS radionuclide concentrations for a reference BWR plant 

Radionuclide 
Liquid 

Concentration 
(µCi/g) a 

Steam 
Concentration 

(µCi/g) a 
Radionuclide 

Liquid 
Concentration 

(µCi/g) a 

Steam 
Concentration 

(µCi/g) a 

Kr-83m 0.0E+00 5.9E-04 I-131 2.2E-03 4.4E-05 

Kr-85 0.0E+00 4.0E-06 I-132 2.2E-02 4.4E-04 

Kr-85m 0.0E+00 1.0E-03 I-133 1.5E-02 3.0E-04 

Kr-87 0.0E+00 3.3E-03 I-134 4.3E-02 8.6E-04 

Kr-88 0.0E+00 3.3E-03 I-135 2.2E-02 4.4E-04 
 

Xe-131m 0.0E+00 3.3E-06 Cs-134 3.0E-05 3.0E-08 

Xe-133 0.0E+00 1.4E-03 Cs-136 2.0E-05 2.0E-08 

Xe-133m 0.0E+00 4.9E-05 Cs-137 8.0E-05 8.0E-08 

Xe-135 0.0E+00 3.8E-03 Rb-86 b 0.0E+00 0.0E+00 

Xe-135m 0.0E+00 4.4E-03    

Xe-138 0.0E+00 1.5E-02    

a. The radionuclide concentrations are from Table 5 of reference [21]. 
b. The radionuclide concentration is not from Table 5 of reference [21]. 

T/S equilibrium activity based on DE I-131 and DE Xe-133 are determined from the DCFs and 
the RCS concentration.  Equations (4-14) and (4-15) show the formulation used 

𝐷𝐷𝐷𝐷 𝐼𝐼 131 =
∑ 𝑁𝑁𝑖𝑖 𝑖𝑖 ∙ 𝐷𝐷𝑁𝑁𝐷𝐷𝑖𝑖

𝐷𝐷𝑁𝑁𝐷𝐷𝐼𝐼 131
 (4-14) 

𝐷𝐷𝐷𝐷 𝑋𝑋𝑒𝑒 133 =
∑ 𝑁𝑁𝑖𝑖 𝑖𝑖 ∙ 𝐷𝐷𝑁𝑁𝐷𝐷𝑖𝑖

𝐷𝐷𝑁𝑁𝐷𝐷𝑋𝑋𝑑𝑑 133
 (4-15) 

where: 

 DCFi = the DCF for each iodine or xenon nuclide.  [The thyroid DCF (Sieverts 
(Sv)/Bq) is used for iodine nuclides and the whole body DCF (Sv-m3/Bq-s) 
is used for xenon nuclides.] 

 DCFI 131 = the I-131 thyroid DCF (Sv/Bq) 
 DCFXe 133 = the Xe-133 whole body DCF (Sv-m3/Bq-s) 
 Ci = the i-th radionuclide concentration in μCi/g. 

The actual equilibrium factor is calculated from the user-specified value of DE I-131 (typically 1 
μCi/g) divided by DE I-131.  This factor is multiplied by the RCS activity to obtain the equilibrium 
activity based on DE I-131.  The approach is the same for Xe-133 except that Xe-133 factors 
are applied.  The calculation is performed separately for liquid and steam in BWRs. 
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The pre-incident spike activity is computed from the user-specified spike activity (typically 60 
μCi/g) divided by DE I-131 and then multiplied by the RCS activity.  The calculation is performed 
separately for liquid and steam in BWRs. 

Co-incident spiking is somewhat more complicated as the iodine appearance rate must be 
determined.  The appearance factor in units of Ci/h is computed as shown in Equation (4-16) 

𝐹𝐹𝐷𝐷 = �𝑀𝑀𝑀𝑀𝐷𝐷 ∙
1 − 1 𝐷𝐷𝐷𝐷⁄

𝑊𝑊𝑃𝑃
+

𝑀𝑀𝑅𝑅𝑁𝑁𝐹𝐹
𝑊𝑊𝑃𝑃 � ∙ 𝐹𝐹𝑆𝑆𝑀𝑀 ∙ �

3600
1𝐷𝐷6

� ∙ 𝑊𝑊𝑃𝑃 ∙ 𝐷𝐷𝐷𝐷𝐼𝐼 (4-16) 

where: 

 MLD = the normal letdown flow rate in gpm (converted to g/s in above equation) 
 DF = the mixed bed demineralizer DF 
 WP = the mass of RCS T/S leakage rate in gpm (converted to g/s in above 

equation) 
 λ = the decay constant in 1/s 
 SpM = the iodine spike multiplier 
 EFI = the equilibrium factor for iodine in μCi/g. 

The total iodine appearance for co-incident spiking is computed by multiplying the appearance 
rate by the spike duration in hours to obtain the total iodine appearance.  The iodine 
appearance is added to the equilibrium activity to obtain the total RCS activity for iodine.  Note 
that co-incident spiking only applies to PWRs. 

One item that should be noted is that there are several formulations for the calculation of the 
RCS inventory, including ANSI/ANS-18.1-1999, the PWR-GALE Code and the BWR-GALE 
Code.  The current status of ANSI/ANS-18.1-1999 is that it has been administratively withdrawn 
because it was neither reaffirmed nor updated during a 10 year period.  The American Nuclear 
Society has formed a Working Group in calendar year 2014 and are now updating ANSI/ANS-
18.1-1999. 

4.5 Removal Models 

Models for radionuclide removal from the compartment atmosphere including sprays, natural 
deposition, leakage, and filters are included in SNAP/RADTRAD.  The removal coefficients for 
the various removal mechanisms are equivalent.  For example, filtration is expressed in terms of 
efficiencies, and natural deposition in terms of removal coefficients.  These are related to each 
other as well as to DFs.  The DF is defined as the ratio of the total material (aerosol or 
elemental iodine) subjected to a removal process to the total aerosol material that remains 
airborne.  Equation (4-17) shows the relationship between the DF and the removal coefficient, λ. 

𝑑𝑑𝐷𝐷𝐷𝐷
𝑑𝑑𝑑𝑑

= 𝜆𝜆𝐷𝐷𝐷𝐷 (4-17) 

The average DF is related to the mass fraction, mf, remaining in the volume as shown in 
Equation (4-18). 

𝑚𝑚𝑓𝑓 =
𝑀𝑀(𝑑𝑑)
𝑀𝑀(0) =

1
𝐷𝐷𝐷𝐷

= 𝑒𝑒−(𝜆𝜆𝑓𝑓) (4-18) 

where: 
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 𝑀𝑀(𝑑𝑑) = the mass of aerosol as a function of time (t) in a compartment 
 𝑀𝑀(0) = the total mass subjected to removal in a compartment. 

The DF is also related to the removal efficiency, η, as shown in Equation (4-19). 

𝐷𝐷𝐷𝐷 =
1

1 − 𝜂𝜂
 (4-19) 

4.5.1 Spray Removal Model 

The spray removal mechanism in SNAP/RADTRAD can be modeled using either the Powers’ 
model, as described in NUREG/CR-5966, for aerosol removal or through the specification of 
user-defined removal coefficients.  As the Powers’ model is only applicable to aerosols, the 
SNAP/RADTRAD user will still need to specify removal coefficients for elemental and organic 
iodine. 

The extent to which sprays will decontaminate an aerosol-laden atmosphere depends on the 
number of spray droplets falling through the atmosphere and the distance they fall.  The water 
flux into the containment atmosphere is time dependent and the fall distance is dependent upon 
the containment design.  The Powers’ model is based on a correlation that determines the 
removal coefficient for an aerosol considering the spray water flux, Q (m3∙H2O/m2∙s) and the fall 
height of the spray droplets H (m) and considers uncertainty in the various parameters affecting 
spray removal.  Since the model was developed from an uncertainty study, the user specifies a 
percentile.  The “best estimate” value is associated with the 50th percentile, or median values; 
the lower bound is associated with the 10th percentile; and the reasonable upper bound, or 
largest DF, with the 90th percentile.  The model was developed using values of 0.001, 0.1 and 
0.25 cm3 H2O/cm2 s for the spray water flux, Q, and fall heights of 500, 853, 1000, 1584, 2000, 
3000, 4000, and 5000 cm.  The aerosol removal coefficient is dependent on the fraction of the 
aerosol suspended in the atmosphere, mf, which is defined as the aerosol mass in the 
atmosphere of a compartment at a given time, t, divided by the total aerosol mass released into 
the compartment atmosphere until this time.  The model includes the effect of the unsprayed 
portions of the containment by incorporating the assumption that the circulation in the 
compartment is rapid compared with the removal rate.  Equation (4-20) specifies the aerosol 
removal coefficient (𝜆𝜆𝑗𝑗,𝑠𝑠𝑠𝑠𝑠𝑠

𝑖𝑖 ) at any time in units of 1/s. 

𝜆𝜆𝑗𝑗,𝑠𝑠𝑠𝑠𝑠𝑠
𝑖𝑖 =

1
3600 (1 − 𝛼𝛼)

(𝑙𝑙 − 𝑏𝑏 𝑙𝑙𝑒𝑒𝑔𝑔10 𝑄𝑄) ��1 −
𝑚𝑚𝑓𝑓

0.9�
𝑑𝑑

+  �
𝑚𝑚𝑓𝑓

0.9�
𝑑𝑑
� 
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  ×  [exp (𝐹𝐹 + 𝐹𝐹 ln 𝑄𝑄 + 𝑁𝑁 𝐻𝐻 + 𝐷𝐷 𝑄𝑄2𝐻𝐻 + 𝐷𝐷 𝑄𝑄 𝐻𝐻2 + 𝐷𝐷 𝑄𝑄 + 𝐺𝐺 𝑄𝑄2𝐻𝐻2)] 

The values for the constants A, B, C, D, E, F, G, a, b, and c in Table 4-10 are from Section 7 of 
NUREG/CR-5966.  The parameter α is the ratio of the compartment volume not exposed to 
sprays to the compartment volume exposed to sprays (unsprayed volume/sprayed volume).  If 
the assumption that the circulation is rapid compared with the removal rate is not valid, then the 
user can split the compartment into two separate compartments and model the flow from the 
unsprayed portions to the sprayed portions as a convective flow.  In this case α would be zero 
for the compartment containing the sprays.  
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Table 4-10 Values for coefficients used in the Powers’ spray removal model 

Constant 
Value 

10th Percentile 50th Percentile 90th Percentile 
A 5.5750 6.83707 7.10927 
B 0.94362 1.0074 0.92549 
C 0.0 -2.4045E-05 0.0 
D -6.9821E-03 -4.1731E-03 -8.0868E-04 

E -7.327E-07 9.006E-08 0.0 
F 0.0 -1.2478 0.0 
G 3.555E-06 0.0 0.0 
a 0.1108 0.1815 0.3751 
b -0.00201 -0.01153 0.00648 
c 0.8945 0.5843 0.2786 

This expression was originally developed for a puff release of aerosols into a system.  In those 
cases where there is a continuing release, the size distribution will continually be renewed by 
the injected particulate.  The model has been extended for this case by setting coefficients A 
through G to zero.  This makes the model assume that the size distribution has not changed in 
time and that most of the material suspended is fresh material provided by the source.  The 
aerosols removed by the sprays are collected in the sump. 

4.5.2 Natural Deposition Model 

Natural deposition in SNAP/RADTRAD can be modeled using either Henry’s correlation or 
Powers’ model for aerosol removal due to natural deposition or through the specification of 
user-defined removal coefficients.  As Henry’s correlation and Powers’ model are only 
applicable to aerosols, the SNAP/RADTRAD user will still need to specify removal coefficients 
for elemental iodine. 

4.5.2.1 Henry’s Correlation 

The correlation developed by Henry, described in reference [22], is based upon observation of 
experiments concerned with aerosol decontamination.  The form of Equation (4-21) is based 
upon the consideration that sedimentation was the dominant phenomenon observed, and the 
coefficients were determined from experimental data from liquid metal reactor tests. 

𝜆𝜆 = 𝑁𝑁1 �
ℎ𝑠𝑠𝑑𝑑𝑓𝑓

ℎ � �
𝜌𝜌𝑃𝑃

𝜌𝜌𝑃𝑃 𝑠𝑠𝑑𝑑𝑓𝑓
� (𝜌𝜌𝐴𝐴)𝐾𝐾 (4-21) 

where: 

 ℎ𝑠𝑠𝑑𝑑𝑓𝑓 = 5.0 m, as determined from the ABCOVE test AB5 
 ℎ = the user-provided fall height in m 
 𝜌𝜌𝑃𝑃 = the user-provided particle density in kg/m3 
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 𝜌𝜌𝑃𝑃 𝑠𝑠𝑑𝑑𝑓𝑓 = the theoretical sodium oxide particle density of 2270 kg/m, as determined 
from the ABCOVE test AB5 

 𝜌𝜌𝐴𝐴  = the aerosol mass in the volume. 

The coefficients that best fit the data are: 

where: 

 𝜌𝜌𝐴𝐴  ≥ 6.0E − 05 𝑘𝑘𝑔𝑔
𝑚𝑚3�  then 𝑁𝑁1 = 0.0220  and 𝑘𝑘 = 0.60 

 𝜌𝜌𝐴𝐴  < 6.0E − 05 𝑘𝑘𝑔𝑔
𝑚𝑚3�  then 𝑁𝑁1 = 0.0016  and 𝑘𝑘 = 0.33. 

Henry’s correlation input can be modified to account for the influence of aerosol shape and 
moisture on the particle density by using Equation (4-22) 

𝜌𝜌𝑃𝑃 = 𝛼𝛼𝜌𝜌𝑇𝑇 + (1 − 𝛼𝛼)𝜌𝜌𝑤𝑤 (4-22) 
where: 

 𝛼𝛼 = the ratio of the effective aerosol particle density to theoretical density 
 𝜌𝜌𝑇𝑇 = the theoretical density in kg/m3 
 𝜌𝜌𝑤𝑤 = the density of water in kg/m3. 

In many cases the aerosol has only 20 percent of its theoretical density, so that in a high steam 
environment its effective density would be closer to that of water.  This correlation is 
implemented in SNAP/RADTRAD. 

4.5.2.2 Powers’ Model 

The Powers’ model for aerosol removal due to natural deposition, in NUREG/CR-6604, is based 
on the observation of a self-preserving aerosol size distribution as a key component in 
predicting aerosol behavior.  Powers included the effects due to turbulence and to the multiple 
aerosol releases specified in NUREG-1465.  The modified model was then compared with a 
series of CONTAIN computer code cases to verify the aging and aerosol size distributions due 
to the multiple sources.  To account for the uncertainties, a large number of calculations were 
performed with the modified mechanistic model, with specific values for the type of reactor 
containment, reactor power, and the source term release phase, while varying the values of the 
uncertainty parameters.  Typical uncertainty parameters were the containment pressure during 
the various release phases, the floor and wall surface areas, the zirconium inventory, the ratio of 
containment volume to thermal power, and the properties of the concrete.  In all, over 20 
parameters that were related to the phenomena were varied.  Equation (4-23) shows the 
governing equation used in Powers’ model 

𝑑𝑑𝐷𝐷𝐷𝐷𝑖𝑖(𝑑𝑑)
𝑑𝑑𝑑𝑑

= 𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠,𝐼𝐼(𝑃𝑃𝑓𝑓ℎ, 𝑑𝑑)𝐷𝐷𝐷𝐷𝑖𝑖(𝑑𝑑) (4-23) 

where: 

 𝐷𝐷𝐷𝐷𝑖𝑖(𝑑𝑑) = the DF for the ith class of radioactive aerosol at time t where i indicates 
the phase at which the material was released into the containment: 
during the Gap or Early In-vessel phases 
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 𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠,𝐼𝐼(𝑃𝑃𝑓𝑓ℎ, 𝑑𝑑) = the decontamination coefficient at time t and power Pth for phase I 
 𝑃𝑃𝑓𝑓ℎ = the thermal power of the reactor. 

The decontamination coefficient should be weighted by each chemical group release rate as 
was done by Powers.  However, SNAP/RADTRAD does not maintain the necessary weighting 
factors; hence a single chemical release rate based on iodine was used for the weighting 
coefficients. 

The decontamination coefficient, λ, was solved over the various release time intervals and for 
the different types of reactors and various operating power levels using a Monte-Carlo 
uncertainty analysis.  The results of these analyses are tabulated in Tables 4-11 and 4-12, for 
PWRs and BWRs, and are presented in terms of percentile DFs, λdep(N%,Pth).  Since the model 
was developed from an uncertainty study, the user specifies a percentile, N%.  The best 
estimate value is associated with the 50th percentile, or median values; the lower bound is 
associated with the 10th percentile; and the reasonable upper bound, or largest DF, with the 90th 
percentile. 

Table 4-11 Correlations of natural deposition decontamination coefficients for PWRs 
DBAs 

Release Phase Time Interval (s) Correlations (h-1) 

Gap 0 – 1800 
(0 – 0.5 h) 

λdep (90) = 0.0365 + 3.580E-06 P(Mwt) 
λdep (50) = 0.0268 + 3.475E-06 P(Mwt) 
λdep (10) = 0.0182 + 3.260E-06 P(Mwt) 

Gap 1800 – 6480 
(0.5 – 2.0 h) 

λdep (90) = 0.1036 [1 - exp (-2.239 P(Mwt)/1000)] 
λdep (50) = 0.0820 [1 - exp (-1.159 P(Mwt)/1000)] 
λdep (10) = 0.0645 [1 - exp (-0.938 P(Mwt)/1000)] 

Early 
In-Vessel 

1800 – 6480 
(0.5 – 1.8 h) 

λdep (90) = 0.0522 [1 - exp (-2.458 P(Mwt)/1000)] 
λdep (50) = 0.0417 [1 - exp (-1.258 P(Mwt)/1000)] 
λdep (10) = 0.0326 [1 - exp (-0.910 P(Mwt)/1000)] 

Gap + Early 
In-Vessel 

6480 – 13,680 
(1.8 – 3.8 h) 

λdep (90) = 0.421 [1 - exp (-2.530 P(Mwt)/1000)] 
λdep (50) = 0.196 [1 - exp (-1.040 P(Mwt)/1000)] 
λdep (10) = 0.094 [I - exp (-0.869 P(Mwt)/1000)] 

Gap + Early 
In-Vessel 

13,680 – 49,680 
(3.8 – 13.8 h) 

λdep (90) = 0.1920 - 1.35E-06 P(Mwt) 
λdep (50) = 0.1382 + 6.85E-06 P(Mwt) 
λdep (10) = 0.0811 + 10.15E-06 P(Mwt) 

Gap + Early 
In-Vessel 

49,680 – 80,000 
(13.8 – 22.22 h) 

λdep (90) = 0.1010 
λdep (50) = 0.0912 
λdep (10) = 0.0860 [1 - exp (-2.384 P(Mwt)/1000)] 
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Table 4-12 Correlations of natural deposition decontamination coefficients for BWRs 
DBAs 

Release Phase Time Interval (s) Correlations (h-1) 

Gap 0 – 1800 
(0 – 0.5 h) 

λdep (90) = 2.903 [exp(-1060/P(Mwt)] 
λdep (50) = 2.252 [exp(-1977/P(Mwt)] 
λdep (10) = 1.285 [exp(-2199/P(Mwt)] 

Gap 1800 – 7200 
(0.5 – 2.0 h) 

λdep (90) = 1.809 [exp(-777/P(Mwt)] 
λdep (50) = 1.722 [exp(-1777/P(Mwt)] 
λdep (10) = 1.161 [exp(-2274/P(Mwt)] 

Early 
In-Vessel 

1800 – 7200 
(0.5 – 2.0 h) 

λdep (90) = 0.746 [exp(-626/P(Mwt)] 
λdep (50) = 0.752 [exp(-1565/P(Mwt)] 
λdep (10) = 0.520 [exp(-2173/P(Mwt)] 

Gap + Early 
In-Vessel 

7200 – 18,000 
(2.0 – 5.0 h) 

λdep (90) = 1.959 [exp(-548/P(Mwt)] 
λdep (50) = 1.811 [exp(-1107/P(Mwt)] 
λdep (10) = 1.551 [exp(-1507/P(Mwt)] 

Gap + Early 
In-Vessel 

18,000 – 30,000 
(5.0 – 8.33 h) 

λdep (90) = 1.533 [exp(-573/P(Mwt)] 
λdep (50) = 1.317 [exp(-1225/P(Mwt)] 
λdep (10) = 0.836 [exp(-1051/P(Mwt)] 

Gap + Early 
In-Vessel 

30,000 – 43,200 
(8.33 – 12.0 h) 

λdep (90) = 1.524 [exp(-647/P(Mwt)] 
λdep (50) = 1.339 [exp(-1474/P(Mwt)] 
λdep (10) = 0.780 [exp(-1316/P(Mwt)] 

Gap + Early 
In-Vessel 

43,200 – 70,000 
(12.0 – 19.4 h) 

λdep (90) = 1.564 [exp(-717/P(Mwt)] 
λdep (50) = 1.373 [exp(-1634/P(Mwt)] 
λdep (10) = 0.778 [exp(-1548/P(Mwt)] 

Gap + Early 
In-Vessel 

70,000 – 86,400 
(19.4 – 24.0 h) 

λdep (90) = 1.562 [exp(-719/P(Mwt)] 
λdep (50) = 1.441 [exp(-1785/P(Mwt)] 
λdep (10) = 0.780 [exp(-1686/P(Mwt)] 

Equations (4-24), (4-25) and (4-26) determine the current decontamination coefficient, λnet, from 
the sum of the coefficients for each phase weighted by the iodine release rate, SI2,I, for phase I. 

𝜆𝜆𝑛𝑛𝑑𝑑𝑓𝑓 =
ln{[𝐷𝐷𝐷𝐷(𝑑𝑑 + ∆𝑑𝑑) 𝐷𝐷𝐷𝐷(𝑑𝑑)⁄ ]}

∆𝑑𝑑
 (4-24) 

where: 

 

(4-25) 
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𝐷𝐷𝐷𝐷𝐼𝐼 = � exp�𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠,𝐼𝐼(𝑁𝑁%, 𝑃𝑃𝑓𝑓ℎ)𝑑𝑑�
4

𝐼𝐼=1

 (4-26) 

Table 4-13 also provides the decontamination coefficients for a DBA in an advanced 
pressurized-water reactor (APWR) design.  These values are based upon work by Powers, 
which found that the CONTAIN-related calculation results were correlated with values in the 
table.  These correlations do not vary with reactor thermal power; hence an approximation is 
used when the user selects a PWR design with a different power level. 

Table 4-13 Correlations of natural deposition decontamination coefficients for APWR 
DBAs 

Release Phase Time Interval (s) Correlations (h-1) 

Gap 0 – 1800 
(0 – 0.5 h) 

λdep (90) = 0.466 
λdep (50) = 0.233 
λdep (10) = 0.029 

Gap 1800 – 6480 
(0.5 – 1.8 h) 

λdep (90) = 0.872 
λdep (50) = 0.487 
λdep (10) = 0.160 

Early 
In-Vessel 

1800 – 6480 
(0.5 – 1.8 h) 

λdep (90) = 0.393 
λdep (50) = 0.240 
λdep (10) = 0.100 

Gap + Early 
In-Vessel 

6480 – 13,680 
(1.8 – 3.8 h) 

λdep (90) = 1.210 
λdep (50) = 0.980 
λdep (10) = 0.731 

Gap + Early 
In-Vessel 

13,680 – 49,680 
(3.8 – 13.8 h) 

λdep (90) = 0.594 
λdep (50) = 0.397 
λdep (10) = 0.245 

Gap + Early 
In-Vessel 

49,680 – 86,400 
(13.8 – 24.0 h) 

λdep (90) = 0.598 
λdep (50) = 0.327 
λdep (10) = 0.107 

The approximation used assumes that the significant difference between the PWR and the 
APWR design, in terms of natural deposition, is that the wall cooling enhances the phoretic 
deposition.  Therefore, the difference in decontamination coefficient at 1800 Mwt represents this 
phoretic deposition and is then scaled by the power ratio.  Equation (4-27) represents the final 
approximation used 

𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠(𝐹𝐹𝑃𝑃_𝑃𝑃𝑓𝑓ℎ) = 𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠(𝑃𝑃𝑊𝑊𝑅𝑅_𝑃𝑃𝑓𝑓ℎ) + �𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠(𝐹𝐹𝑃𝑃_1800) − 𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠(𝑃𝑃𝑊𝑊𝑅𝑅_1800)�
𝑃𝑃𝑓𝑓ℎ

1800
 (4-27) 
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where: 

 𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠(𝐹𝐹𝑃𝑃_𝑃𝑃𝑓𝑓ℎ) = the decontamination coefficient from the APWR at the power level 
indicated (Pth =1800 or design power) 

 𝜆𝜆𝑑𝑑𝑑𝑑𝑠𝑠(𝑃𝑃𝑊𝑊𝑅𝑅_𝑃𝑃𝑓𝑓ℎ) = the decontamination coefficient from the PWR DBA calculation for the 
power level indicated (Pth =1800 or design power). 

4.5.3 Deposition in Piping Models 

At the discretion of the user, piping can be modeled as a transfer pathway where deposition can 
occur.  A model is available for the removal of fission products during transport through pipes.  
Alternatively, the user may specify DFs and volumetric flow rates as a function of time.  Noble 
gases are assumed not to interact with the piping and are transmitted without any depletion.  
The models chosen do not have documented limitations; however, the assumption is made that 
only primary deposition phenomena are being modeled.  Scenarios in which supersaturated 
conditions occur, or in which very high or very low velocities are found, may give unrealistic 
results. 

The models that are available in SNAP/RADTRAD for piping deposition include the Brockmann 
model for aerosol removal, the Bixler model for elemental iodine removal, and the Bixler model 
for organic iodine removal. 

4.5.3.1 Brockmann Model for Aerosol Removal 

The Brockmann model described in reference [23] is used to determine the amount of aerosol 
deposition that occurs in pipe bends and due to settling, turbulent inertia and diffusion.  The 
mean particle diameter, dp, used in the Brockmann model is assumed to be 1 µ with an average 
particle density, ρp, of 1000 kg/m3.  The temperature, pressure, open volume, and other 
parameters are provided by the user.  Particles will settle due to gravitational force and deposit 
on the horizontally projecting lower surface of the flow path during transport.  This turbulent flow 
deposition efficiency, ηg, is modeled in Equation (4-28). 

𝜂𝜂𝑔𝑔 = 1 −  exp�−𝑈𝑈𝑔𝑔 𝐹𝐹𝑠𝑠 𝜋𝜋𝑄𝑄⁄ � (4-28) 

𝑈𝑈𝑔𝑔 = 𝜏𝜏𝑔𝑔  

𝜏𝜏 = 𝑠𝑠𝑙𝑙𝑖𝑖𝑆𝑆 ∙ 𝑑𝑑𝑠𝑠
2𝜌𝜌𝑠𝑠 18𝜇𝜇⁄   

𝑠𝑠𝑙𝑙𝑖𝑖𝑆𝑆 = 1.0 + 2.0
𝑚𝑚𝑓𝑓𝑆𝑆
𝑑𝑑𝑆𝑆 �1.257 + 0.4𝑒𝑒−0.55𝑑𝑑𝑠𝑠 𝑚𝑚𝑓𝑓𝑠𝑠⁄ � (𝑑𝑑𝑒𝑒𝑚𝑚𝑒𝑒𝑑𝑑𝑠𝑠𝑖𝑖𝑒𝑒𝑑𝑑𝑙𝑙𝑒𝑒𝑠𝑠𝑠𝑠)  

where: 

 𝑈𝑈𝑔𝑔 = the gravitational deposition velocity in m/s 
 τ = the particle relaxation time in s 
 Q = the user provided gas flow in m3/s 
 𝐹𝐹𝑠𝑠 = the user provided total pipe surface area in m2 
 µ = the viscosity of air, 1.93E-05 Pa-s 
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 mfp = the particle mean free path in cm 
 g = the gravitational acceleration in m/s2. 

For instances of laminar flow, described in reference [24] the deposition efficiency is described 
by Equation (4-29). 

𝜂𝜂𝑔𝑔 = 1 −  
2
𝜋𝜋 �2𝜀𝜀�1 − 𝜀𝜀2 3⁄ − 𝜀𝜀1 3⁄ �1 − 𝜀𝜀2 3⁄ + arcsin �𝜀𝜀1 3⁄ � (4-29) 

where: 

 ε = 0.75𝑍𝑍 − 0.75
𝑀𝑀 𝑈𝑈𝑔𝑔
𝑈𝑈 𝐷𝐷  

and 

 L = the horizontal pipe length (As/π D) in m 
 As = the user provided total pipe surface area in m2 
 D = the pipe diameter (4 Vol/As) in m 
 Ug = the gravitational deposition velocity in m/s 
 U = the linear velocity (Q/As) in m/s 
 Q = the user provided gas flow in m3/s. 

The laminar and turbulent settling efficiencies are equivalent for Reynolds Number between 500 
and 2300. 

If the flow is turbulent, then turbulence in the central core can propel a particle into the laminar 
sublayer.  If the particle inertia is high, then it will penetrate the sublayer and be collected on the 
wall.  There have been experiments, reference [25], on inertial deposition velocity and 
Brockmann has modeled the turbulent deposition efficiency, ηturb, as shown in Equation (4-30). 

𝜂𝜂𝑓𝑓𝑡𝑡𝑠𝑠𝑡𝑡 = 1 − exp(−𝑈𝑈𝑓𝑓𝐹𝐹𝑠𝑠 𝑄𝑄⁄ ) (4-30) 

where: 

 𝑈𝑈𝑓𝑓 = 0.01988 𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠 𝑅𝑅𝑒𝑒1 8⁄⁄  

 Re = 𝜌𝜌𝑙𝑙𝑖𝑖𝑠𝑠 𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠𝑑𝑑𝐻𝐻 𝜇𝜇⁄  

and 

 𝑈𝑈𝑓𝑓 = the turbulent inertial deposition velocity in m/s 
 𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠 = the air velocity in m/s 
 𝑑𝑑𝐻𝐻 = the hydraulic diameter in m (4 Vol/As) 
 𝜌𝜌𝑙𝑙𝑖𝑖𝑠𝑠 = the density of air in kg/m3. 

When the flow in the pipe is slower as described in Equation (4-31), then the turbulent velocity is 
calculated using Equation (4-32). 
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𝜏𝜏𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠

𝑑𝑑𝐻𝐻
𝑅𝑅𝑒𝑒3 4⁄ < 326.3 (4-31) 

𝑈𝑈𝑓𝑓 = 1.861E − 07 �
𝜏𝜏𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠

𝑑𝑑𝐻𝐻
�

2
𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠𝑅𝑅𝑒𝑒11 8⁄  (4-32) 

Small particles undergoing Brownian diffusion will diffuse from areas of high concentration to 
those of low concentration.  Since the wall acts like a sink for these particles, there is net 
diffusion from the bulk to the wall.  This phenomenon has been analyzed in reference [26] and 
the diffusional deposition efficiency is modeled as shown in Equation (4-33). 

𝜂𝜂𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 = 1 − exp�−𝑈𝑈𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓𝐹𝐹𝑠𝑠 𝑄𝑄⁄ � (4-33) 

where: 

 𝑈𝑈𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 = the diffusion velocity in m/s 
 𝐹𝐹𝑠𝑠 = the user provided total pipe surface area in m2 
 Q = the user provided gas flow in m3/s. 

In cases of laminar flow, this efficiency is modeled as shown in Equation (4-34). 

𝜂𝜂𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 = 2.56𝜁𝜁2 3⁄ − 1.2𝜁𝜁 − 0.177𝜁𝜁4 3⁄   (4-34) 

where: 

 ζ = the dimensionless diffusion parameter �𝐹𝐹𝑠𝑠𝐷𝐷𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 𝑄𝑄𝑑𝑑𝐻𝐻⁄ � 

and 

 𝐹𝐹𝑠𝑠 = the user provided total pipe surface area in m2 
 𝐷𝐷𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 = the particle diffusion coefficient in m2/s 
 Q = the user provided gas flow in m3/s 
 𝑑𝑑𝐻𝐻 = the hydraulic diameter in m [see Equation (4-30)]. 

The particle diffusion coefficient is computed as shown in Equation (4-35) in units of cm2/s units 
which is converted in the code to units of m2/s. 

𝐷𝐷𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 = 1.38E − 16  𝑇𝑇𝑔𝑔 × �
𝑠𝑠𝑙𝑙𝑖𝑖𝑆𝑆

3 𝜋𝜋 𝜇𝜇 𝑑𝑑𝑆𝑆�  (4-35) 

where: 

 slip = 1.0 + 2.0 𝑚𝑚𝑓𝑓𝑠𝑠
𝑑𝑑𝑠𝑠

�1.257 + 0.4𝑒𝑒−0.55𝑑𝑑𝑠𝑠 𝑚𝑚𝑓𝑓𝑠𝑠⁄ �  [see Equation (4-28)] 

and 
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 Tg = the gas temperature in °K 
 1.38E-16 = Boltzmann constant in g cm2/s2 °K 
 µ = the viscosity of the gas in g/cm s 
 dp = the particle diameter in cm. 

When the flow is slow or the pipe length is large such that ζ > 0.02, then the diffusional 
deposition efficiency is modeled as shown in Equation (4-36). 

𝜂𝜂𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 = 0.819 exp (−3.657 𝜁𝜁) + 0.097 exp(−22.3 𝜁𝜁) + 0.032 exp (−57 𝜁𝜁)  (4-36) 

In cases of turbulent flow, the diffusional efficiency, from reference [27], is modeled as shown in 
Equation (4-37). 

𝜂𝜂𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓 = 1 − exp �−𝜁𝜁2 3⁄  0.0187 𝑅𝑅𝑒𝑒13 24⁄ �
𝑀𝑀

𝑑𝑑𝐻𝐻
�

1 3⁄

�  (4-37) 

where: 

 ζ = the dimensionless diffusion parameter [see Equation (4-34)] 
 Re = 𝜌𝜌𝑙𝑙𝑖𝑖𝑠𝑠 𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠𝑑𝑑𝐻𝐻 𝜇𝜇⁄  [see Equation (4-30)] 
 L = the path length in m (𝐹𝐹𝑠𝑠 𝜋𝜋𝑑𝑑𝐻𝐻⁄ ) 
 𝐹𝐹𝑠𝑠 = the user provided total pipe surface area in m2 
 𝑑𝑑𝐻𝐻 = the hydraulic diameter in m [see Equation (4-30)]. 

When the direction of gas flow is diverted in a bend, an aerosol particle may deviate from the 
gas flow due to its inertia and deposit on the wall.  The efficiency of an aerosol particle in a bend 
is modeled as shown in Equation (4-38). 

𝜂𝜂𝑡𝑡𝑑𝑑𝑛𝑛𝑑𝑑 =
𝜏𝜏𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠𝜑𝜑

𝑑𝑑𝐻𝐻
  (4-38) 

where: 

 τ = the particle relaxation time in s [see Equation (4-28)] 
 𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠 = the air velocity in m/s 
 φ = the user-provided sum of the angles the flow has been diverted in radians 
 𝑑𝑑𝐻𝐻 = the hydraulic diameter in m [see Equation (4-30)]. 

When the flow is turbulent, the efficiency of an aerosol particle in a bend, from reference [28], is 
modeled as shown in Equation (4-39). 

𝜂𝜂𝑡𝑡𝑑𝑑𝑛𝑛𝑑𝑑 = 1.0 − exp
(−2.83  𝜏𝜏  𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠  𝜙𝜙)

𝑑𝑑𝐻𝐻
 (4-39) 

where: 

 τ = the particle relaxation time in s [see Equation (4-28)] 
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 𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠 = the air velocity in m/s 
 𝑑𝑑𝐻𝐻 = the hydraulic diameter in m [see Equation (4-30)]. 

In cases of laminar flow, the efficiency of an aerosol particle in a bend is modeled as shown in 
Equation (4-40). 

𝜂𝜂𝑡𝑡𝑑𝑑𝑛𝑛𝑑𝑑 = �1.0 + �
𝜏𝜏 𝑈𝑈𝑙𝑙𝑖𝑖𝑠𝑠

0.171𝑑𝑑𝐻𝐻
�

𝑃𝑃1

�
−𝑃𝑃2

  (4-40) 

where: 

 𝑃𝑃1 = 0.452 � 𝜏𝜏 𝑈𝑈𝑎𝑎𝑎𝑎𝑎𝑎
0.171 𝑑𝑑𝐻𝐻

� + 2.242 

 𝑃𝑃2 = 2 𝜙𝜙
𝜋𝜋

 

Therefore, the total aerosol deposition efficiency is modeled as model as shown in Equation (4-
41). 

𝜂𝜂𝑇𝑇 = 1.0 − �1.0 − 𝜂𝜂𝑔𝑔�(1.0 − 𝜂𝜂𝑓𝑓𝑡𝑡𝑠𝑠𝑡𝑡)�1.0 − 𝜂𝜂𝑑𝑑𝑖𝑖𝑓𝑓𝑓𝑓�(1.0 − 𝜂𝜂𝑡𝑡𝑑𝑑𝑛𝑛𝑑𝑑) (4-41) 

4.5.3.2 Bixler Model for Elemental Iodine Removal 

The equation for the Bixler model for elemental iodine removal in pipes is given by Equation (4-
42). 

𝜂𝜂𝑑𝑑𝑖𝑖 = 1 − exp �−𝐹𝐹𝑆𝑆𝑈𝑈𝑑𝑑𝑖𝑖
100𝑄𝑄� � (4-42) 

where: 

 𝑈𝑈𝑑𝑑𝑖𝑖 = 𝑒𝑒2809 𝑇𝑇⁄ −12.5 

and 

 T = the gas temperature in °K. 

4.5.3.3 Bixler Model for Organic Iodine Removal 

The equation for the Bixler model for organic iodine removal in pipes is given by Equation (4-
43). 

𝜂𝜂𝑜𝑜𝑖𝑖 = 1 − exp �−𝐹𝐹𝑆𝑆𝑈𝑈𝑜𝑜𝑖𝑖
100𝑄𝑄� � (4-43) 

where: 

 𝑈𝑈𝑜𝑜𝑖𝑖 = 𝑒𝑒2809 𝑇𝑇⁄ −19.30 
and 
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 T = the gas temperature in °K. 

Note:  Organic iodine removal is not credited in design basis calculations. 

4.5.4 Filters 

Heating, ventilation, and air conditioning (HVAC) system filter efficiency can be input by the user 
for the different nuclide groups as a function of time.  The filter efficiency is specified as the 
fraction of material passing through the filter that is trapped on the filter media.  This efficiency, 
expressed in terms of a decontamination coefficient as shown in Equation (4-44). 

𝜆𝜆𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠 = �𝜂𝜂𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠
100� � 𝜆𝜆𝑗𝑗,𝑘𝑘,𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠

𝑖𝑖  (4-44) 
where: 

 𝜆𝜆𝑗𝑗,𝑘𝑘,𝑓𝑓𝑖𝑖𝑓𝑓𝑓𝑓𝑑𝑑𝑠𝑠
𝑖𝑖  = the volume-normalized flow rate from compartment through the filter in in 

1/s. 

4.6 Dose Analysis 

Doses in the environment, within a control room, or within a given volume due to inhalation and 
whole body immersion can be computed in SNAP/RADTRAD.  The models used are presented 
in the following sections and, as discussed in Section 3.4.1.1, the user can either choose the 
FGR 11 & 12 (default) or a user defined set of DCFs. 

4.6.1 Offsite Dose Analysis 

The dose to an individual at the EAB and the LPZ in the environment compartment is calculated 
in SNAP/RADTRAD.  The dose due to cloudshine (immersion) for each nuclide, n, is calculated 
using Equation (4-45). 

𝐷𝐷𝑑𝑑,𝑛𝑛
𝑑𝑑𝑛𝑛𝑒𝑒 = 𝐹𝐹𝑛𝑛 �𝜒𝜒

𝑄𝑄� � 𝐷𝐷𝑁𝑁𝐷𝐷𝑑𝑑,𝑛𝑛 (4-45) 

where: 

 𝐷𝐷𝑑𝑑,𝑛𝑛
𝑑𝑑𝑛𝑛𝑒𝑒 = the air immersion (cloudshine) dose due to nuclide n in the environment 

compartment in Sv 
 𝐹𝐹𝑛𝑛 = the integrated release of nuclide n in Bq 
 �𝜒𝜒

𝑄𝑄� � = the user-provided atmospheric dilution factor in s/m3 
 𝐷𝐷𝑁𝑁𝐷𝐷𝑑𝑑,𝑛𝑛 = the FGR 11 & 12 air immersion (cloudshine) DCF for nuclide n in 

Sv-m3/Bq-s. 

The activity is related to the number of atoms of nuclide, n, as shown in Equation (4-46). 

𝐹𝐹𝑛𝑛 = 𝜆𝜆𝑛𝑛𝑁𝑁𝑛𝑛 (4-46) 

where: 

 𝜆𝜆𝑛𝑛 = the radiological decay constant for nuclide n in 1/s. 
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The thyroid and committed effective dose equivalent (CEDE) doses due to inhalation from each 
nuclide, n, are calculated using Equation (4-47). 

𝐷𝐷𝑖𝑖,𝑛𝑛
𝑑𝑑𝑛𝑛𝑒𝑒 = 𝐹𝐹𝑛𝑛 �𝜒𝜒

𝑄𝑄� � 𝐹𝐹𝑅𝑅 ∗ 𝐷𝐷𝑁𝑁𝐷𝐷𝑑𝑑,𝑛𝑛 (4-47) 

where: 

 𝐷𝐷𝑖𝑖,𝑛𝑛
𝑑𝑑𝑛𝑛𝑒𝑒 = the inhalation dose commitment due to nuclide n in the environment 

compartment in Sv 
 𝐹𝐹𝑛𝑛 = the integrated release of nuclide n in Bq 
 �𝜒𝜒

𝑄𝑄� � = the user-provided atmospheric dilution factor in s/m3 
 BR = the user-provided breathing rate in m3/s 
 𝐷𝐷𝑁𝑁𝐷𝐷𝑖𝑖,𝑛𝑛 = the FGR 11 & 12 inhalation DCF for nuclide n in Sv/Bq for the CEDE or 

thyroid. 

The TEDE is calculated as the sum of the CEDE and the immersion or cloudshine dose.  Note 
that the conversion factor of 100 Rem = 1 Sv is applied to all the dose equations to obtain the 
dose in units of Rem.  The total dose over the entire problem time is computed as the sum of 
the contributions over each time interval and each nuclide. 

4.6.2 Control Room Dose Analysis 

The dose to an individual in a control room is calculated from the time-integrated concentration 
of radionuclides in the control room compartment.  The dose to the individual due to air 
immersion (cloudshine) in the control room is calculated using Equation (4-48). 

𝐷𝐷𝑑𝑑,𝑛𝑛
𝐶𝐶𝐶𝐶 = �

𝐷𝐷𝑁𝑁𝐷𝐷𝑑𝑑,𝑛𝑛

𝐺𝐺𝐹𝐹
�  𝑂𝑂𝐷𝐷 � 𝑁𝑁𝑛𝑛(𝑑𝑑)𝑑𝑑𝑑𝑑 (4-48) 

where: 

 𝐷𝐷𝑖𝑖,𝑛𝑛
𝑑𝑑𝑛𝑛𝑒𝑒 = air immersion (cloudshine) dose due to nuclide n in the control room 

compartment in Sv 
 𝐷𝐷𝑁𝑁𝐷𝐷𝑑𝑑,𝑛𝑛 = the FGR 11 & 12 air immersion (cloudshine) DCF for nuclide n in 

Sv-m3/Bq-s 
 OF = the user-provided control room occupancy factor 
 𝑁𝑁𝑛𝑛(𝑑𝑑) = the instantaneous concentration of radionuclide n in the control room in 

Bq (s) 
 𝐺𝐺𝐹𝐹 = the Murphy-Campe geometric factor, given in reference [29], which is 

relates the dose from an infinite cloud to the dose from a cloud of 
volume, V, in 1/m3.  This factor is defined in Equation (4-49). 

𝐺𝐺𝐹𝐹 =
351.6
𝑉𝑉0.338 (4-49) 

The thyroid and CEDE doses (inhalation dose) to an individual in the control room are 
calculated using Equation (4-50). 
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𝐷𝐷𝑖𝑖,𝑛𝑛
𝐶𝐶𝐶𝐶 = 𝐹𝐹𝑅𝑅 ∙ 𝑂𝑂𝐷𝐷 ∙ 𝐷𝐷𝑁𝑁𝐷𝐷 � 𝑁𝑁𝑛𝑛(𝑑𝑑)𝑑𝑑𝑑𝑑 (4-50) 

where: 

 𝐷𝐷𝑖𝑖,𝑛𝑛
𝐶𝐶𝐶𝐶 = the inhalation dose commitment due to nuclide n in the control room in 

Sv 
 BR = the user-provided breathing rate in m3/s 
 OF = the user-provided control room occupancy factor 
 𝐷𝐷𝑁𝑁𝐷𝐷𝑖𝑖,𝑛𝑛 = the FGR 11 & 12 inhalation DCF for nuclide n in Sv/Bq 
 𝑁𝑁𝑛𝑛(𝜏𝜏) = the instantaneous concentration of radionuclide n in the control room. 

The TEDE dose is calculated as the sum of the CEDE dose and the immersion or cloudshine 
dose.  The total dose over the entire problem time is computed as the sum of the contributions 
over each time interval and each nuclide. 



 

5-1 

5.0 REFERENCES 
[1] NUREG/CR-6604, “RADTRAD: A Simplified Model for RADionuclide Transport and 

Removal and Dose Estimation,” U.S. Nuclear Regulatory Commission, Washington, DC, 
December 1997. 

[2] NUREG/CR-6604, Supplement 1, “RADTRAD: A Simplified Model for RADionuclide 
Transport and Removal and Dose Estimation,” U.S. Nuclear Regulatory Commission, 
Washington, DC, June 1999. 

[3] NUREG/CR-6604, Supplement 2, “RADTRAD: A Simplified Model for RADionuclide 
Transport and Removal and Dose Estimation,” U.S. Nuclear Regulatory Commission, 
Washington, DC, October 2002. 

[4] SNAP Manual, Version 2.2.1, “Symbolic Nuclear Analysis Package (SNAP) User's 
Manual,” Applied Programming Technology, Inc., Bloomsburg, PA, October 2012. 

[5] ICRP Publication 38, “Radionuclide Transformations – Energy and Intensity of 
Emissions, International Commission on Radiological Protection, Ann. ICRP 11-13. 
September 1983. 

[6] TID-14844, “Calculation of Distance Factors for Power and Test Reactor Sites,” U.S. 
Atomic Energy Commission, Washington, DC, March 1962. 

[7] NUREG-1465, “Accident Source Terms for Light-Water Nuclear Power Plants,” U.S. 
Nuclear Regulatory Commission, Washington, DC, February 1995. 

[8] EPA-520/1-88-020, “Limiting Values of Radionuclide Intake and Air Concentration and 
Dose Conversion Factors for Inhalation, Submersion, and Ingestion,” Federal Guidance 
Report No. 11, U.S. Environmental Protection Agency, Washington, DC. September 
1988. 

[9] EPA-402-R-93-081, “External Exposure to Radionuclides in Air, Water, and Soil,” 
Federal Guidance Report No. 12, U.S. Environmental Protection Agency, Washington, 
DC, September 1993. 

[10] Regulatory Guide 1.183, “Alternative Radiological Source Terms for Evaluating Design 
Basis Accidents at Nuclear Power Reactors,” U.S. Nuclear Regulatory Commission, 
Washington, DC, July 2000. 

[11] Lee, C.E. and Wilson, B.C., “A Conservative Variational Method for Multicomponent 
Concentration Time Dependent Diffusion,” Journal of Computational Physics, Vol. 60 (1), 
August 1985, p. 1-22. 

[12] NUREG/CR-5966, “A Simplified Model of Aerosol Removal by Containment Sprays,” 
U.S. Nuclear Regulatory Commission, Washington, DC, June 1993. 

[13] Washington, K.E., “A Reflected Kinetics Model for Nuclear Space Reactor Kinetics and 
Control Scoping Calculations,” Texas A&M University, College Station, TX, May 1986. 



 

5-2 

[14] Birchall, A. and James, A.C., “A Microcomputer Algorithm for Solving First-Order 
Compartmental Models Involving Recycling,” Health Physics, Vol. 56 (6), June 1989, p. 
857-858. 

[15] Regulatory Guide 1.3, Revision 2, “Assumptions used for Evaluating the Potential 
Radiological Consequences of a Loss of Coolant Accidents for Boiling Water Reactors,” 
U.S. Nuclear Regulatory Commission, Washington, DC, June 1974. 

[16] Regulatory Guide 1.4, Revision 2, “Assumptions used for Evaluating the Potential 
Radiological Consequences of a Loss of Coolant Accidents for Pressurized Water 
Reactors,” U.S. Nuclear Regulatory Commission, Washington, DC, June 1974. 

[17] Regulatory Guide 1.25, “Assumptions Used for Evaluating the Potential Radiological 
Consequences of a Fuel Handling Accident in the Fuel Handling and Storage Facility for 
Boiling and Pressurized Water Reactors,” U.S. Nuclear Regulatory Commission, 
Washington, DC, March 1972. 

[18] NUREG/CR-5009, “Assessment of the Use of Extended Burnup Fuel in Light Water 
Power Reactors,” U.S. Nuclear Regulatory Commission, Washington, DC, February 
1988. 

[19] NUREG-0017, Revision 1, “Calculation of Releases of Radioactive Materials in 
Gaseous and Liquid Effluents from Pressurized Water Reactors (PWR-GALE Code),” 
U.S. Nuclear Regulatory Commission, Washington, DC, April 1985. 

[20] NUREG-0016, Revision 1, “Calculation of Releases of Radioactive Materials in 
Gaseous and Liquid Effluents from Boiling Water Reactors (BWR-GALE Code),” U.S. 
Nuclear Regulatory Commission, Washington, DC, January 1979. 

[21] ANSI/ANS-18.1-1999, “Radioactive Source Term for Normal Operation of Light Water 
Reactors,” American Nuclear Society, La Grange Park, IL, September 1999. 

[22] Fauske & Associates, Inc., “FAI Aerosol Correlation, An Industry Degraded Core 
Rulemaking (IDCOR) Program Report,” Fauske & Associates, Inc., Bethesda, MD, 1984. 

[23] Brockmann, J.E., “Sampling and Transport of Aerosols,” Aerosol Measurement: 
Principles, Techniques, and Applications, Third Edition, John Wiley & Sons, Hoboken, 
NJ, September 2011. 

[24] Fuchs, N.A., “The Mechanics of Aerosols,” Macmillan Company, New York, NY, 1964. 

[25] Liu, B.Y.H. and Agarwal, J.K., “Experimental Observation of Aerosol Deposition in 
Turbulent Flow,” Journal of Aerosol Science, Vol. 5 (2), March 1974, p 145–148. 

[26] Gormley, P.G. and Kennedy, M., “Diffusion from a Stream Flowing Through a Cylindrical 
Tube,” Proceedings of the Royal Irish Academy, Vol. 52-A (1948 - 1950), p 163–169. 

[27] Friendlander, S.K., “Smoke, Dust, and Haze: Fundamentals of Aerosol Behavior,” Wiley, 
New York, NY, 1977. 



 

5-3 

[28] Pui, D.Y.H., Romay-Novas, F. and Liu, B.Y.H., “Experimental Study of Particle 
Deposition in Bends of Circular Cross Section,” Aerosol Science and Technology, Vol. 7 
(3), February 1987, p 301–315. 

[29] Murphy, K.G. and Campe, K.M., “Nuclear Power Plant Control Room Ventilation System 
Design for Meeting General Criterion 19, 13th AEC Air Cleaning Conference,” U.S. 
Atomic Energy Commission, Washington, DC, August 1974. 



 

 

 









 
 

 



   
 

 
 

 
 

 
 

  
 

 
 

 
 

 
 

 
 

 

 
 

 

 
 

 

 
 

 

N
U

R
EG

/C
R

-7220 
 

SN
AP/R

AD
TR

AD
 4.0:  D

escription of M
odels and M

ethods 
June 2016  

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 
 


	1smrecyclelogo.pdf
	Page 1

	Blank Page

